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Concordance

Concordance® is an electronic discovery, document management, and litigation

support tool. Concordance makes it easy to identify, organize, and analyze case-

critical information to aid in collaboration across your firm or around the world.

Concordance gives you the most effective, cost-efficient way to manage large

volumes of documents - scanned paper, email, and other e-documents - generated

during litigation.

Here are some of the key benefits and features that Concordance offers:

· Holds documents of all types 

· Contains a fast and efficient search engine 

· Categorizes records with folders, tags, and issues 

· Secures confidential data at various administrative levels 

· Integrates with other litigation technology 

· Offers remote access while traveling or in the court room

Using Concordance

User Interface

Launch Concordance by right clicking on Start (Windows Key) > CloudNine >

Concordance 10 from the Windows Taskbar, and selecting Run as administrator

from the More menu.
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Menus & Toolbar

Menus

· File - Here you can create, maintain, and manipulate databases and/or the files

used by these databases. You can also send data from Concordance to other

applications, and edit or run Concordance programs.

· Edit - Contains commands that allow you to edit and set data validation

options for documents in your databases.

· View - From here you can open images in your viewer, work with documents

in the Edit, Browse, Review, or Table views, change data and field font sizes,

split your screen, and select the status bar and toolbars.

· Search - Provides access to the Simple Search and Advanced Search panels

in the Search Task pane, access to the Form Search - Query by Example

dialog box, and the Persistent Search and Find Attachments commands. 

You can also save your query session to a file, re-execute a saved query

session, clear all searches, and search for documents that have been edited or

marked for deletion.
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· Documents - Allows you to navigate documents and search results, and

import, export, print, or create reports in your Concordance databases. Most

Documents menu commands operate on the current query.

· Tools - Contains options for displaying empty fields, checking for duplicate

records, managing list files, managing tags and issues, replication, production,

and updating your preferences.

· Help - Provides a link to the online Concordance Help.  You can also activate

Concordance, and view your installed Concordance version number.

Toolbar

Button Description

Opens the Browse view. The Browse view allows you to view

the documents in the database. You can also add and edit

tags, notes, and issues to documents in the Browse view, and

send selected text to other programs. When you open the

Browse view you will be viewing the first document in the

current query or the first document in the database if no

query has been entered.

Opens the Table view. The Table view displays documents

from the current search in a tabular format, similar to a

spreadsheet, with one document per row. In the Table view,

you can add and edit tags to documents, define which fields

are displayed in the view, the field order, and modify the style

and color of the font displayed in the view.

Opens the Review view. The Review view displays all searches

performed since the current database was opened, indexed,

reindexed, or the search history was cleared. The Review view

includes the search number, number of search hits, number

of documents containing the search terms, and the search

terms for each search.
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Button Description

Selects the entire database and returns the sort order of all

records to the order in which they were added to the

database. This function is sometimes referred to as Zero

Query. The document last displayed in the Browse view

remains the active record. The documents that come before

and after are the documents that physically precede and

follow it in the database. When you want to return to the last

query, simply click the All button again. Performing a search

also resets the All button.

Opens the Sorting layouts dialog box.  The Sorting layout

feature provides additional tools to customize and save how

records are sorted in the Browse view to display the desired

result.  

Opens the Edit view.  The Edit view allows you to edit the

contents of the documents in the database.  The Edit view also

provides additional tools needed to create and save custom

edit layouts that can be applied to display only the fields

specified in the selected layout in the Edit view.

Opens the Print documents dialog box. In the Print

documents dialog box you can print records located from a

search. You can underline search terms and produce key-

word-in-context reports. Printed output can be routed to your

printer or to a file. You can select a range of documents within

the current query and specify the fields within the database.

Opens the Report Writer dialog box. When you click the

arrow next to the Report view button, you can open the

Report Writer or Annotation Report dialog box. The Report

Writer dialog box is used to create columnar reports for
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Button Description

database data. The Annotation Report dialog box is used to

create the Annotation Report for transcript databases. 

Opens the Preferences dialog box. In the Preferences dialog

box you can you to customize how you use Concordance,

including customizing the Workspace tab, search hit color,

title bar, issue coding, and indexing.

Opens the Concordance Answer Center.

Quick Search

The Quick Search field is located below the Menus & Toolbar and can be used in

any view. Quick Search allows you to enter basic one-word searches, as well as

more complex combinations without having to open the Search Task pane.

Quick Search also stores your queries from your current Concordance session. 

Click the drop-down arrow on the right to edit and rerun a previous search easily.

Navigation Pane

The Navigation pane allows you to manage your case record review, control

database access, and conduct your daily search, sort, and tagging tasks.

The Navigation pane contains multiple Task panes.  Each Task pane is divided into

work areas called panels.  The Navigation pane is re-sizable based on your personal

preference.  Notice the pin icon in the upper right corner of the Navigation pane. By
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clicking this icon, you can hide the Navigation pane on the left with the Toolbox tab.

 Click the Toolbox tab to view the Navigation pane again, and re-pin to make it

visible at all times.

Ta

sk

Pa

ne

Description

Dat

aba

ses

Allows you to open and concatenate multiple databases, take a

snapshot of a query session, quickly scan recently reviewed

databases, and identify the current database you are reviewing

and whether it needs updating.

Sea

rch

Allows you to perform simple to advanced queries with fast

search results, save and reopen queries, clear search history, and

access the dictionary and field lists.

Tag

s

Contains a menu tree for categorizing tag folders, adding new

tags, and panels for running history and statistical tag queries.

No

tes

Displays comments added to a document, allows you to sort by

note or issue, and shows the properties for each file.

Workspace Pane

The Workspace pane is located on the right side of the Concordance interface, and

displays database items in various views. When you open a database in

Concordance, a tab is created for the database in the Workspace pane.
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Status Bar

The Status bar at the bottom of the Concordance window displays the current

document number being edited, and the total number of documents in the current

set. The bracketed number reflects the document’s location in the physical

database.  The Status Bar also displays activation of the Caps Lock key and Num

Lock lock key, and CV will display highlighted in green if you currently have a

viewer active.

Additional document indicators are displayed here for documents that are tagged

(TAG), marked for deletion (DEL), and/or locked (LCK) by another user.  A document

locked by another user cannot be saved. A locked document is displayed for editing

so that you can copy the document data to another document or program. When a

record is locked, the record is grayed out.

Dynamic Toolbars (not shown above)

Depending on the view that you are in, a dynamic toolbar appears in the lower left

corner, just above the status bar.  The available tools in the dynamic toolbar update

automatically based on the current view.

Button Name Description

First

Opens the first document in the

current query in the Browse view, or

opens the first document in the

database if you are using zero query. 
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Button Name Description

Previous
Opens the previous document in the

Browse view. 

Next
Opens the next document in the

Browse view. 

Last
Opens the last document in the

current query in the Browse view. 

Go to

Opens the Goto dialog box, where you

can enter the number of the document

you want to view from the current

query. Concordance opens the

document in the Browse view.  

For Transcripts, use the Goto dialog

box to enter the number for the

document, page, or line you want to

view.

Previous Hit

Moves the cursor to the previous

search hit in the Browse view. If the

document was edited since the last re-

index, the document containing the hit

is displayed, but the search terms are

not highlighted.

Next Hit

Moves the cursor to the next search hit

in the Browse view. If the document

was edited since the last reindex, the

document containing hit is displayed,

but search terms are not highlighted. If
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Button Name Description

there isn't a next search hit to display,

the next document is displayed.

View Image

Displays the image associated with the

current document. Once you click the

View Image button, it automatically

stays selected and displays the image

associated with each record in the

image viewer. Click the View Image

button again to release the button.

This button only works when images

are enabled in Concordance. 

Copy

Opens the Copy dialog box, where

you can copy document data from

selected fields to the output

destination you specify. 

Font

Opens the Font dialog box. When you

modify the font in the Browse view,

you are modifying the font for data

displayed in the Browse view for the

entire database.  When you modify the

font in the Table view, you are

modifying the font for data displayed

in the Table view for the entire

database. If you are viewing a

concatenated database, the font

change only affects the database for

the current selected record. 

Edit
Adds the search terms of a selected

query to the Search task pane for
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Button Name Description

editing.

Activate

Select a search in the Review view and

click the Activate button to activate a

previous search and make it the

current search. Clicking the Activate

button opens the documents in the

Browse view.

Fields

Opens the Fields dialog box,

containing a list of all fields available

for editing. Select a field from the list

and click the Insert button to move

your cursor to the selected field in the

Edit view.

Ditto

Opens the Duplicate dialog box,

where you can copy field data from

one record to another record or to

another field in the current record. 

Delete

Marks and unmarks a record for

deletion. Records marked for deletion

are removed from the database when

the database is packed.

Undo

Opens the Edit Options dialog box,

where you can undo edits, mark and

unmark the record for deletion, or

erase all content from the document.
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Preferences

The Preferences dialog box contains settings used by both the administrator and

reviewers. You can choose to prevent certain users from accessing the Preferences

dialog box by applying security to this menu item. Most of the preferences are

Microsoft Windows registry settings, but there are several options that allow you to

apply selections to all databases.

Setting some of your viewing parameters helps to ease browsing by offering more

record details onscreen, changing the red highlight color for keywords, and

choosing default settings for the Concordance Image viewer application.

To open the Preferences dialog box, use the Tools menu from the User Interface.

The Preferences dialog box contains seven tabs:

· General - settings used when starting and closing Concordance,

enable/disable Workspace options, and assigning fields for attachments.

· Searching - settings for the default search behavior and search engine.

· Browsing - settings for the title bar field, default query field, and tag and issue

options.

· Wizards - settings for enabling or disabling the import and export wizards.

· Viewer - settings for the default viewer application and View image (camera)

button preferences.

· Indexing - settings for configuring the amount of memory allocated to

indexing and reindexing.

· CPL - settings for CPLs, such as the CPL font selection.

Any setting changes made in the Preferences dialog box require

you to close Concordance and restart the application before taking

effect.
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General Preferences

Startup

Initial Browse Path

Determines the folder that first

opens when browsing for a file or

opening a new database. Use the

ellipses button [...] to browse to and

select the desired folder.
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Startup

During each Concordance session,

the browse path is dynamic, so the

last folder what was opened will be

stored. The next time you browse for

a file or select Open database, that

stored folder location opens.

However, when you close and

restart Concordance, the browse

path will be reset to the Initial

Browse Path.

Default view

Select either Browse or Table to

determine which view is displayed

when you open a database in

Concordance.

Number of MRU items

Determines the number of files

listed in the most recently used

(MRU) file list, which is displayed in

the File menu and the Recent panel

in the Databases task pane.

The maximum number of files you

can display is 9.
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Exit

Exit application

Allows you to set up an application

to launch automatically once

Concordance is closed.

Use the ellipses button [...] to

browse to the the desired executable

application.

Parameters

Allows you to define launch

parameters for the Exit

Application.

Workspace

Enable Workspace

Determines whether or not the

Workspace tab in Concordance is

displayed.

Apply to

Determines which users will be

affected by changes made to the

Workspace settings.

URL

Allows you to add a link to an

external HTML webpage. Be sure to

include http:// or https:// in this URL.
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Attachments

Range

Allows you to specify an Attach

Range field to use with the Find

Attachments feature.  You should

select a paragraph type field.

Fields

Allows you to specify a Beg Attach

and End Attach field to use with the

Find Attachments feature.  You

should select paragraph type fields.
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Searching Preferences

Default search item

Default search term

Determines which search operator is

used when two search terms are

entered without an operator present

between them.
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Default search item

Within words

Expands the allowed proximity

between words within the search

results.

For example, a search for "Cloud

Nine" will search for the word

"Cloud" within 3 words of "Nine".

Wildcard

Wildcard character

This character is used as a prefix or

suffix mask when running a search.

Must be a non-alphanumeric

character.

Quotation

Quotation character

This character is used to specify

search strings, which is useful when

your query includes numbers or

special characters, such as periods,

asterisks, and spaces.

Must be a non-alphanumeric

character.
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Highlight

Highlight color

Determines the color used to display

search hits from searches performed

using the Quick, Simple, Form, and

Advanced Search features.

It is best practice to choose a color

that stands out against the Browse

view background, and is different

than the data or field font color.

Persistent color

Highlights terms found in the record

from the list of terms in the

<databasename>_Persistent.txt file

when the Persistent Search feature

is enabled.

It is best practice to choose a color

that stands out against the Browse

view background, and is different

than the data or field font color.
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Browsing Preferences

Local settings

Apply settings to

Determines what database the

Browse settings are applied to.

Browse settings can be applied to

any database in a group of

concatenated databases.
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Local settings

Select the field to display in

the title bar while browsing

Determines which field will be

displayed in the Concordance title

bar for the current document in the

Browse, Table, and Edit views.

For transcript databases,

Concordance automatically displays

the name, date and volume of the

current document in the Title bar.

Select the field to sort the

default query by

Determines the sort order of a

database when it's opened and

before running a search, also known

as the default query.

This can be set to any field

designated as a key field on the New

or Modify dialog boxes. Selecting

<none> sorts the database by

document number.

Tag action

Select the default action of

double-clicking a tag

Specifies what happens when you

double-click a tag. You can always

access the tagging options menu in

Concordance by right-clicking a tag.
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Issue coding

Use shift-left-click for issue

coding

Issues are applied to highlighted text

in Concordance when shift-left-

clicking.

Use left-click for issue

coding (original method)

Issues are applied to highlighted text

in Concordance when left-clicking.
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Wizards Preferences

Wizards

Import wizard

Enables or disables the wizard that

guides you through the process of

loading delimited text files into

Concordance.
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Wizards

When disabled, importing a

delimited text file opens the Import

Delimited Text dialog box rather

than the Import wizard.

Export wizard

Enables or disables the wizard that

guides you through the process of

exporting a Concordance database

to a delimited text files.

When disabled, exporting a

delimited text file will open the

Export Delimited ASCII dialog box

rather than the Export wizard.

Viewer Preferences

Viewer Settings can be defined at different levels - all users, the

current user, or database.  Settings at the lowest level take

precedence.  If you define viewer settings for all users and an

individual database, when accessing that specific database the

database settings will be used (not the all user settings).

Viewer settings for all databases are stored in the local user's

registry settings and only apply to the local user.  Viewer settings

that are applied to a specific database are stored in the .ini file of

the database and will impact all users that access that database.
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Viewer settings

Apply user settings to

Determines whether user settings

apply to the Current user or All

users.

Apply database settings to

Determines whether the database

settings apply to the Current

database or All databases.
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Viewer settings

Viewer

Use this drop-down to select the

application that you want to use as

the default image viewer. Other

fields may be displayed depending

on the viewer chosen. The following

options are available:

· Concordance Viewer:  This

database will use the

Concordance Viewer.

· Concordance Native Viewer: 

Click the ellipses button to the

right of Application path. In

the file explorer window,

navigate to the location of your

ConcordanceNativeViewer.exe

and click Open.

· Concordance Image (Option): 

Click the ellipses button to the

right of Application path. In

the file explorer window,

navigate to the location of your

ConcordanceImage.exe and

click Open.

· CPL:  Click the ellipses button to

the right of Viewer CPL. In the

file explorer window, navigate

to the location of the .cpl file to

execute when you click the

View Image button in

Concordance, and click Open.
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Viewer settings

See more information below on

using the CPL option.

· IPRO:  Click the ellipses button

to the right of Application

path.  In the file explorer

window, navigate to the

location of IPRO.exe and click

Open. Click the ellipses button

to the right of Viewer CPL.

Browse to and select the

applicable .cpl file. You can

download the CPL script from

Ipro Tech. For more

information about the IPRO

viewer and setup options, see

the IPRO documentation.

· IPRO Thin Client:  Enter the

appropriate Alternate project

name.  For more information

about the IPRO Thin Client

viewer and setup options, see

the IPRO documentation.

· <none>:  No viewer is defined

for the user and/or database

selected.

· <Use Global Settings>:  No

specific viewer settings are

defined for the user and/or

database selected, global

settings will be used.

https://iprotech.com
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Sticky camera

"Sticky" browse button

The View Image button will

automatically be selected in the

Browse view.

"Sticky" table button

The View Image button will

automatically be selected in the

Table view.

"Sticky" edit button

The View Image button will

automatically be selected in the Edit

view.

Using CPL Viewer

The CPL (Concordance Programming Language) viewer option is intended for

programmers and systems integrators who have knowledge of programming

languages and technical expertise. Concordance can execute a CPL program when

clicking the View Image button in the Browse, Edit, or Table view, or right-clicking

highlighted text and clicking View image. The CPL program can then pass the

image key to another program through DDE or as a startup parameter.

The CPL program you select needs to take the appropriate action to bring up the

viewer and the proper image. The CPL program should check the clipboard by

using the paste() function. If nothing is in the clipboard, your program should use

the data in the image-key field. You need to check the clipboard because the end

user can highlight text in the Edit or Browse view and send it to your program with

the right mouse button. Your program must not perform any screen displays. For

information about DDE functions that may be useful to your program, see

Developing with Concordance .400
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Indexing Preferences

Cache settings

Indexing cache

Determines the memory cache

available for the indexing process.

This cache is released back to the
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Cache settings

operating system when indexing

completes.

Larger caches result in faster

database indexing. Be careful not to

allocate more memory than your

workstation can afford, and leave at

least 128MB for the operating

system. Concordance logs the

allocation and indexing time in

Concordance_[version #].log.

Dictionary cache

Determines the cache available for

all list files, including the database

dictionary, the database .key file, the

stop-word files, files for spell-

checking, miscellaneous .lst files,

security and password files, etc. This

cache is always in use, not just

during indexing.

Indexing also makes extensive use of

the dictionary cache. Increasing the

size of this cache will especially

improve indexing performance on

large natural language text and OCR

databases.
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Multiuser reindexing

Apply settings to

Use this drop-down to determine

whether <All databases> or just

the current database will become

unavailable for searching or

dictionary functionality during

indexing or re-indexing. This setting

works in conjunction with the Allow

exclusive indexing check-box.

Allow exclusive indexing

This will prevent searching and

dictionary functionality during

indexing or re-indexing for

databases specified in the Apply

settings to drop-down.
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CPL Preferences

CPL Font

CPL font...

Use this button to open the Font

dialog (shown below), allowing you

to adjust CPL font settings.
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CPL Font

Tab size
Enter a numeric value (number of

spaces) to adjust the tab size.

Creating a Database

Concordance supports several different types of databases.  It is important to

understand the differences, and to properly prepare and plan for your database

based on your data requirements.

If you are new to Concordance, please see the Concordance Databases

information before creating a new database.
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When creating a database, Concordance uses a wizard type interface that walks you

through each step of the database creation process.  The Wizard is for creating new

databases only.  The Wizard supports three types of databases:  Load File, E-

Document, and Email and Attachments.

Load File Databases

The New Database Creation Wizard for load files uses the header row of a

delimited text file, an existing Concordance database structure, or a setting file that

was saved from an existing database to create the fields and import the data.  The

database can be modified to fit your needs.  

Keep the following in mind when using the wizard to create a Load File database:

· Field names longer than 12 characters will be truncated automatically.

· All OCR text files must be located within the same directory.

· Selecting a viewer and loading imagebase files is optional.  If you do not create

an imagebase, only multi-page OCR text files can be loaded (multiple OCR text

files for a single database record will only have the first file loaded).

· If the viewer and imagebase options are selected, single-page OCR text files

are grouped together into a single database record and separated in the

specified OCR field using page tags (i.e. ***00010002***).

· All image files are loaded from an OPT file, which contains the path and file

name for each image.

· Only one OPT file can be loaded using the Wizard.  If you have more than one

OPT file, use the Imagebase Management tools.

o For Concordance Viewer or Concordance Native Viewer, see OPT to

CIB.

o For Concordance Image, see Loading Image Files.

· Only TIF formatted files can be loaded for Concordance Image.

E-Document Databases
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Concordance is able to create a database using a variety of native files (electronic

documents), including text, Adobe Acrobat PDF, Microsoft Word, PowerPoint, and

Excel. 

When creating a database, Concordance automatically processes and normalizes

the documents during import.  Concordance OCRs all the native files and generates

a .PDF near-native version of the document for viewing.  The PDF near-native files

are stored in the database folder in a separate Near Natives folder, and a copy of

the native file is stored in a Natives folder.  Documents are imported

alphanumerically.  The Temp folder contains files with the OCR text that was

extracted from the document, and is cleared when the import process is complete.

Email and Attachment Databases

Using the wizard, Concordance imports .pst formatted files that are associated with

a Microsoft Outlook profile located on your machine. You need to have Outlook or

Microsoft Exchange Server installed with a mail profile set up for each custodian, so

you can associate each .pst file to an Outlook profile. This should be done before

using the wizard to create an Email Database.

Concordance provides you with an E-mail and Attachments template, but you may

also create your own. The E-mail and Attachments template includes typical

metadata fields from Outlook, and takes care of the field mapping for you. The

template also allows you to create and modify fields as needed.

You may also want to consider how you are using Concordance in terms of

production so that the content can be reviewed and redacted.  If your organization

is using:

· Concordance Viewer or Concordance Native Viewer - the View emails in

the viewer associated to this database option must be selected in the Import e-

mail - Attachments dialog box to ensure the Concordance Imagebase (CIB) file

is created (for new records only).

· Concordance Image - e-mails need to be processed into images with a

corresponding .dat and image load file.
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Creating a Load File Database

It is recommended that you review your load files  prior to

creating a Load File Database.

1. From the the File menu in Concordance, click New.

2. At the prompt, select either Yes to use Concordance Viewer, or No for another

viewer.

3. In the New Database Creation Wizard, click the Load Files button.  The

Load Files wizard displays.
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4. Click the Browse button next to Enter Database Name.  Navigate to where

you want to save the new database, type a File name for the database, and

click Save. 

5. Click the Browse button next to Select DAT File.  Navigate to and select the

.DAT file you want to load, and then click Open.

Only files with the .DAT file extension can be loaded through the

Import Wizard for the Select DAT file option.  If you have a

.CSV, .TXT, or .ASC file, you must rename the file extension to .DAT

to use it with the wizard.

6. In Load Field Names From select one of the following options:

· Select DAT File to load the database field names from the DAT file header

row you are importing.  The field type settings are automatically set to

Paragraph.

· Select Template/Structure to import the field names and types from a

template or existing database structure.  In the Load Database Structure

dialog box, click Browse to locate and select the template/database you

want to load.

· Select Settings File to import the fields names and field type settings from a

Field Properties text file.  Click Browse to locate and select the Field

Properties file.

· Select None (Enter Field Names Manually) to manually enter the field

names.

The Field Properties file is a text file that can be exported using the

Save to File option in the Modify dialog box (File > Modify).  The

properties file lists the field names and type settings for the

database structure.

Concordance requires that each field name be unique; therefore, if

the imported settings file and/or DAT file contain duplicate fields,



Concordance Classic44

© 2022 CloudNine™. All rights reserved.

the duplicate field names will be appended with a suffix of 01 up to

the maximum number of characters allowed for field length.

7. Click Next to continue.  The Choose Delimiter screen displays.

8. Select the appropriate delimiter and date format:

· Select the delimiter Format that works with your data.  The Format

defaults to Concordance default, which works for Concordance

documents.  You can also choose Comma delimited, Tab delimited,

and Custom.  Once you choose an item in the Format dropdown, the

Comma, Quote, and Newline values will update to match your

selection.  For Custom, you can define whatever you want for these

delimiters.
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o Comma - separates one field from another. (Concordance

Default is numeric value 20)

o Quote - encloses text to differentiate it from field delimiters that

may appear in the data. (Concordance Default is numeric value

254)

o Newline - substitute for a carriage return.  Some programs use

this character to designate multi-level fields or fields within

fields.  For the data within a field, Concordance replaces all

carriage returns or combinations of carriage return and linefeed

with this newline code. (Concordance Default is numeric value

174)

· Select an appropriate value under the Select the date format for

importing date fields drop down.  This format should match the data

in your delimited text file.

9. Click Next to continue.  The Modify screen displays.
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10. Review and edit any field properties as needed.  Select a field in the Field

Name list on the left and edit the field properties on the right.  Field names

must begin with an alphabetic character.  Only alphanumeric characters and

underscore characters are allowed in a field name.  Field names can be a

maximum of 12 characters.  The order of fields listed on the left will be the

order in which they appear within Concordance.

If you selected to import the field names from a DAT file, the field

names are created from the header row of the DAT file and the

type property for each field is set to Paragraph by default.  

11. Select a field and click Delete to remove any fields that are not needed.

12. Click New or Insert on the bottom-left to add any new fields as necessary.  If

you are creating database fields using an existing database template/structure

or a settings file, make sure that the fields you define match the fields in the

header row of the corresponding delimited text file being used to import the

field data.  Be sure to specify all appropriate parameters for the new fields as

follows:

Field Type Additional

Parameter(s)

Notes

Text Length is the

number of

characters

allowed in the

field.  Text

fields can have

from 1 to 60

characters.

Sorting for text

fields is

alphanumeric

so 1000 comes

before 9 unless

you zero-fill

the text field

(0009 comes

before 1000). 

Numeric Length is the

number of

The number

1234.56 would
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Field Type Additional

Parameter(s)

Notes

characters

allowed in the

field.  Numeric

fields can have

up to 20

characters,

including the

decimal place. 

Negative

numbers use

an extra

character for

the negative

sign.

Places is the

number of

decimal places

in the numeric

field. 

Format

determines

how numeric

fields are

displayed and

printed.  Select

Plain,

Comma,

Currency, or

Zero Filled.

have a Length

of 7 and

Places value

of 2.



Concordance Classic48

© 2022 CloudNine™. All rights reserved.

Field Type Additional

Parameter(s)

Notes

Date MMDDYYYY This field will

be displayed in

Concordance

as month-day-

year.

Date YYYYMMDD This field will

be displayed in

Concordance

as year-

month-day.

Date DDMMYYYY This field will

be displayed in

Concordance

as day-month-

year.

Paragraph Paragraph

fields are

variable in

length, and can

hold up to 12

million

characters. 

Concordance

only sorts

paragraph

fields by the

first 60
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Field Type Additional

Parameter(s)

Notes

characters in

the first line of

text.

The field length affects the column width and how the field name

appears in Table View.  You need to use the appropriate date

format for a field when searching for dates or entering dates

during data entry.  Dates are always sorted correctly, regardless of

the date format chosen.

13. For each field, verify the additional property check boxes on the lower right:

· Image - an image field is used to link Concordance with a viewer, such

as Concordance Native Viewer, Concordance Image or Opticon. The

Image check box should only be selected for one database field. It is best

practice to select the Image check box for the BEGNO field or it's

equivalent. 

· Key - a key field performs a function similar to indexing, but does not

require re-indexing.  When fields are designated as key fields,

Concordance creates a database .key file that is used to through them. 

Any field can be a key field, but most often they are fixed-length fields

and/or date, numeric, and text fields that require searching.  Key fields

take up additional space for the key file, so it is best to not define too

many key fields unless they are needed.  Paragraph fields are normally

NOT key fields - unless you specifically need to quickly locate empty

paragraph fields.

· Accession - Accession numbers are unique serial numbers stored with

each record and managed entirely by the database software.  They do

not change even if other records are deleted.  Accession numbers cannot

be edited - they can only be viewed.  This check box should only be

selected for ONE database field.  It is best practice to select the Accession



Concordance Classic50

© 2022 CloudNine™. All rights reserved.

check box for the ACCESSID field or it's equivalent. The internal

accession number for each record will be displayed in the accession field

you create.

· System - These fields are created by Concordance and are hidden fields

with no read or write privileges for end users.  These fields should never

be indexed, added, deleted, or modified by users.

· Indexed - A field must be Indexed in order to use Concordance full-text

search capabilities.  The Indexed check box is automatically selected for

paragraph fields.  You can modify the indexed setting at any time, but

the dictionary files are not updated until the database is re-indexed.

14. The Punctuation field is used in full-text searching.  Review the Punctuation

field and add any other punctuation characters that are integral to your

searches.   See Punctuation  for more details.  The default is apostrophe,

period, comma, and forward slash.

15. When you are finished editing information on the Modify screen click OK.

16. You will be prompted to verify that the Image field you set is correct.  Click

Yes to confirm, or No to re-open the Modify screen and update the Image

field selected.

17. After confirming the Image field selection, the Fields dialog displays.  This

screen allows you to define which fields will be imported.

359
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18. By default, all database fields are added to the Selected fields list.  Use the

buttons in the center of the screen to add and remove selected fields, and to

change the field order.  The field order must match the field order of your

delimited text file.  If the field structure and order in the Selected fields list

does not match your delimited text files, then the data won’t transfer into

Concordance properly.

19. Select the Options that apply:

· Show system fields - check this box to display hidden system fields. 

System fields are used by Concordance to administer database

functions, such as replication.  They are generally not visible, but you can

display and import them if you select the Show system fields check

box.
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· Skip first line - check this box to prevent Concordance from creating a

database record for your field name row.  The first line of a data file

sometimes contains the field names for the records in the database. 

When this check box is selected, Concordance ignores that line of data

during import.

20. If you want to setup attachment fields, update the Set Attachment Fields

section.  You can choose either an attachment range field, or both a beginning

and ending attachment field.  By default Range is selected, but no field is

specified (effectively no attachment fields specified).

· To setup an attachment range field, select the radio option at the far left

of the Range section.  Select a field in the Attach Range drop down to

use for storing attachment range data.

· To set up beginning and ending attachment fields, select the radio

option at the left of the Fields section, then select a specific field in the

Beg Attach and End Attach drop downs.

When using the Find Attachments feature, it is best practice to

setup the fields as paragraph type fields to increase the

performance and make sure to index/re-index the database. For

more information see Options .

21. When you are finished editing information on the Fields screen, click OK. The

Load OCR Text/Tag List screen is displayed.

22. To load OCR text: 

· Inside the Load OCR Text section, click the Browse button to navigate

to and select the OCR directory that contains your OCR text files, and

then click Select Folder.

· In the OCR field drop down, select the OCR field you want to use for

OCR text.  By default, the OCR field list contains all Paragraph type

fields.  To properly load OCR data, make sure OCR fields are numbered

sequentially.
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The wizard can import both single or multi-page OCR text files.  To

import these files correctly, make sure that all the text files are

located within the same directory.

23. To load a list of tags from a text file, in the Load Tag List section, click Browse

to navigate to and select your tag file, and then click Open.

Tags and tag folders do not support Unicode characters.  Only

ASCII (values 032-126) characters are allowed. If a tag name or tag

folder name contains an invalid character, you will be prompted to

make corrections.  For more information about tags, see the

Tagging  topics.

24. When you are finished with OCR text and tag settings, click Next.  The Import

Imagebase screen displays.

146
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25. Choose your imagebase viewer in the Select Imagebase default viewer

section.  Depending on the viewer selected, the Options section will update

accordingly.

· For Concordance Viewer or CNV Only, click the Browse button to

locate and select the corresponding OPT file for the imagebase.

· For CI Only:

o To scan images from a directory, select the Scan Images option and

click Browse to locate and select the directory containing the image

files.

o To load an opt file, select the Load OPT option and click Browse to

locate and select the corresponding OPT file for the imagebase.



Concordance 55

© 2022 CloudNine™. All rights reserved.

When importing the image files using the Scan Images option,

make sure that all the image files are located in the same directory. 

26. Click Next to continue.  The Preview screen displays.

27. Preview shows the fields you have specified for the first three records.  Verify

that these fields contain the proper data.  If not, go Back to previous wizard

steps to make any necessary changes.  

28. Select Index database after completion to automatically index the new

database after it is created.

29. When you are satisfied with the information displayed on the Preview screen,

click Next.  The Summary screen displays.
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30. Click Create to create the database and load the data.  The Summary screen

updates to display any Errors, along with information about the data that was

loaded.
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31. Click Done to exit the database wizard.  You should now review the

Concordance records to verify the data and imagebase loaded correctly.

Load files or delimited text files typically have extensions ending in .dat, .csv, or .txt.

Each file contains record metadata, but some may also include body text. We

recommend having your OCR separated into individual text files and imported

separately.

As an administrator, always make it a best practice to open and review delimited

text files when you receive them, as the files are not always prepared perfectly and

may need to be modified.
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Delimited text files can be opened with any text editor program,

such as Notepad. We recommend using an advanced text editor

program like TextPad® or UltraEdit®.

Reviewing a Load File

1. Open the load file in any text editor program.

2. Review the load file for the following elements:

· The file must be a text-based format with an extension of .dat, .csv, .txt, .rtf, or

any normal text file extension.

· If there is not a header row containing field names, open the associated .tif file

for the first record and match the data in the record to the data in the .tif file.

· Note the delimiters used in the file. Concordance can handle any standard text

delimiters. 

· Note the date format used in the file. Concordance can load dates containing

slashes in any order with either 2- or 4-digit years, with a maximum of 8

digits. The only date formats Concordance can load without slashes is the
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universal date format of YYYYMMDD and the mm-dd-yyyy date format with

dashes.

· Check the final line number for your last record to note the number of records

expected to be added to the database. Subtract header row if the Skip first line

option is checked during import.

· Is there a carriage return at the end of the record? If not, add a carriage return

at the end of the record. Concordance will not load the last record if the

carriage return at the end of the record is missing.

Concordance database field names do not support special

characters.  Therefore, if you are using the Delimited Text Database

Creation wizard, make sure that the header row does not contain

any special characters (i.e. #, $, etc).  Special characters will prevent

the wizard from creating the fields properly.

Creating an E-Documents Database

1. From the File menu in Concordance, click New.

2. At the prompt, select Yes to use Concordance Viewer, or No for another

viewer.

3. In the New Database Creation Wizard, click the E-documents button.  The

Create E-Documents Database dialog displays.
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4. In the Select document location section, for each set of documents you

want to import, do the following:

· In the folder list on the left, expand a folder to browse to the folder

location where the documents to import are located, select the folder

name, and then click the Add button.  Alternatively, you can type the full

path to the location of the files you want to import in the Add Path text

box and then click Add.

· Check the Include subdirectories box if you want to include files in

sub-directories underneath the folder you selected.

5. Click the Browse button to the right of Select database location, navigate to

where you want to save the new database, type a File name for the database,

and then click Open.
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6. To customize the import settings, click the Customize button.  The Customize

Import Settings dialog displays.

7. On the Customize Import Settings dialog, make any necessary updates as

follows:

· To use an existing database template, click the Browse button, locate the

database template to use, and then click Open.

· Under Auto number documents, enter a Starting Number and

Prefix for numbering the documents.
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· Under Native file, specify either Yes or No to copy the original native

files into the Native Files folder within the database.

· Under Field mapping, you can modify the mapping of imported data

(document metadata) to Concordance fields by selecting the field and

then selecting the appropriate data type from the corresponding list. 

When importing E-Documents, Concordance captures metadata when

possible, including the document ID, author, creation date, and last

modified date. Concordance also captures the metadata present in

formatting such as font changes, bolding, underlining and highlighting.

Each of the fields in the Field mapping section are automatically set to

the default Concordance field mappings. 

To make sure that the documents import properly, the field that is

mapped to Document text must be an OCR paragraph field with

an alpha prefix and numeric suffix, such as TEXT01.

8. When you are finished customizing the import settings, click OK.  The Create

E-Documents Database dialog displays again.

9. Click Import to create the database.  Progress dialogs are displayed.  Once

completed, you will see the following screen:

10. You can click View Log to review the import, or click Open to start working

with the new database.
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Creating an Email and Attachments Database

Prior to creating an Email and Attachments Database, you must

have Outlook installed, and the Outlook Data File (.pst) you want to

load opened in Outlook.

1. From the File menu in Concordance, click New.

2. At the prompt, select Yes to use Concordance Viewer, or No for another

viewer.

3. In the New Database Creation Wizard, click the E-mail and Attachments

button.  The Choose Profile dialog displays.

4. Select the Profile Name where the .pst file has been opened.  For default local

Outlook installations, choose Outlook.

5. Click OK to continue.  The New Database Creation Wizard - E-mail dialog

displays.
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6. Click the Browse button to the right of Enter Database Name, navigate to

where you want to save the new database, type a File name for the database,

and click Save.

7. Click Next to continue.  The Import e-mail - Folder screen displays.
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8. Browse the list displayed under Select the folder to import.  Select the

Outlook Data File (.pst) top-level folder that you want to load.  Alternatively

you can select a subfolder if you want a smaller set of data.  Select the Import

subdirectories check box if you want everything underneath your selection to

be loaded.

9. Click Next to continue.  The Import e-mail - Attachments screen displays.
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10. To extract the email attachments, select the Extract messages and

attachments check box.  Click Browse underneath the Attachment

directory to navigate to a folder location where the attachments should be

stored. 

11. If your Outlook Data File contains a large number of attachments, you can also

decide to save the attachments in multiple sub-directories.  To do this, select

the Create subdirectories for attachments check box.  In Subdirectory

prefix, specify the root name for the sub-directory.  Select the number of

attachments to put in each sub-directory under Max files.  For the example

shown above, the root attachment folder is C:

\ProgramData\CloudNine\Databases\EMTestA\Attachments.  Attachments will

be saved in sub-folders, starting with a folder named ATTACH0000 - where

the first 500 attachments will be placed.  The next 500 attachments will be

found in sub-folder ATTACH0001, and so on.
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12. Select View emails in the viewer associated to this database to be able to

view e-mails in the previously selected viewer during review.

13. Click Next to continue.  The Import e-mail - Date range screen displays.

14. To import all e-mail messages from the Outlook Data file, select Import all e-

mails.  To narrow the e-mail message selection to a smaller time-frame, select

Import e-mails from a specific date range and then pick an appropriate

value for Begin date and End date.

15. Click Next to continue.  The Import e-mail - Fields screen displays.
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16. The Fields screen allows you to map specific e-mail fields to Concordance

database fields.  The left column displays the e-mail message fields, and the

corresponding field on the right defines the associated Concordance database

field.  By default, e-mail databases are created using the E-mail and

Attachments template, and fields are automatically mapped to the correct e-

mail message fields.  If your e-mail database did not use a template, you need

to map your e-mail fields manually on this screen to load the data.

17. After verifying your field mappings, click Next.  The Import e-mail - Options

screen displays.
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18. If you want to automatically number the imported e-mail messages, select

Auto-number documents with a DOCID, and then enter the Prefix and

Starting number you want to use.  Auto-numbering provides a number for

each e-mail message and any attachments, while also tracking family groups

in a DOCID and PARENT_DOCID field.

If you are using the Concordance Native Viewer with this database,

the Auto Number documents with DOCID option must be

selected to successfully view the documents.

19. Select Display full path of attachments to display the full path rather than

just the attachment file name.

20. Select Do not allow duplicate e-mails if you want Concordance to ignore

duplicate e-mails.  Messages with the same MESSAGEID as an existing

message will not be imported.
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21. Select an option for Input formatted e-mail text as.  Choose RTF/Plain

Text if you are using Concordance Native Viewer, otherwise choose Native

Format.

22. Select Create log file for attachment import errors if you want the wizard

to generate an import error log.

23. After selecting your options, click Next.  The Import e-mail - Finish screen

displays.

24. Click Import.  The Status messages updates with progress while the import is

running.  A final message will display the total number of emails that were

imported.  Click Done to close the import wizard.

25. The newly created database will be displayed in Concordance.  In the Browse

view, you can navigate through a few of the e-mail messages to verify they

were imported properly.  It is recommended to run a full index at this time.
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Opening a Database

Due to the major database structure changes, all databases need to

be converted to version 10 or later.  When opening a 7.x, 8.x, or 9.x

database, Concordance will prompt the user to convert the

database to version 10.x.  If the user chooses not to convert, the

database will not open in Concordance version 10.x.  See

Converting Databases  for more information.

If your Concordance administrator set up security requiring users

to log in to the Concordance database you want to open, you will

be prompted to enter your user name and password. The first time

you log on, you will be prompted to create and confirm your

password. You can change your password during login at any time.

1. From the Menu of the Main User Interface, select File > Open.  You can also

click Open database in the Databases panel of the Navigation Pane.

2. A browse window displays.  Navigate to and open the .dcb or .fyi database file

you want.

3. A new tab displays in the Workspace Pane on the right with your database. 

Opening a database displays additional panels in the Navigation Pane, and

additional toolbars below.  The Status Bar updates to display information for

the currently selected database.  The Concordance title bar at the top updates

to provide information about the current database.

73
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Concordance Title Bar

Concordance transcript databases automatically set the Title bar to the name, date

and volume of the current document. For non-transcript databases, you can define

the Concordance field you want to display by going to

Tools>Preferences>Browsing and updating the Select the field to display in

the title bar while browsing drop-down.  The selected field displays in Browse

View, Table View, and Edit View.

When reviewing standard records in the Browse, Table and Edit views, displaying a

unique record number field like BEGNO on the Title bar can help you keep track of

which record you are viewing in the database. 
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Converting Databases

After upgrading to the latest version of Concordance, databases from older

versions of Concordance that you want to use need to be converted.  You can

convert an individual database, or you can run a bulk conversion to convert

multiple databases at one time.

Database conversion is permanent.  You cannot convert back to

an earlier version.  Be sure to make a backup copy of the databases

before converting.

The conversion process to version 10.x includes a built-in step that checks the tag

file contents for corruption and attempts to repair any detected issues.  After

conversion completes, Concordance generates a Conversion Report.

During bulk database conversion, the administrator is no longer

prompted for a username and password for each database. To

prevent this feature from being used inadvertently, the Bulk

Convert Databases to Current Version menu item is disabled

until it is enabled on your workstation with a specific registry key. 

See Concordance Registry Keys for more information.

The Default tag has been removed in version 9 and 10 databases. 

If the Default tag is not assigned to a document in a version 8

database, the tag will not appear in the converted version 10

database. If the Default tag is assigned to a document in a version 8

database, the tag will be converted and appear exactly the same in

the converted version 10 database.

The following table indicates how each database file is handled during a database

conversion:
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File Type Conversion Action

.dcb Converted

.dct Deleted

.dir Not modified

.fyi Not modified

.fzy  Deleted

.ini Not modified

.ivt Deleted

.key Converted

.layout Converted

.ndx Converted

.sec Converted

.tag Converted



Concordance 75

© 2022 CloudNine™. All rights reserved.

File Type Conversion Action

.tex Converted

.trk Converted

.vol Not modified

Converting a Single Database

1. Before converting a database, make a backup of all the files in the database.

2. Open the older database in Concordance using the File>Open or

Databases>Open Database menu.  A warning dialog displays notifying you

that the database must be converted before it can be used.  Click OK in the

warning dialog.

3. Select Convert Single Database from the File>Administration menu.

4. In the Open dialog box, navigate to and select the database you want to

convert, and then click Open.

5. A confirmation message displays.  Click Yes to convert the database.

6. If the database has security applied, you will be prompted for the database

administrator Username and Password.  Enter that information and click OK.

7. The conversion process runs, and a conversion report is created.  You can now

open the converted database in Concordance.
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Converting Multiple Databases

1. Before converting databases, make a backup of all the files in the databases.

2. Select Bulk Convert Databases to Current Version from the

File>Administration menu.

3. Navigate to and select the folder containing the databases you want to

convert.  All databases in this folder and any sub-folders will be converted. 

Click OK.

4. A confirmation message displays.  Click Yes to convert the databases.

5. The conversion process runs, and a conversion report is created for each

converted database.  You can now open any of the converted databases in

Concordance.

Database Conversion Report

After database conversion completes, a database conversion report is created in the

database's directory.  The conversion report is a comma-delimited conversion log

file, named <database name>-<date>.csv.

The conversion report contains the following information:

· Database name

· Path to database

· Original database version

· Date and time of database conversion

· Total number of documents before conversion

· Total number of documents after conversion

· For each converted database file:
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o File name

o For B-tree files, the number of records before and after conversion

o For index files, the total number of dictionary words before

conversion, and a note indicating that a full index needs to be run to

gather the total number of words after conversion

o For TRK files, the total number of tag names, total number of

documents tagged before and after conversion, and the number of

errors found during the TRK file conversion.  When converting version

9.x databases to version 10.x, Concordance counts the distinct tag

names and the number of tag-to-document assignments, and ignores

tags that have no document assignments.

o Error codes for errors found

· User ID of the user entered for Concordance security

· Microsoft Windows User ID of the user converting the databases

· Whether Concordance security is enabled

· Whether Concordance login is required

Working with Database Records

Viewing Records

There are three ways to display records in Concordance:

· Browse View - displays document content in a scrollable pane (default view)

· Table View - displays a list of documents in a spreadsheet format

· Split Screen - allows you to view both Browse and Table simultaneously

(split vertical or horizontal)

Browse View
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The Browse View (default) allows you to read an entire document summary. Use

the Dynamic toolbar at the lower left to navigate between documents. The

document number and record count display in the Status bar, and the document

title displays in the window’s title bar. Non-paragraph fields are preceded with an

equal sign (=) and paragraph fields are preceded with a colon (:).

When you run searches in Concordance, any words located in a search (search hits)

are highlighted in the Browse view. You can quickly navigate search hits using the

Previous Hit and Next Hit buttons on the Dynamic toolbar.

When viewing records in the Browse view, you can use the Empties command on

the Tools menu to hide fields without data, which can help tighten the screen view

when reading records. A check mark next to the Empties command on the Tools

menu indicates empty fields are hidden in the Browse view. If a field is not

displayed in the Browse view, even when the Empties command is deselected, you

may not have viewing privileges for the field. Contact your Concordance

administrator for more information.

You can customize the font and color of the field and record text displayed in the

view, unless the record contains rich-text format. Changing the text font and color

does not affect the record’s original text, which is stored as a rich text file (.rtf) to

secure the original format. See Customizing View Fonts  for more information. 80
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You or your Concordance administrator can also customize the Browsing

Preferences . Browsing Preferences are saved in your Microsoft Windows

registry settings.

Table View

The Table view displays documents from the current search in a tabular format,

similar to a spreadsheet, with one document per row. Use the Dynamic toolbar at

the lower left to navigate records in the Table view. The view's default document

sort order is the original import order for records entered into the system. Clicking

a field column header will sort data in ascending or descending order. You can

adjust the column widths by dragging the divider between columns. 

You can customize which fields are displayed in the view, as well as the field order,

by using the table layouts. You can create multiple custom table layouts for the

Table view.  See Using Table Layouts  for more details.

You can also modify the font and color of the record text displayed in the Table

view. Changing the text font and color does not affect the record’s original text,

which is stored as a rich text file (.rtf) to secure the original format.  See

Customizing View Fonts  for more information.    

26

82

80



Concordance Classic80

© 2022 CloudNine™. All rights reserved.

To review the contents of a specific document in the Table view, double-click on the

document to open that document in the Browse view.

Split Screen View

The Split Screen view allows you to display two views simultaneously. You can

have the two views display from top to bottom or left to right. You can use the Split

Screen for the Browse, Table, Review, and Edit views.  The current views displayed

in the Split Screen will be selected (highlighted in orange) on the Toolbar.

Enable or change the display mode of the Split Screen by selecting options in the

View | Split Screen menu.  The views displayed will update when you select

individual views on the Toolbar.

In the Browse view, you can customize the font/color of the field and record text

bring displayed, unless the record contains rich-text format.  You can also modify

the font/color of the record text displayed in the Table view.  Changing the text



Concordance 81

© 2022 CloudNine™. All rights reserved.

font and color does not affect the record’s original text, which is stored as a rich text

file (.rtf) to secure the original format.

When you change the text font and color in the Browse and Table views, the

changes are applied to each database record displayed for the current database. 

For concatenated databases, you can customize the text font and color displayed in

the Table view for each database in the concatenated set.  This can help

differentiate between the databases at a glance.

Change the Field Font in Browse View

1. Make sure you are in Browse View.

2. Right-click anywhere in the record text section and select Font > Field font. 

The Font dialog displays.

3. Modify the font settings as desired.

4. Click OK to save your changes.  The new font settings apply to all field text

displayed in Browse view.
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Change the Record Font in Browse View

1. Make sure you are in Browse view.

2. Right-click anywhere in the record text section and select Font > Data font. 

The Font dialog displays.

3. Modify the font settings as desired.

4. Click OK to save your changes.  The new font settings apply to all record text

displayed in Browse view.

Change the Record Font in Table View

1. Make sure you are in Table view.

2. Right-click anywhere in the table section and select Font.  The Font dialog

displays.

3. Modify the font settings as desired.

4. Click OK to save our changes.  The new font settings apply to all record text

displayed in Table view.

If you are changing the font and color for a record in databases

within a concatenated set, right-click any record in the database for

which you want to change the font. This only changes the font for

the records in that specific database.

The Table view uses table layouts to determine which fields are displayed, and

order in which they are displayed. Table layouts can be used to customize viewing

preferences or to support sort methods specific to a review.

Table layouts are created and maintained using the Table Layout dialog. For each

database, each user has one private layout that is accessible only to that user. Any
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additional layouts created for a database are public and accessible to everyone

using the same database. A database's public layouts can be created, edited, or

deleted by anyone with access to the database.

If you are using Table View to display long documents, such as depositions or

resumes, you can get much faster performance if you do not display full text

Paragraph fields.  If necessary, add fixed length fields to your database, which have

identifying information such as a name, date and serial or volume number, and

then use those fields for Table View.

If you have a table layout design that works well in other databases, you can copy

and paste the .layout file into other database directories, and then rename the file

with the new database name. 

To display records in Table view using a table layout, select the desired layout from

the list by clicking the arrow to the right of the Table button on the Toolbar.

Create a Table Layout

1. Click the arrow to the right of the Table button on the Toolbar, and then click

Table layout.  The Table Layout Dialog displays.
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2. Click New.  A new Untitled table layout will appear in the Layouts box on the

left.

3. Update Untitled to provide a name for the new layout.

4. To add fields to the layout, drag fields from the Available fields list into the

table layout.  You can reorder fields in the layout by selecting and moving

them in the list.

5. When you have finished defining the layout, click OK.

Modify a Table Layout

1. Click the arrow to the right of the Table button on the Toolbar, and then click

Table layout.  The Table Layout Dialog displays.

2. In the Layouts list, your private table layout will show a green box with your

user ID at the top level.

3. Expand the layout that you want to modify.

4. Select fields to Delete, add new fields from the Available fields list, or

modify the order of the fields in the layout by selecting and moving them.

5. Click OK to close the Table Layout dialog box and apply your changes to the

Table view.

Delete a Table Layout

Only public table layouts can be deleted in Concordance.  When you delete a table

layout, it is deleted for all users using the same database. You cannot delete your

private table layout or the table layout currently displayed in the Table view.

1. Click the arrow to the right of the Table button on the Toolbar, and then click

Table layout.  The Table Layout Dialog displays.

2. Right click the layout you want to delete in the Layouts list and click Delete.
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The Table layout is not applied to the current view if you currently

have sorting applied.  Applying a sort automatically generates a

Zero query, returning all documents and sorting the records based

on the specified sorting layout.

Sorting Records

The results of any search are sorted in the order that documents were added to the

database. You may sort your documents chronologically, by author, by document

type, or by any other field you have in your database to help speed up your

review.  

When you are sorting, you need to remember that it only affects your current

search results.

In order to sort your documents by a field, click on a column heading in Table

view. Documents are sorted in ascending order by the selected field. To sort in

descending order, click the column heading a second time.  You can also sort

documents by multiple fields using Sorting Layouts .

Returning All Records

After sorting and reviewing your records, you can to refresh the sort order to its

original state using the All button on the Toolbar.   The All button will quickly

return all records to the sort order in which they were added to the database. You

can also toggle the All button to switch between your current query or viewing all

records in the database.

The Sorting feature in Concordance determines the display order for records in the

Browse view. The fields selected in the Sorting Layout dialog box determine the

order that records are returned for viewing. You can also choose to sort in

ascending or descending order.  

85
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Sorting layouts are created and maintained in the Sorting Layout dialog box, and

are saved as .Sortlayout files in the same directory as the database. There are no

limits to the number of sort layouts that can be created and saved; however, sort

layouts are specific to the database and user for which they were created.

Therefore, if you are working in a database and using a sorting layout that you

created, and another user accesses the same database, the sorting layout you are

using is not affected by the other user or their sorting layout.  

Sorting layouts are compatible with concatenated databases.  The fields available in

the Sorting Layout dialog box are those associated with the primary database.

When creating sorting layouts for concatenated databases, keep the following in

mind:

· All databases in a concatenated set are sorted according to the sorting layouts

for the primary database when accessed from the concatenated set.

· Database fields in a concatenated set other than the primary will not appear in

the Sorting Layout dialog box unless they are opened separately.

· If the field structures for the primary database do not completely match the

field structure of concatenated databases, the sorting layout may not sort the

concatenated databases as expected.

· In order for field structures of concatenated databases to match, they must

have identical field names and field types and be listed in the same order.

· Each sorting layout is limited to four fields.

To display records in Browse view using a sort layout, select the layout from the list

by clicking the arrow to the right of the Sorting button on the Toolbar.
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Icon Description

Single Database and Compatible

Concatenated Databases

Primary database

Available sort

layout

Field sort order -

Descending

Field sort order -

Ascending

Incompatible Concatenated Databases
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Icon Description

Available sort

layout containing

fields that are not

compatible with

the concatenated

set of databases

Field sort order -

Descending

(inconsistent

layouts may

appear for each

concatenated

database)

Field sort order -

Ascending

(inconsistent

layouts may

appear for each

concatenated

database)

Create a Sorting Layout

1. Click the arrow to the right of the Sorting button on the Toolbar, and then

click Sort layout.  The Sort Layout Dialog displays.

2. Click New.  A new Untitled sort layout will appear in the Layouts box on the

left.

3. Update Untitled to provide a name for the new layout.
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4. To add fields to the layout, drag fields from the Available fields list into the

sort layout.  You can reorder fields in the layout by selecting and moving them

in the list.  You can also choose to sort each field Ascending or Descending

using the right mouse menu.

5. When you have finished defining the layout, click OK.

Modify a Sorting Layout

1. Click the arrow to the right of the Sorting button on the Toolbar, and then

click Sort layout.  The Sort Layout Dialog displays.

2. Expand the layout that you want to modify.

3. Select fields to Delete, add new fields form the Available fields list, or

modify the order of the fields in the layout by selecting and moving them. 

Update the sort order for each field to be Ascending or Descending using

the right mouse menu.

4. Click OK to close the Sort Layout dialog box and apply your changes to the

Browse view. 

Delete a Sorting Layout

1. Click the arrow to the right of the Sorting button on the Toolbar, and then

click Sort layout.  The Sort Layout Dialog displays.

2. Right click the layout you want to delete in the Layouts list and click Delete.

The default user sort layout is automatically created when the

database is opened.  This sort layout cannot be renamed.
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Editing Records

Concordance is fully equipped to handle a rolling production environment with

features that allow editing and adding records as needed. Attorneys find the editing

tool useful for adding comments directly to a document record during the case

review. Administrators can add Attorney Note fields to the database for this

purpose.

Reviewers rarely need to create new records in Concordance.  However, as new

documents roll in after the initial collection phase, these new records need to be

added to the database too. It may not be cost-effective to send a handful of

documents out to be processed when a paralegal can manually add them into

Concordance by dropping the file on the Concordance workspace.

Editing existing records is most often done when records are added to

Concordance yet are still missing key information that needs to be captured in the

system for identification, such as the document title, author, and date it was

created. 

If you are an attorney entering summary notes or a paralegal adding missing data

to records, you are only able to access fields that you have permission to edit.

Fields that can’t be edited are displayed in gray. Other data entry restrictions may

be placed on fields by your Concordance administrator.  You can use an Edit Layout

to customize the view and display only those fields you want to edit - in the order

you want to see them.

Each time you edit a record, changes are saved when you navigate to another

record or change your view in Concordance.  New information is not full-text

search-able until the database is re-indexed to refresh the dictionary.

If you try to edit a record that someone else has open for editing, the record will be

locked as read-only, with gray fields and a LCK notification displayed in the Status

Bar.

Editing = coding. Use caution when working in the Edit view. You

can spoliate documents if you are not careful, damaging the

integrity of your original database records and impacting the

search results of others.
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The Edit View is displayed by clicking the Edit button on the Toolbar.  When the

Edit view is open, the Dynamic Toolbar at the bottom updates to show the Edit

tools.  Additionally, the Rich Text toolbar displays underneath the standard Toolbar,

allowing you to adjust font details for edit form fields.  Only fields you have full

rights for can be edited.
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Right-clicking in the contents of a field will display additional formatting options

you can use while editing the field. 

To query the database for any documents that have been edited, use the Search

for edited documents command. All documents that have been edited since the

last database re-index/index are displayed in Browse or Table view.  This feature is

available on the Search menu.

You can also query the database for any documents that have redactions (applied

during Content Review).  On the Search menu, select the Search for documents

with redactions command.  All documents that have been redacted are displayed

in Browse or Table view.

To make editing easier, Concordance provides the ability to select specific fields

and change the order they are displayed in the Edit view.  Changing field display

settings only affects your view of the fields - it does not affect field display for other

users. These field settings apply to all records within the database.

Concordance uses edit layouts to determine the which fields are displayed, and

order in which they are displayed. Edit layouts are created and maintained on the
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Edit Layout dialog box, and are stored in <databasename>.Editlayout files. An edit

layout can be created or edited by anyone in the database.  However, only the

Concordance Administrator or person who created the layout has permissions to

delete it.

When creating an Edit Layout for a concatenated set, only the fields

of the primary database are displayed in the Available Fields list for

non-identical concatenated databases.

Create an Edit Layout

1. Click the arrow to the right of the Edit button on the Toolbar, and then click

Edit layout.  The Edit Layout Dialog displays.

2. Click New.  A new Untitled edit layout will appear in the Layouts box on the

left.

3. Update Untitled to provide a name for the new layout.
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4. To add fields to the layout, drag fields from the Available fields list into the

edit layout.  You can reorder fields in the layout by selecting and moving them

in the list.

5. When you have finished defining the layout, click OK.

Modify an Edit Layout

1. Click the arrow to the right of the Edit button on the Toolbar, and then click

Edit layout.  The Edit Layout Dialog displays.

2. In the Layouts list, expand the layout that you want to modify.

3. Select fields to Delete, add new fields from the Available fields list, or

modify the order of the fields in the layout by selecting and moving them.

4. Click OK to close the Edit Layout dialog box and apply your changes to the

Edit view. 

Delete an Edit Layout

Only the Concordance Administrator, or the person who created the layout, has

permissions to delete it.

1. Click the arrow to the right of the Edit button on the Toolbar, and then click

Edit layout.  The Edit Layout Dialog displays.

2. Right-click the layout you want to delete in the Layouts list and click Delete.

In most document databases, some data entry work is unique (such as attorney

review comments), but much of it is repetitive. Having these repetitive words

available in word lists allows you to insert them easily into database fields,

reducing data entry errors. For example, you can pick Schenectady from a list

instead of having to remember how to spell it each time you need to enter it into a

field.
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You can use word lists by manually selecting the list when editing fields, but a

better practice is to define a word list to use when validating entries in a specific

field.  See Data Validation  for more details.

Word lists are set up by your Concordance administrator. If you want a word list

added to a particular field, contact your Concordance Administrator.

You can only open a word list when you are in the Edit view.

Edit a Record by Selecting from a Word List

1. In the Browse or Table view, select the record you want to edit.

2. Click the Edit button on the Toolbar to open the Edit view.

3. Right click in the field and choose Word Lists.

4. Browse to and select the word list file you want to use, and then click Open.

5. The Word List dialog displays.

6. Select the word you want to add to the field in the list, and then click Add.

356
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7. The Concordance field is updated with the word you selected from the word

list.

You can format individual field text in the Edit view by changing the text's case, or

editing other font attributes.  When you modify text formatting for a field in the Edit

view, the formatting only applies to the field text for the current record.

If you need to remove rich-text formatting from a field in multiple records in the

database, Administrators can use the Bulk Field Format Reset feature. 

To Format Text in Edit View

1. In the Browse or Table view, select the record you want to edit.

2. Click the Edit button on the Toolbar to open the Edit view.

3. Select the text you want to edit.

4. If desired, right-click and select one of the formatting options:

· Upper - each selected letter will be changed to upper case.

· Lower - each selected letter will be changed to lower case.

· Capitalize - the first letter of each word in the selected text is changed to

upper case.

5. You can also use any of the options available in the Rich Text toolbar at the top

to modify the font attributes for the selected text.

6. Navigate to another record to save your changes.

If you want to remove the text formatting that was applied, you can right click in a

field and select Reset field formatting to reset the field to plain text.
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When you are creating new records in the Edit view, each new record added is

automatically saved at the end of the existing records list. New records are not full-

text search-able until a re-index is performed to refresh the dictionary. If you are

adding a lot of new records, coordinate with your Concordance administrator to

ensure that the re-indexing process coincides with your schedule in order to keep

the database dictionary up-to-date.

There are two ways to create new records in the Edit view:

· Using the Append command to create a new blank record.

· Using the Ditto feature to create a new record with data from another

document. 

The Append and Ditto features are not available for E-Document

databases.  E-document databases have automatic document

numbers that prohibit using Append and/or Ditto.

Append a New Blank Record

1. While in Edit view, select Edit > Append.  A new record is displayed in Edit

view.  Some fields may be gray because you do not have permission to edit

these fields.

2. Fill out the applicable fields for the new record.

3. Click Edit on the Toolbar to turn off edit mode and save your record. 

Concordance automatically saves the new record as soon as you close the Edit

view or navigate to another record.  Changes are immediately viewable.   In

order to search the records, the database must be re-indexed.

To ensure that your edits are search-able, coordinate with your

Concordance administrator regarding the re-indexing schedule.  If

any edits are made that require a re-index, a check mark displays

on the File menu next to Reindex.
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Using Ditto

Another tool for repetitive data entry is the Ditto feature. The Ditto feature copies

fields of data from one record to another, minimizing data entry errors. The Ditto

feature is only available in the Edit view. Both the Ditto button on the Dynamic

toolbar in the Edit view and the Ditto (Edit View) command on the Edit menu open

the Duplicate dialog box. 

The Duplicate dialog box offers the following options:

· Append new - copies data from the current document into a new document.

· Copy previous - copies data from a previous document into a new or edited

document.

· Copy from another - copies data from another document into a new or

edited document.

If you are copying field data from another document, when you

select Copy previous or Copy from another, the selected field

data from the current document is overwritten by the data from

the other document.

For concatenated databases, only documents in the primary (first)

database can be used for copying data.

Ditto a Record to Another

1. In the Browse or Table view, select the record containing the field data you

want to use.

2. Click the Edit button on the Toolbar to open the Edit view.

3. Select Edit > Ditto (Edit View), or click the Ditto button in the Dynamic

Toolbar.  The Duplicate dialog displays.
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4. From the field list, select the fields that contain the data you want to copy.

5. Select Append new and click OK.  A new record containing the fields you

selected is created and opened in the Browse or Table view.

6. Update any fields as needed.

7. Click Edit on the Toolbar to turn off edit mode and save your record. 

Concordance automatically saves the new record as soon as you close the Edit

view or navigate to another record.  Changes are immediately viewable.   In

order to search the records, the database must be re-indexed. 

The Duplicate dialog offers three different options:

· Append new - copies data from the current document into a new document.

· Copy previous - copies data from a previous document into a new or edited

document.

· Copy from another - copies data from another document into a new or

edited document.

If you are copying field data from another document, when you

select Copy previous or Copy from another, the selected field
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data from the current document is overwritten by the data from

the other document.

For concatenated databases, only documents in the primary (first)

database can be used for copying data.

You can mark records for deletion one at a time using the tools available on the

Dynamic Toolbar when the Edit view is open. You can also mark multiple records

for deletion at one time.  When a record is marked for deletion, DEL is displayed in

the status bar. Concordance administrators can review and retrieve these

documents before removing them permanently from the database.

Records are not permanently removed from the database until your Concordance

Administrator removes them.

Mark Individual Record for Deletion

1. In the Browse or Table view, select the record you want to mark for deletion.

2. On the Toolbar, click the Edit button to open the Edit view.

3. On the Dynamic Toolbar click the Delete button.  The record is marked for

deletion and the Status Bar now shows DEL for the deleted record.  The record

will not be permanently deleted until your Concordance Administrator

removes it.

Unmark Individual Records for Deletion

1. In the Browse or Table view, select the record you want to unmark for

deletion.

2. On the Toolbar, click the Edit button to open the Edit view.
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3. On the Dynamic Toolbar click the Undo button.  Select Undelete document

in the Edit Options dialog and click OK.  The record is no longer marked for

deletion and the Status Bar no longer displays DEL for the record.

Mark Multiple Records for Deletion

1. Run a search for a batch of records that you want to mark for deletion, or a

zero search to be able to select a specific range of records from the entire

database.

2. Verify that the desired records appear in Table view.

3. On the Edit menu, click Delete and Undelete.  The Delete and Undelete

dialog displays.

4. In the Range field, confirm the range of records to mark for deletion, and then

click OK.  The selected records are marked for deletion and each of those

records will display DEL in the Status Bar.

If you accidentally mark records for deletion that should not be

deleted, follow the procedures above for deleting multiple records

but select Undelete instead of Delete in the Delete and

Undelete dialog. You can also remove the delete status from the

individual records using the Delete or Edit buttons on the Dynamic

toolbar. Be sure to verify that the DEL status no longer appears for

the appropriate records.
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Searching

Concordance search tools sort through vast amounts of information quickly using

two search methodologies:

· Full-text Searching - Full-text searching is fast and produces results quickly

because it searches for words based on index entries created when building

the database. The index provides directions to words in the database

dictionary and records are gathered for you to review based on search

criteria. 

· Relational Searches - Relational searches scan every word of every record in

a database and take longer than full-text searches, because Concordance must

read every record to locate your entries and does not use an index. Relational

searches are great for locating dates and numbers, whereas full-text searches

are optimal for word searches. 

See Advanced Searching  for more details about searching in Concordance.

When your Concordance administrator builds your record databases, the

information is indexed for full-text searching capabilities. Once a record collection

is indexed, a dictionary is created with additional filters that weed out unnecessary

words, common English words, and even some punctuation, to improve search

processing time. When reviewers make edits, redactions, or add new records to the

database, the administrator must perform a reindex in Concordance to update your

record collection.  It is recommended to perform indexing when reviewers are not

working in Concordance. 

To more effectively execute full-text searches, it is important to understand the

search concepts below.

Indexing and Re-indexing

When Concordance databases are built, the index and dictionary are generated

from your document contents. The index contains location information for every

word or character string in the database. The dictionary contains a list of every
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word or string of characters in your record collection, except words, punctuation,

and/or field content your administrator specifically excludes from the dictionary. 

A word is simply defined as any string of letters and/or numbers.  Both airforce1

and ABC000001 could be words in the Concordance index.

Spaces break characters into multiple words, so a space between airforce and 1

would result in two separate words in the index.

In Concordance, updating the index is called a reindex.  Reindexing updates the

database dictionary and its corresponding index. Actively used databases need

frequent reindexing to keep the index and dictionary entries current for searches.  

Administrators are usually responsible for indexing or reindexing databases due to

the sensitivity involved in running these processes. Concordance administrators

must ensure that all data is reviewed and proper backups are made before indexing

or reindexing a database.

When updates have been made to a database and your database dictionary is no

longer current with the latest updates, Concordance indicates that the database

needs reindexing. On the file menu a check mark is displayed next to the Reindex

command and Needs Reindexing is displayed in the Databases task pane under

Current Database. If you do not have reindexing privileges, the Reindex command

is not visible on the File menu.
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Stopwords

Concordance comes with a pre-defined list of stopwords for each database. 

Stopwords are words that are automatically excluded from a database's index. The

stopword list includes the most common words in the English language (for

example: and, but, is, and the).  Stopwords are words you normally would not

search for.  Eliminating these words from the index ensures that searches run faster

and more efficiently. You can see the stopwords list for your database by going to

File>Dictionaries>Stopword list.

Punctuation

For full-text searching, punctuation is not indexed. Concordance treats punctuation

symbols as spaces when full-text searches are conducted. All punctuation is

ignored, such as periods or quotations, as well as any symbols like currency and

percentage. 

You can search for words with punctuation if both of the following things are true:

· The punctuation character is defined by your administrator to be indexed in

Concordance
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· The punctuation is part of a string surrounded by two other characters

To see what punctuation your administrator defined to be indexed, go to

File>Properties.

When using punctuation characters in your search term, at least

one non-punctuation character needs to be inserted between the

punctuation characters. For example:  joe&i@email.com. Using two

or more punctuation characters together will not work

(joe&@email.com).

Dictionary

In Concordance, a word is any string of characters.  A word can be a series of

numbers or a combination of letters, numbers and even punctuation or symbols

depending on your settings. You can view your dictionary by going to
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File>Dictionaries>Database Dictionary.  The Dictionary dialog box provides a

complete listing of all words included, the number of documents it appears in, and

how many word hits there are.

Quick Search

Quick Search appears immediately below the Concordance Menus and Toolbars. 

You can use Quick Search to find information quickly in the Browse or Table views

without having to open the Search Panel in the Navigation Pane.  You can toggle

between viewing all case records or those in your current search by selecting the

All button on the Toolbar.

To Run a Quick Search

1. In the Quick Search field, type your search string.  You can enter up to 255

characters.

2. Click the Go (green arrow) button on the right or press Enter to run the search.

3. Depending on which views you have displayed, records containing the search

you entered are displayed in Table View, and the first record is displayed in the
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Browse View.  Each occurrence (hit) of your search is highlighted in red in the

Browse View.

4. To navigate to the next occurrence of your search string, click the Next Hit

button in the toolbar on the lower left.  The Status Bar at the bottom updates

to show you what search result document you are currently viewing.  For

example, Document 2 [3] of 4 indicates you are viewing the second search

result of four total results, and this document is the third document in the

database.

5. The Quick Search field stores your recent quick searches.  To access a

previous Quick Search, click the drop down arrow on the right, and select the

query. To rerun the search, click the Go button or press Enter.

Options

Options provides the ability to define a persistent search and include attachments

in your searches.  Options is available in the Search Panel in the Navigation

Pane.
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There are several reasons to save your search queries. A benefit to saving queries is

that once stored, they will collect new data on future executions. The next time you

open the query file, Concordance automatically reruns all previous query criteria

and includes them in the current session’s list of searches. This provides you with a

foundation of queries to build upon in your advanced search efforts and saves you

data entry time.

Queries are saved as .qry files. These are editable text files containing only the

search string. Re-running a saved query file reprocesses all searches for the file.

This process can take extra time since Concordance is re-executing all of the

searches. You can execute a .qry file on other databases. If you re-execute it in

another database, remember that you will need to resolve any field discrepancies

between them by editing the search strings or by making a copy of the search and

editing it. For example, the To and From fields in one database may be titled Author

and Recipient in another one.

If you don’t need to re-execute a .qry file, then you can save queries as .txt files by

right-clicking on a query in the Review view and selecting Save. Unlike a saved

.qry file, which only stores your search clause, a saved text file also stores the

number of hits and documents for that query. Saved search .txt files are useful in

referencing search history.

Save All Queries

1. On the Toolbar, click the Review button.

2. Open the Options section of the Search Panel in the Navigation Pane.

3. Click Save all queries to a saved query file.  The Keep Queries dialog

displays.

4. Navigate to and provide a file name for the query file.  Click Save.

5. Once you have saved your queries you can clear the queries from Review view

by clicking Clear search history in the Options section of the Search Panel.

Execute a Saved Query

1. On the Toolbar, click the Review button.
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2. Open the Options section of the Search Panel in the Navigation Pane.

3. Click Execute a saved query. The Open dialog displays.

4. Navigate to and select a query file name containing the queries to execute. 

Click Open.

5. Concordance runs all searches in the query file.  The search results display in

Review View as soon as they are executed.

Persistent Search

A Persistent Search remains active even after the results are returned.  The search

terms for a Persistent Search are saved in a file with the database (<database

name>_Persistent.txt).   To add search terms to the Persistent Search file, contact

your Concordance Administrator.  

When new records are added to a database, and Persistent Search is enabled, the

Persistent Search will automatically be run whenever the database is reindexed.

A Persistent Search may be run in conjunction with Quick, Simple, and Advanced

Search queries to refine search results even further.  When combining Persistent

Search and other searches, make sure that the Persistent Search option is enabled

before running any additional queries.  Persistent Search is automatically disabled

after executing the Find Attachments command.

To enable Persistent Search, either:

· Open Options inside the Search Panel of the Navigation Pane and select the

Persistent Search check box.

·  Click Search>Persistent Search.

When Persistent Search is enabled, the Status Bar updates to show the word

PERSISTENT.

When a search is executed while Persistent Search is enabled, Concordance

returns all the records that contain both the terms in the search and the Persistent
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Search.  If you want to return to just the Persistent Search results, type 0 (the

number zero) in the Quick Search field and press Enter.

When combining search queries a maximum number of 255 characters is allowed. 

If Persistent Search is activated and then a search is performed, make sure that

the total number of characters does not exceed 255 to ensure the correct results

are returned. 

Each persistent search can define a different color to use for highlighting terms

found matching the search.  See Searching Preferences  for more information.

If you click the All button on the standard toolbar, all the records in

the database are returned and Persistent Search is automatically

disabled.  Click the All button a second time to reactivate the

Persistent Search.

Include Attachments

When paper documents are scanned to TIFF formatted files and loaded into

Concordance, parent documents and their attachments may be broken into

separate records.  If a document and its attachments are scanned as one document,

there may be only a Begin and End Bates number field for each record in the

database that reflects whole documents.  If parent documents and attachments are

separate records there may be a Begin and End Bates number as well as a Begin

and End Attachment field or Attachment Range field in the database for each

record.

When native e-mail files are processed, they may be converted to TIFF formatted

files, in which case, they could be treated the same as paper document TIFF

formatted files, in terms of the Begin and End Bates number and Attachment

number fields in the database. If they are not converted to .tiff files and were

reviewed in native format, document ID fields are used to assign a unique identifier

to each document and attachment.  A document ID is a document level identifier,

rather than a page level identifier.

When searching a database that has documents and attachments, the search

results may return some of the attachments for a document but not the parent

23
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document, or just the parent and not the attachments, etc.  If it is important to

produce the entire document set (parent and all attachments related to those

document that returned as the result of a search), it may be necessary to run the

Find Attachments command to gather the related parents and attachments. 

The Find Attachment command gathers related parent and attachment documents

in a database based on the fields containing the attachment information for an

active query. The Find Attachments command looks for attachments where the

attachment ranges are stored in a single field or two separate fields. The Find

Attachments can be set up when creating a database using the New Database

Creation wizard, or using the preferences.  For concatenated databases, only the

primary database settings will work for all other databases in concatenated set,

even if non-primary databases have different settings.

When using the Find Attachments feature, it is best practice to

setup the fields as paragraph type fields to increase the

performance.  Be sure to index the database prior to running the

Find Attachments command.

To Locate Documents and Related Attachments

1. Run the appropriate search to locate the documents for review.  The search

results are returned.

2. To find related attachments, on the Search menu, click Find Attachments.

3. When finished, press Enter.

To Run a Query and Include all Documents and

Attachments

1. In the Search field, type the query to locate the documents and attachments.

2. In the Navigation pane, click the Search tab.

3. In the Options section, click the Include Attachments check box.
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4. On the Search toolbar, click the Go button.

The Include Attachments option on the search panel does not work

with Tag Queries.  Use the Find Attachments option on the Search

menu after running a Tag Query to find additional email and

attachment family members or use the tagging option to Tag

Query & Attachments.

Simple Search

Simple Search allows you to search records easily using provided parameters

without having to learn about search operators.  Simple Search is available in the

Search Panel in the Navigation Pane.
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When using features in the Navigation Pane, you may want to

expand the width of the pane by dragging the divider between the

Navigation Pane and the Workspace Pane to the right.

To Run a Simple Search

1. Open Simple Search inside the Search Panel of the Navigation Pane.

2. Enter your search criteria:
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· with all the words - conducts an and search to find document records

containing all terms listed

· with the exact phrase - conducts an adjacent search to find document

records containing terms found together

· with at least one of the words - conducts an or search to find document

records containing any of the words listed

· without the words - conducts a not search to find document records that

do not contain any of the words listed

3. Click the Search button to run the query.

4. Depending on which views you have displayed, records containing the search

you entered are displayed in Table View, and the first record is displayed in the

Browse View.  Each occurrence (hit) of your search is highlighted in red in the

Browse View.

5. To navigate to the next occurrence of your search, click the Next Hit button in

the toolbar on the lower left.  

6. The Status Bar at the bottom updates to show you what search result

document you are currently viewing.  For example, Document 2 [3] of 4

indicates you are viewing the second search result of four total results, and

this document is the third document in the database.

Form Search

Form Search allows you to search records easily by helping to provide search

syntax for you.   The search performs the same full-text and relational searches that

can be manually entered.  Clicking Form Search in the Search Panel in the

Navigation Pane will bring up the Query by Example dialog.
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Notice each of the column headers at the top. Your first search will always start

with *New* as the Connector.  You then need to specify Where to look, How to

look, and what word you want to Look for.  You can continue to build out a more

complex query by filling out another row, starting with another Connector.

The Look for field can be a maximum of 85 characters.  The total of all fields can be

a maximum of 255 characters.

You can determine whether the row in the form search will be run as full-text or

relational by inspecting Where to look.  If you want to use form search to build
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complex queries, remember to put full-text searches before the relational searches

in the Query by Example dialog.

The Query by Example dialog box is limited to ensure it remains

simple to use. For more complex or longer searches, you can use

the Advanced Search panel.

To Run a Form Search

1. Click Form Search in the Search Panel in the Navigation Pane.  The Query

by Example dialog displays.

2. Define the term and/or connector for your search in the first row:

· Leave Connector set to *New*.
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· Select a field to search, or *Any Full Text* to search all text, in Where to

look.

· The How to look updates based on your Where to look choice.  Select an

appropriate operator. 

· Select the value you want in Look for.

3. Fill out any additional rows in the Query by Example dialog following step 2,

until you have specified your entire search.

4. Do one or more of the following:

· Select the Notes check box to run your search on any note content as well.

· Click Search to display the full search string in the text box, and see the

number of hits/documents found using the search.  You can edit the

search string directly in the text box if needed.

· Click Search then Browse to display the search results in Browse View.

· Click Search then Table to display the search results in Table View.

· Click Dictionary to display the Dictionary dialog and select a word from

your dictionary to Add to your search string.  The word will be added

following an OR operator.

5. Click Done to exit the Query by Example dialog.

You can use Form Search to add to a query.  By changing the first

Connector chosen to something other than *New*, the Form

Search will be added to the previous query.

Advanced Search

Advanced Search allows you allows you to type longer, more complex search

strings.  After executing the search,  Advanced Search displays Results for each of

the terms in your search - along with the number of hits and documents.  The total
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number of hits and documents is shown at the bottom of the Results list

(highlighted in gray).  

Double-clicking a term in the Results field narrows your search to only those

documents containing the term. The search results are displayed in Table View. The

first document in the search results is displayed in the Browse View.

Advanced Search is available in the Search Panel in the Navigation Pane.
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Display the Database Dictionary

Use your database dictionary to search for keywords and also to add words directly

to a search string in the Advanced Search panel. You can also use your dictionary

to see if a word already exists (has already been indexed).  If a word is not in the

dictionary, use relational searching. 

To open the Dictionary dialog, in the Advanced Search Panel of the Navigation

Pane, click the Display the database dictionary link.   This list contains every

word, other than stopwords, in the database since the last index or reindex.  If the

database is concatenated, the list displays only words in the primary database.

While the Dictionary dialog is open you can:

· Select a word and click the Add button to add it to the search string in the

Advanced Search panel.  The Dictionary dialog closes.

· Double-click a word to add it to the search string without closing the Dictionary

dialog.  You can then pick additional words to add.  Additional words will be

added separated by OR in the search string.  Click Done when you are finished

specifying the OR phrase.
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You can add words to your search string directly from the Dictionary list by

selecting a word and clicking Add.

The maximum length of a dictionary word is 64 characters.  Only

the first 64 characters of a word longer than 64 characters are

included in the dictionary. 

Display the Fields List

Use your fields list to view available fields in a database and add fields directly to a

search string in the Advanced Search panel.

To open the Fields dialog, in the Advanced Search Panel of the Navigation pane,

click the Display a list of available fields link.

While the Fields dialog is open you can:

· Select a field and click the Insert button to add it to the search string in the

Advanced Search panel.  Click Done to close the Fields dialog.

· Double click on a field to add it to the search string in the Advanced Search

panel.  Click Done to close the Fields dialog.
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If the field you add is type Paragraph, Concordance automatically inserts field

limiters into the search string, and separates adjacent Paragraph fields by commas.

Displaying Sound Alike Words

You can use a fuzzy search to find misspelled words.  A fuzzy search looks for

homonyms in the dictionary - finding words that look similar or sound like the

word you want to find.

To open the Fuzzy Search dialog, type a word in the Advanced Search pane

search terms box and click the Display a list of words that sound like the

selected word link.

While the Fuzzy Search dialog is open you can select one or more words, then click

OK.  The words will be added to the search string in the Advanced Search panel

(multiple words are separated by OR).

When you perform a search for a word, Concordance automatically searches for

any synonyms associated with that word in the the database dictionary. Synonyms

are created and managed in the Synonyms dialog box. 

Synonyms can be based on words already entered in your database dictionary,

creating a permanent link between them, or other search terms in Concordance.

You can also create synonyms from the fuzzy words list, to include homonyms or
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words that “look like” and “sound like” those already in your dictionary and

synonyms listings. Fuzzy words provide a 65% character match on search terms,

but fuzzy searches can miss words longer than the search term.

Synonyms are stored in the .syn file and fuzzy words are stored in the .fzy file. Both

files are located in the same directory folder as the primary database.

Here are some examples of synonyms you can create:

· Common American English and UK English spellings, such as color and colour

· OCR errors and misspellings

· Acronyms

· Associating generic drug names with brand name medications 

· Associating e-mail messages to a person’s name 

· Capturing misspellings of a person’s name 

To Create a Synonyms List

1. Click File>Dictionaries>Synonyms.  The Synonyms dialog displays.
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2. In the Dictionary list, click the word you want to link to synonyms.

· To search for a word in the Dictionary list, type or select part or all the word

you are looking for in the field below the Dictionary list.

· If you only want the Dictionary list to display words already associated with

synonyms, select the Limit to words with synonyms check box. If you want

the Dictionary list to display each word in the dictionary, clear the Limit to

words with synonyms check box. 

· You can manually adds words to the synonym list or add words to the

synonym list from the Fuzzy matches list. You can associate multiple

synonyms with a dictionary word. 

3. To manually add a word, in the field at the bottom of the Synonym list, type in

the corresponding synonym and click the Add button.  Clicking the Add

button adds the word to the Synonyms list. Repeat this step for each of the

synonyms you want to associate with the selected dictionary word.

4. To add a word from the Fuzzy matches list, in the Fuzzy matches list, click

the word and click the double arrows << button.

5. When finished, click OK.
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When you run a search for a word in the Advanced Search inside the Search

Panel in the Navigation Pane, you should see synonyms listed as hits in the

Results list since they are linked to the word in the dictionary.

Advanced Searching

Full-text and relational searches each have different pros and cons.  It is important

to understand when to use each.  You can combine full-text and relational searches

together - allowing you to search free-text paragraph fields and fixed fields at the

same time to maximize your query potential.

Comparison of Full-Text versus Relational Searches

Full-Text Relational

Searches the dictionary,

uses index to display

words from dictionary

search

Searches the database in

real time

Very fast Slower (depending on size

of database)

Hit highlighting in red No hit highlighting

Can only search indexed

fields

Can search any field,

indexed or not

Easy to search multiple

fields at once

Searches one field at a time

(unless fields groups are

established in the .INI file)
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Full-Text Relational

Used more often to find

words

Used more often to find

dates, numbers, ranges,

comparisons

Cannot be used on date

fields

Can find specific dates or a

range of dates within limits

or outside limits

Often used on paragraph

fields

Normally used on

paragraph fields only to find

empty/not empty fields

Cannot be used until the

database has been

indexed. Will not find new

data until database has

been reindexed.

Can be used whether or not

the database has been

indexed

Cannot be used to find

stopwords, since they are

not in the dictionary

Can be used to find

stopwords

Uses the * wildcard

character.

Can be used before or

after the word.

Uses the * wildcard

character only at the end of

a word. Use the ? wildcard

character, to replace a single

character in the middle of a

word and in data searches.

Always searches the

complete contents of

paragraph fields

Only searches the complete

contents of paragraph fields

when using CO and NC

operators
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Boolean (Document Level)

Boolean operators provide basic true or false results. In Concordance, Boolean

operators search at the document level. The operators are not case-sensitive.

Boolean Operators

Operator Descripti

on

Query

Example

Results

AND contains

both

words

milk AND

coffee

documents

with both

the words

"milk" and

"coffee"

OR contains

either

word

milk OR

coffee

documents

with either

"milk" or

"coffee", or

both

NOT contains

first word,

but not

second

milk NOT

coffee

documents

with "milk",

but not

"coffee"

XOR contains

either

word but

not both in

the same

record

milk XOR

coffee

documents

with "milk"

or "coffee",

but not

both words
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Context (Field Level)

Context operators search at the field level and are combinations of field limiters

and qualifiers.  Field limiters specify the field(s) to search, and qualifiers allow you

to search for multiple terms.  Context operators are not case-sensitive.  Take care to

not put spaces between the periods in the field limiters and the field names.

Context Operators and Qualifiers

Query

Example

Results

.<fieldn

ame>.

milk.DOCTITL

E.

documents that have the

term "milk" in their

DOCTITLE field

..<fieldn

ame>.

milk..DOCTIT

LE.

documents that have the

term "milk" in any field

other than DOCTITLE
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Context Operators and Qualifiers

SAME coffee SAME

milk.DOCTITL

E.

documents that have the

term "milk" in their

DOCTITLE field, and also

have the term "coffee" in

that same field

SAME coffee SAME

milk..DOCTIT

LE.

documents that have the

term "milk" in any field

other than DOCTITLE, and

also have the term "coffee"

in that same field

NOTSA

ME

coffee

NOTSAME

milk.DOCTITL

E.

documents that have the

term "milk" in their

DOCTITLE field, and also

have the term "coffee" in a

field other than DOCTITLE

NOTSA

ME

coffee

NOTSAME

milk..DOCTIT

LE.

documents that have the

term "milk" in any field

other than DOCTITLE, and

also have the term "coffee"

in a field different than the

field where "milk" is located

Proximity (Word Level)

Proximity operators search at the word level within a document.  These operators

allow you to locate a search term within a certain distance of another.  The

maximum range of words is 255, and it does not include stopwords.
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Proximity Operators and Qualifier

Operator Query

Example

Results

ADJ milk ADJ

coffee

(same as a

search for

"milk

coffee")

documents that have "milk"

and "coffee" immediately

next to each other and in

the order specified

NEAR milk NEAR

coffee

documents that have "milk"

and "coffee" within close

range of each other,

regardless of order

<word

range>

can be a

number

between 0

and 255

milk ADJ5

coffee

milk

NEAR5

coffee

documents that have "milk"

within 5 words of "coffee",

in that order

documents that have "milk"

within 5 words of "coffee",

in any order

Wildcard (Field and Character Masking)

Wildcard characters help when searching for more complicated strings where

misspellings or variations can occur.  
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As an example, names in documents are also easily misspelled and could be

overlooked if apostrophes and initials are combined in records. Using a wildcard as

a substitute for a character or series of characters leads to a broader search with

stronger results.

Wildcards

Query

Examp

le

Results

Asterisk (*)

Can be used at the

beginning or end of

a search string or

fieldname

*count* documents that have

the characters

"count" within any

word, with 0 or more

characters before

and after "count"

includes minimally

documents with

these words:

account, accountant,

country, countries,

discount

milk.TE

XT0*.

documents that have

the term "milk" in

the TEXT01, TEXT02,

TEXT03, etc. fields
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Relational searches query the entire database in real time, searching a specified

field for a specified value. Relational searches are primarily used to search fields

with unique values such as Bates numbers or dates, and other short fields.

Relational searching does not require an index.  You can also search on all

punctuation and stopwords in the database. Because Concordance is searching the

actual database data in real time without an index, relational searching can take

longer than full-text searching. 

Relational searches can be done on full-text fields, but it is best practice to use full-

text searching for full-text fields when you can to save time.  Relational searches

can run faster if you combine them with a full-text search.

Like full-text queries, relational searches are not case sensitive. You may enter your

search in upper, lower, or mixed-case letters.

Relational search results are not highlighted in red. Instead, you receive a list of

records containing your query results in the Table view.

Relational Search Syntax

Relational search requests are entered in a structured query format. Each query

contains at least three elements:

· the fixed field name to search

· a relational operator

· the data value or selection criteria

Relational Operators



Concordance Classic132

© 2022 CloudNine™. All rights reserved.

There are ten relational operators available in Concordance.  Most of the relational

operators have both a symbol and an abbreviation - they may be used

interchangeably.  Be sure to include spaces between words and symbols or

abbreviations so your search can be interpreted correctly.

Search for several values at once by separating them with commas. Spaces

between the values are optional. 

If you are searching for a value that itself has a comma, space, or operator symbol

in it, then the value must be placed in quotes.

Concordance searches numbers and dates in sequential order.  It is best to enter

the smaller number or date first, then the bigger number or date when specifying a

range.

Relational Operators

Sy

mb

ol

Ab

bre

via

tio

n

Descripti

on

Additional Info

= EQ equals

<> NE not equal

to

> GT greater

than

< LT less than
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Relational Operators

>= GE greater

than or

equal to

<= LE less than

or equal to

$ CO contains Only valid when

searching text or

paragraph fields.  If used

on numeric or date fields,

Concordance processes

as if you entered EQ.

! NC does not

contain

Only valid when

searching text or

paragraph fields.  If used

on numeric or date fields,

Concordance processes

as if you entered NE.

(no

sy

mb

ol)

WL within

limits,

includes

stated

values

two values are required

to specify a range,

separated by a comma

(no

sy

mb

ol)

OL outside

limits,

excludes

stated

values

two values are required

to specify a range,

separated by a comma
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Use relational searching to search for empty or populated fields.

· <fieldname> EQ “” - locates records where <fieldname> is

empty

· <fieldname> NE “” - locates records where <fieldname> is

populated with any value

Wildcard Characters

When Concordance reads a relational search, it views each individual character. 

Individual or multiple characters can be masked using wildcard characters in order

to accept zero or more characters in that position.

Only the question mark wildcard can be used in dates.  For relational date searches,

be sure to include the slashes when constructing the date string based on the date

format for the field you are searching.

Wildcard Characters

C

h

a

r

a

c

t

e

r

D

e

s

c

r

i

p

t

i

o

n

Query

Example

Results
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Wildcard Characters

*

(

a

s

t

e

r

i

s

k

)

m

a

s

k

s

m

u

l

t

i

p

l

e

c

h

a

r

a

c

t

e

r

s

(

z

e

r

o

o

r

m

o

r

e

TEXT05 =

woman*

all records containing words

starting with "woman" in the

TEXT05 field (including

"woman", "womanhood",

"womankind", etc.)
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Wildcard Characters

)

a

t

t

h

e

b

e

g

i

n

n

i

n

g

o

r

e

n

d

o

f

a

w

o

r

d

?

(

q

u

e

s

m

a

s

k

s

a

TEXT05 = ?og all records containing three

letter words ending in "og"

in the TEXT05 field (for

example: "dog", "log", "fog",

etc.)
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Wildcard Characters

t

i

o

n

m

a

r

k

)

s

i

n

g

l

e

c

h

a

r

a

c

t

e

r

Sample Searches

Search Results

ISBN = 0-

477-01-

482-8

documents that have "0-477-01482-8" in

their ISBN field
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Sample Searches

milk and

DATE >=

4/22/1990

first Concordance finds documents that

have the term "milk",  then from that result

set - any documents whose DATE field is

greater than or equal to "4/22/1990"

AREACOD

E = 513,

719

documents that have either "513" or "719"

in their AREACODE field

OCR CO

side

documents that have the characters "side"

within their OCR field - even within a word

(for example the words "inside", "outside",

"considered", "presides", and others)

CREATION

DATE WL

6/10/2019

,

6/15/2019

documents that have their CREATIONDATE

field greater than or equal to "6/10/2019"

AND less than or equal to "6/15/2019"

CREATION

DATE OL

2/12/2019

,

6/11/2019

documents with a CREATIONDATE prior to

2/12/2019 or after 6/11/2019

CREATION

DATE

= ??/??/20

12

documents with a CREATIONDATE in the

year 2012 - with any day and month
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Sample Searches

TEXT03 =

"$5,000"

documents with the TEXT03 field containing

the string $5,000

A complex clause search is a search string containing multiple search clauses, and

can include either or both full-text and relational search clauses.  Full-text search

clauses should appear first, then relational clauses - to make your searches efficient

and result in a distinct outcome.

Remember the order of fields and operators for full-text and

relational search clauses:

· full-text clauses - the fieldname is typed last (ex. smit*.recipient.)

· relational clauses - the fieldname is typed first (ex.

CREATIONDATE = ??/??/1990)

To combine search clauses together, simply join the clauses using Boolean, context,

or proximity operators.  When combining search clauses it is important to

understand the operator precedence.  You can add parentheses to override the

operator precedence or make your search string easier to read.  Parentheses have

the highest precedence and can be nested up to 50 levels deep.  Be careful when

using spaces, since field limiters (. and ..) cannot have spaces.

The following table shows the operator precedence order for Concordance

searches, highest at the top.

Operator Order of Precedence

Operato

r

Description
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Operator Order of Precedence

ADJ Locates words that are

immediately adjacent, and

you can specify a range of

intervening indexed words

from 0 to 255

NEAR Locates words that are near

each other, and you can

specify a range of

intervening indexed words

from 0 to 255

SAME Finds words within the same

field

NOTSAM

E

Finds words that do not

occur in the same field

AND Combines words and search

results that occur in the same

document

NOT Combines words and search

results if they do not occur in

the same document

OR Combines words and search

results, whether they occur in

the same documents or not;

Concordance doesn’t care
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Operator Order of Precedence

XOR Finds documents that

contain one of two search

terms, but not both

Sample Complex Searches

Search Results

milk AND

sugar

NEAR25

coffee

NEAR has a higher precedence.  This is

evaluated as milk AND (sugar NEAR25

coffee).  Results are documents that have

sugar within 25 words of coffee.  Then

those results are searched to find

documents containing milk for the final

query results.

board ADJ

report NOT

financial

ADJ report

This can be translated to board report NOT

financial report.  The results are

documents that don't have both board

report and financial report.

milk.DOCTIT

LE. AND

CREATIOND

ATE

= ??/??/201

2

Results will be documents with milk in the

DOCTITLE field that also have a

CREATIONDATE in the year 2012.
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Tally is a great tool for gaining an item count for a specific field to help you

organize your document collection and for quality assurance checks.  Perhaps you

need to quickly determine how many contracts are currently in your caseload or

verify if any new ones have been added to the database since you started your

review.  Or, find out how many times a key witness is mentioned by tallying the

Author field.  A Tally count itemizes this information for you so you can perform

internal quality assurance checks in your case review, organize documents by field

type, or narrow your searches to a reduced set of records.

The Tally feature is only accessible from the Table view, and runs a query on the

selected field column. Once a Tally has been executed in Table view, you can open

the Tally Panel by clicking the Tally button that appears in the lower section of

the Navigation Pane.
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Run a Tally in Table View
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1. In the Table view, right-click in a field column.

2. Select Tally <field name>.

3. The tally results are displayed in the Tally Panel of the Navigation Pane.

4. Double-click an item in the tally list to display the associated records in the

Table view and the first corresponding record in the Browse view.

Reviewing and Re-running Searches

The Review View provides a complete, numerical listing of all searches conducted

since you opened Concordance or it was last reindexed. The Review View can be

displayed by clicking Review on the Toolbar.

Because each search query is numbered sequentially, you can easily combine 2 or

more searches together using the search number.  Referencing the search number

is much faster than re-typing the search.  For example, type 3 OR 6 in Quick Search

at the top to combine query number 3 and query number 6.  The result for this

example, based on the information above, would be a search for weapon OR skill

OR SASCHA.
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Selecting the Edit icon on the Dynamic Toolbar on the lower left will put the search

terms for the currently highlighted search into the Advanced Search pane on the

left so you can modify them.  You can also select the Activate icon on the Dynamic

Toolbar to re-run the selected search.

Zero Search

The easiest way to return all records for the entire database after running several

queries is to run a Zero Search by typing a zero (0) in Quick Search.

The Zero Search is always the first search run when opening a database in

Concordance.

The Activate button can be used with the Persistent Search option.  If the Persistent

Search option is enabled in the Search pane and then the Activate button is

selected, Concordance returns all the records that contain both the terms in the

query and the Persistent Search text file.

To Copy a Previous Search Query

1. In the Review view, do one of the following: 

· Right-click the search query, click Copy Query, and then right-click in a search

field and click Paste.

· Select the search query, and then on the Dynamic toolbar, click Edit.

· Right-click the search query, and then click Edit.

2. The query displays in the Advanced Search panel, where you can add or edit

the search logic for a new query.
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Tagging

Tagging records is a critical step in the discovery process.  Tagging allows you to

categorize your documents during document review by privilege, review status, or

other criteria that are important to your organization.

To help you manage the case review process, your Concordance administrator

typically builds a set of tags for case review that include standard naming

conventions, such as privileged, responsive, non-responsive, etc. Tags can also be

added in the Tags task pane and can be removed at any time. There are no limits on

tagging. You can tag as many documents as you want, with as many tags as you

want.

Once tags are applied to document records, the tags become searchable, allowing a

user or administrator to easily retrieve all documents with a particular tag.

The following tag list provides some tag examples to consider.  Make sure your

tags can cover both high-level review and specific research for your case. 

Collaborate with your Concordance administrator so appropriate tags can be set up

in advance.

· Responsive or Non-Responsive - identify responsive documents that must

be produced as part of the discovery process

· Privileged - identify documents containing information that should not be

produced

· Witnesses - identify documents for witness kits or binders used in

depositions or trials

· <Reviewer> - create tags for each individual reviewer

· Exhibits - identify documents that will used as exhibits

· Issues - identify documents related to key legal issues in the case

· Keywords - identify documents containing important terms in the case

In order to gain the most benefit from tag use, please consider the following:

· Determine how your database will be used by reviewers, so tags can be

created in advance.
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· Use consistent tag and folder names for better organization.

· As a general rule, search first, tag second. This method allows you to focus on

documents containing key terms or other search criteria, which limits the

number of documents that need to be reviewed.

· For field-level tags, once all documents are tagged with a particular tag,

consider adding a field value to the database to permanently categorize these

documents.

You can quickly see the Tags that are currently defined for your database by

opening the Tags Panel in the Navigation Pane on the left.
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Creating Tags

Tags can be easily created by right-clicking in the Tags Panel.  Select New>Tag.  A

new tag entry will appear in the Tags Panel that you can edit with the name you

want.  By default, when you add a new tag it is automatically selected for the

current document, so be sure to unselect the new tag if it doesn't apply to the

currently displayed document.

New tag folders can be created in a similar fashion.  Right-click in the Tags Panel

and select New>Folder.  When you create a new tag folder, you also need to add

at least one tag to that folder.  Empty tag folders will not be saved.

You can easily organize tags into folders directly in the Tags Panel.  Simply select

the tag and drag to the folder.  You can also select multiple tags and move them at

the same time.
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If you need to remove a folder or tag, contact your Concordance

administrator.

Personal Folders and Tags

You can create a personal folder and custom tags specific to your own review

needs. When you create personal folders, they are not visible in the Tags Panel for

other users, however, personal folders and tags are viewable by your Concordance

administrator.  Create a personal folder first by right-clicking in the Tags Panel

and selecting New>Personal folder.  Then create a new tag in your newly added

personal folder.

Tagging Records

Before you begin tagging records, it is best practice to run a search to limit the

number of documents you have to review.  Tags can be applied and removed by

any user, at any time.

To Apply or Remove a Tag from a Document

1. Select the document you want to tag or untag in either the Browse View or

Table View.

2. Open the Tags Panel.

3. Select or unselect the check box next to the tag you want to add to or remove

from the current document.

When you are viewing a document in Browse View or Table View,

the Status Bar at the bottom of Concordance will display TAG if the

document has one or more tags applied.
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Tagging Multiple Documents

You may want to conduct searches and tag all the results of that search for later

review. This method is often referred to as bulk tagging. 

1. Run a search to generate a list of documents.

2. Select Table View from the toolbar.

3. In the Table View, select all the documents you want to tag.

4.  Open the Tags Panel.

5. In the Tags pane, click a tag's check box.  A menu will display where you can

Apply or Remove the selected tag from the records you have selected in Table

View.

6. Choose the appropriate menu option.  A confirmation dialog will display.  Click

Yes and the tag will be applied or removed from the selected records.

Tagging All Results from a Query
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1. Run a search to generate a list of documents.

2.  Open the Tags Panel.

3. In the Tags pane, right click on a tag name (not the check box).  A menu will

display.

4. Select Tag all documents in a query.  A confirmation dialog will display. 

Click Yes and Concordance will apply the tag you selected to all the results of

the most recent query.

Tag Queries

If you need to identify which documents have a specific tag applied to them, you

can easily do so by creating a query from a tag.
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To Create a Query from Tags

1. Open the Tags task pane.

2. In the Tags task pane, select the tag you want to query. You can select multiple

tags by pressing the Ctrl key while selecting multiple tags.

3. Right-click the selected tag and select Create query from tag(s). 

Concordance runs a query for all documents with the selected tag.  You can

see the results in Browse View or Table View.  If you select multiple tags for

the query, the results will include any documents with any selected tags (this is
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an OR search - tag1 OR tag2)  Your search history also updates to show the

tag query.

You can also execute Create query from tag(s) from a tag folder.  In the example

above, if you create a query from the Reviewer tag folder, the results will display

for documents that are tagged with any tag inside that folder (BJones and SSmith).

Tag History and Statistics

The Tags Panel in the Navigation Pane on the left contains two additional panes

with Tag information.

As you navigate through your database records, the Tag history updates to display

details for tags that have been added or deleted from the currently selected

document.  The history details include who applied or removed the tag, and when.
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The Tag statistics section of the Tags Panel allows you to review the history of all

tags applied to the current database.  You can select a date range at the bottom, to

see what tag activity occurred during that timeframe.  This feature is useful for

monitoring review progress.  If you are not seeing the most recent tag activity, click

the Refresh button at the bottom to update the display.

Transcripts

With Concordance you get the benefit of managing your transcripts within the

same application as your documents. As a transcription management tool,

Concordance provides you with additional review and annotation features

necessary for working with transcripts. You can also join a transcript database with

other discovery databases to search across all documents and transcripts at once.

Like other Concordance databases, transcripts are searched using full-text

operators. You can narrow your search to a specific deponent, transcript date, or

volume number. Specific fields are used in transcript databases to capture that

information.  
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You can create a Transcript database by using a template that is provided with

Concordance.  See Database Templates  for more information.

Concordance displays transcripts in a traditional format familiar to most attorneys

and paralegals. Transcripts are reviewed in the Browse view with the database

listing of individual transcripts in the Table view.

A transcript database has name, date, and volume fields with the full-text of the

deposition stored in the text field. These fields are not visible in the Browse view,

but you will see them in the Table and Edit views. In a transcript database, you can

mark transcripts by line, add notes and issues, and add file attachments or

hyperlinks.

A Quick Mark is highlighting applied on the left side of a transcript denoting the

page and line number. Simply click on a line number during a cursory review. This

is a great way to remind yourself there may be content worthy of a note or issue

tag, or simply marks the place where you may want to return in the future.

351
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Quick Marks made in West® LiveNote® are retained if the

transcript is imported from that application into Concordance.

Transcript Notes

Creating notes within a transcript is an ideal way to create a reminder of relevance

for case arguments. When you need to find these comments later, you can search

the entire transcript database, locate notes attached to a particular transcript, or

find both at the same time.

There is no limit to the number of notes you can apply per transcript. The first lines

of your notes are displayed in the Notes task pane and are also displayed as

floating text when you move your cursor over a highlighted note. Notes disappear

the instant you delete them, but are not physically removed from the database until

your Concordance administrator removes them.

Once transcript notes are applied, there may be times when you need to search for

them in a lengthy transcript.  You can search transcripts notes using:

· Advanced Search panel - enter words found in the notes

· Notes pane - review notes and jump to a specific note within the transcript

The database must be reindexed after notes are added in order to

search those notes. 
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Add Transcript Notes

1. In the Browse view, use your mouse to select the transcript text or region

where you want to apply a note.

2. Right-click the selected text and select New note.  The Notes dialog displays.
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3. On the Note tab, type the applicable comments in the Note text box.

4. Click OK to save the note.  The Notes dialog closes and the area you selected

is highlighted and underlined to show a Note has been added.

Changes are immediately viewable.  In order to run full-text searches on new notes

in the record, the database needs to be reindexed.

Delete a Note

1. In the Browse view, right-click the note with your mouse and select Edit note

to open the Notes dialog. 

2. Click the Delete button, and then when prompted click Yes to verify that you

want to delete the note.

3. The note is removed from the database and the next note displays in the Notes

dialog.

4. Click OK to close the Notes dialog.

Notes disappear immediately after deletion, but are not physically removed from

the database until your Concordance administrator removes them.
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Search Transcript Notes Using Advanced Search

1. Open Advanced Search in the Search Panel in the Navigation Pane.

2. In the Options drop down, select Search notes only.

3. Type the search string in the Advanced Search text box.

4. Click Search to run the query.

5. Results updates to show the search hits.  You can also select the Notes Panel

to review the Notes that match the search.

Transcript Issue Tags

Tags work well for categorizing documents, because tags mark or categorize an

entire document.  Transcripts are handled differently than documents in

Concordance.  Instead of marking the entire transcript, you are marking a section of

text within a transcript.  An Issue Tag is a tag applied to a section of transcript text. 

When you're adding Issue Tags to transcripts, you can also enter comments with

the Issue Tag for further distinction.

You can apply Issue Tags to transcripts from both the Tags Panel in the

Navigation Pane and the Notes dialog.

In the Tags Panel, Document Tags appear in black text and Issue Tags appear in red

text.
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Add an Issue Tag from the Notes Dialog Box

1. In the Browse view, use your mouse to select the transcript text or region

where you want to apply a note.

2. Right-click the selected text and select New note.  The Notes dialog displays.

3. In the Issues list on the left, select the Issue Tag that you want to apply.  The

Issue Tag will update with a check mark to show it has been selected.

4. Click OK to save the Issue Tag and close the Notes dialog.

Add an Issue Tag from the Tags Task Pane

1. In the Browse view, use your mouse to select the transcript text or region

where you want to apply a note.

2. Open the Tags Panel in the Navigation Pane.

3. Hold the Shift key and select the check mark next to the Issue Tag you want to

apply.  The Issue Tag will update with a check mark to show it has been

selected.

Some people find that they highlight and select text as they read

documents and transcripts. Doing so may cause accidental issue

tagging if you are using a single left click to add issue tags. For

those users in this scenario, it is best to train yourself to add issue

tags using only the right-click menu option. When applying

document tags to an entire document record, make certain that no

text in the record is highlighted.
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Transcript Attachments

Transcripts often reference exhibits and evidence. The ability to view that evidence

as you are reading a transcript is useful in your review. Exhibits attached directly to

a transcript excerpt are an easy way to refer back to those exhibits.

Add Attachment to a Transcript

1. In the Browse view, use your mouse to select the transcript text or region

where you want to add an attachment.

2. Right-click the selected text and select New note.  The Notes dialog displays.

3. Click on the Attachment tab.

4. Select the appropriate Attachment type:

· External - to attach an external file or link to a web site

· Viewer - to attach a document image from a Concordance database

· Clipboard - to copy the highlighted text to the Microsoft Windows clipboard

· Internal - used by the system only

5. Click Browse to navigate to and select the applicable file or web site for the

attachment.  Click Open.
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6. Select Open attachment when note is clicked if you want to automatically

open the file or web site when clicking a note in Concordance.

You can save a copy of the attachment by right clicking the highlighted text and

selecting Save attachment as.

Reviewing Transcript Notes
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A quick review of a transcript notes and issues can be done in the Notes panel.

Select a specific note in the Notes list and the Properties pane updates to display

the details for that note.

To Review Notes and Issues in a Transcript

1. Open the transcript in the Browse view.

2. Open the Notes task pane.

3. In the Notes panel, select either View by notes or View by issues to display

the list of notes or issues.  Notes and issues display in the order they appear in

the transcript, not eht order applied.

4. Select a note or issue in the Notes pane.  The selected note or issue will be

highlighted and displayed in the transcript on the right.  The Properties pane

updates to display the location, plus attachment information.

5. You can also double-click a note or issue in the transcript to open the Notes

dialog and edit the note, issue, and/or attachment.

Annotation Report Writer Wizard

Because your transcripts are unique documents with added notes, highlights and

attachments, Concordance offers an Annotation Report Writer tool for customizing

reports for your transcript database.

Depending on your needs, each annotated report created in the wizard may include

several types of annotations and the text included in the annotations. 

1. In Concordance, open your transcript database.

2. On the Toolbar, click the arrow next to the Report button and select

Annotation report writer.

3. In the Annotation Report dialog box, select Annotation Report Wizard and

click OK.  The Report dialog displays.
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4. Select the type of annotated report you want to print:

· Issue report - prints an issues report

· Attachment report - prints a report of annotations containing attachments

· Note report - prints a report of annotations containing notes

· Quick mark report - prints a report of all transcript line number highlights  

5. Click Next.  The Issues dialog displays.  
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6. If you selected Issue report, choose either Print all issues or Print selected

issues and select the issues to print from the list box.

7. Click Next.  The Annotations dialog displays.
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8. In the Annotations section, select the options you want.  You can also select

specific users in the list box on the bottom right.

9. Click Next.  The Context dialog displays.

10. Select the Context options you want.  Click Next.  The Formatting dialog

displays.
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11. If desired, add a custom header and/or footer to the report by filling out the

Header and Footer fields.  Specify any additional formatting options you

need.  Click Next.  The Print dialog displays.

12. Define your final print options in the Print dialog box, like customizing the

font and page layout, and whether to print a hard copy or save to a file.  It is
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recommended to preview your report before printing a hard copy or saving to

a file.

13. Click Print to print the report.

Content Review

Document content review is done using one of the viewers available for

Concordance:  Concordance Viewer, Concordance Native Viewer, or Concordance

Image.  You can magnify the original document image for clarity and inspection,

markup the document with tools specifically designed for handling privileged

content and trial preparation.  Once you have reviewed and annotated the content,

the information is saved and changes secured.

The viewers open in a secondary window, which can be resized and viewed

alongside the main Concordance application - allowing you to see the Browse and

Table Views while reading the full document content.

When you create a new database using the wizard, you have the option to specify

whether you will use the Concordance Viewer or not.  You can also specify the

viewer to use with a database via the Viewer Preferences.

The table below provides a guide to which viewer works best with which database

type.
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Datab

ase

Type

Conco

rdance

Viewer

Conco

rdanc

e

Native

Viewe

r

Conco

rdanc

e

Image

Load

Files

YES YES YES

E-

docume

nts

YES YES NO

E-mail

and

Attach

ments

YES YES NO

Transcri

pts

NO NO NO

Converting from Concordance Native Image to

Concordance Viewer
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Converting single or concatenated databases to Concordance Viewer

is permanent and not backwards compatible.  Make sure that you

backup all database files prior to conversion.

If you want to convert newly concatenated databases, be sure to

save the concatenated file set.  Then close and reopen the

concatenated file set before attempting a conversion.

Highlight, Image, and Underline markups are not supported for

conversion from Concordance Native Viewer to Concordance

Viewer.

Unsupported markups will not exist in the converted Concordance

Viewer database.  Other markups will be converted, but some

markup locations may change slightly during the conversion

process.  You should review your markup content after conversion.

You have the option to update an existing Concordance Native Viewer database to

use the latest Concordance Viewer for review.  This requires a two step process:

1. Update your Viewer Preferences for the database.

a. Open the Concordance Image or Concordance Native Image database.

b. From the Tools menu, open the Preferences dialog and go to the Viewer

tab.  

c. In the Apply user settings to drop down, select All users.

d. In the Apply database settings to drop down, select Current database.

e. In the Viewer drop down select Concordance Viewer.  

f. Click Apply in the Preferences dialog, and then OK to close the window.

2. Open the viewer.
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a. Select Image from the View menu or click the View Image button on the

toolbar.

b. You will be prompted to confirm that you want to proceed with conversion.

  

c. Click Yes.

d. The Native Conversion window displays and shows you the status while the

conversion is running.  
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e. Upon completion, you will see a Concordance Redaction Converter

window that displays the final migration status.  

f. You can click View Log or View Report to see more details about the

conversion, or click Done to close the conversion window and open the

Concordance Viewer.
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Converting from Concordance Image to

Concordance Viewer

Converting single or concatenated databases to Concordance Viewer

is permanent and not backwards compatible.  Make sure that you

backup all database files prior to conversion.

If you want to convert newly concatenated databases, be sure to

save the concatenated file set.  Then close and reopen the

concatenated file set before attempting a conversion.

All markup history is lost when converting from Concordance Image

to Concordance Viewer.  The newly converted Concordance Viewer

database will have history, but that history will contain a list of

markups that were converted, each with the date/time that the

conversion was completed.

Highlight, Hollow Ellipse, and Solid Ellipse markups are not

supported for conversion from Concordance Image to

Concordance Viewer.

Unsupported markups will not exist in the converted Concordance

Viewer database.  Other markups will be converted, but some

markup locations may change slightly during the conversion

process.  You should review your markup content after conversion.

You have the option to update an existing Concordance Image database to use the

latest Concordance Viewer for review.  This requires a two step process:

3. Update your Viewer Preferences for the database.

a. Open the Concordance Image or Concordance Native Image database.
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b. From the Tools menu, open the Preferences dialog and go to the Viewer

tab.  

c. In the Apply user settings to drop down, select All users.

d. In the Apply database settings to drop down, select Current database.

e. In the Viewer drop down select Concordance Viewer.  

f. Click Apply in the Preferences dialog, and then OK to close the window.

4. Open the viewer.

a. Select Image from the View menu or click the View Image button on the

toolbar.

b. You will be prompted to confirm that you want to proceed with conversion.

 

c. Click Convert.

d. The Convert ImageBase window displays and shows you the status while

the conversion is running.  
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e. Click Close to dismiss the Convert ImageBase window and open

Concordance Viewer.  

Review with Concordance Viewer

The Concordance Viewer allows you to magnify the original document image for

clarity and inspection, and provides a variety of markup tools specifically designed

for privileged content and trial preparation.  Once you have reviewed and

annotated the content, especially redacting key information, the document

markings are automatically saved and the changes secured. 

Concordance Desktop stores references to all native documents and image

information in a single Concordance Desktop Image Base database (.cib) file. The

.cib file is located in the same folder as the associated Concordance Desktop

database (.dcb).   

Imported eDocs and eMails are automatically converted to near-

native PDF files for viewing with Concordance Viewer.  For load file
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imports, there is an option to convert to PDF for near-native

viewing during database creation.  If the load file has unsupported

file types, they can be converted at import or converted later using

the optimize feature on a document, a query, or the entire

database.

Supported Files

Concordance Viewer works with the following file types:

File Type Description

*.tif, *.tiff Tagged Image File

*.jpg, *.jpeg Joint Photographic

Experts Group

*.pdf Adobe Portable

Document Format

The Concordance Viewer displays the image or near-native file associated to the

record currently open in Concordance.  Using the tools in Concordance Viewer you

can review documents, navigate between records, apply markups (annotations),

and adjust the display of the documents.  
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From an open database in Concordance, you can launch Concordance Viewer by

selecting the View Image (camera) icon on the Dynamic Toolbar.

Viewer Toolbar
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Tool N
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Markup Toolbar

To

ol

Na

me

Description

Reda

ct

Blocks out areas on the page that

are considered confidential or

sensitive from being viewed or

copied after production

High

light

er

Highlights the selected text

Rect

angl

e

Draws a rectangle around the

selected area on the page
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To

ol

Na

me

Description

Ellip

se

Draws an ellipse around the

selected area on the page

Conn

ecte

d

Line

Draws a jointed line on the page

Line Draws a straight line on the page

Text Places a box that contains text on

the page

Cross

out

Draws an X on the page

Note Places a box on the page to hold

short notes

Stam

p

Places a predefined stamp on the

page

Arro

w

Draws a line with an arrow
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To
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Description

Imag

e

Places an external image (jpg,

bmp, or png) on the page

Und
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e

Draws an underline under the

selected text

Strik
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ough

Draws a strikethrough line over

the selected text

Rota

te

(cloc
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e)

Rotates the document 90 degrees

clockwise

Rota

te

(cou

nterc

lock

wise)

Rotates the document 90 degrees

counterclockwise

Fit to

Widt

h

Adjusts the zoom so that the entire

width of the document appears in

the Viewer Pane
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To

ol

Na

me

Description

Best

Fit

Adjusts the zoom so that the entire

width and height of the document

appear in the Viewer Pane

Underline and Strikeout are only available if the document contains

selectable text and text is selected.

Viewer Pane

The Viewer Pane displays the current page of the current document.  The document

number is displayed at the top.

Thumbnails Pane

The Thumbnails pane displays small images of the pages within the current

document.  You can hide or show the Thumbnails pane by clicking Expand

Thumbnails (4 dots) to the right of the Viewer Pane.

If a page contains markups, it will display with a red box surrounding the thumbnail

image.  You can navigate to the next or previous page with markups by using the

red navigation arrows at the top of the Thumbnails Pane.

Select a specific page in the Thumbnails Pane to display it in the Viewer Pane.  

Information Pane
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The Information Pane contains additional information about each document.  The

Information Pane can display two different tabs: 

· Properties Tab -  displays numeric, text and paragraph data, up to 40 characters,

from the document's Concordance fields.

· History Tab - displays the markup history, in descending page order, of all

markup additions, modifications, and deletions that have been made to the

current document.

Status Bar

The Status bar at the bottom of  Concordance Native Viewer displays information

about the current database being viewed, including whether the database is

editable or not.

Concordance Viewer is synchronized with Concordance.  Each separately opened

database has a tab at the top of Concordance Viewer that displays the database

name.  The name of the currently viewed database will be underlined.  You can

have up to 16 databases open in Concordance Viewer at the same time.

Documents may consists of multiple pages.  You can always determine what page

you are currently viewing by looking at the page information in the lower right

corner (on the Status Bar).

Use the Viewer Toolbar at the top to move between documents, and move to

different pages within a document.  You can also navigate pages by selecting a

page in the Thumbnails Pane.

You can close a specific database in Concordance Viewer by clicking the X in the

upper right corner of that database tab at the top.

Concordance Viewer provides a variety of tools that you can use to annotate

documents or images during review.  Applying markups includes redacting

information and adding notes. You can also apply color markings to highlight or

underline text and add a circle or box to emphasize a block or region of key

content.  All of these elements can easily be edited, moved, or resized.
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There is no limit to the number of markups you can add to a document.  As a best

practice, use some restraint and stick to the internal review guidelines for your

organization, ensuring all annotation marks are sensibly applied and records are

kept clean for other reviewers.

Markups for the current document are displayed in the Information Pane on the

right side in the Concordance Viewer.  The markup history includes markup type,

author, date, and time.  Markup history is also saved in the .CIB file.

When you select a Markup Tool, the top of the Viewer Pane updates to display an

appropriate toolbar to use for adding or editing that markup.  You can change the

appearance, size, and location of markups after you add them.  All changes are

tracked in the History tab of the Information Pane.

The Markup Properties Toolbar
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Add Text Markup

1. On the Markup Toolbar, click the Text tool.

2. Adjust any text markup attributes you want in the Markup Properties Toolbar.

3. Use your mouse to draw a text box in the document.It'

4. Double click inside the text box and type the text you want to add.

5. Click outside the text box or navigate to another document to save the

markup.
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Add a Note

1. On the Markup Toolbar, click the Note tool.

2. Adjust any note markup attributes you want in the Markup Properties Toolbar.

3. Use your mouse to draw a note box in the document.

4. Double click inside the note box to enter your note text.

5. Click outside the note box or navigate to another document to save the

markup.

A Note is created with the text "Short Text" by default.

Add a Line or Shape Markup

1. On the Markup Toolbar, select the line or shape tool you want to add.

2. Adjust any markup attributes you want in the Markup Properties Toolbar.

3. Use your mouse to draw the line or shape on the document.

· For a Connected Line, click the mouse to start and end a line segment. 

Double click the mouse after drawing the final line to finish.

· For a Line, click and hold the mouse while drawing the line, then release

the mouse to complete the line.

· For a Rectangle or Ellipse, click the mouse then drag the mouse to form

the rectangle or ellipse in the shape you want.

4. Click outside the line or shape, or navigate to another document to save the

markup.

Selectable Text Markups
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When a document contains selectable text, the Strikeout, Underline, and Highlight

tools become available.

1. In the document, use your mouse to select the text to apply the markup to.

2. On the Markup toolbar, select the Strikeout, Underline, or Highlight tool.

3. For a Highlight, in the Markup Properties toolbar, select the highlight color you

want to use.

4. Click outside the applied markup, or navigate to another document to save the

markup.

Editing a Markup

1. Use your mouse to select the markup to edit in the document.

2. In the Markup Properties toolbar, modify any properties as needed.

3. Depending on the markup type, after selecting the markup to edit the display

updates to display resize and rotate handles.  You can select any of these to

modify the size or rotate the markup as needed.

4. Click outside the updated markup, or navigate to another document to save

the markup changes.

Delete a Markup

1. Using your mouse, select the markup you want to delete.

2. Press Delete.  The selected markup is removed.

3. Click inside the document again, or navigate to another document to save the

markup changes.

The Image tool allows you to insert images (JPG, BMP, or PNG) into the current

document.  
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The Stamp tool inserts a stamp with short text in the document.  You can specify

any stamp text you need such as:  Attorney's Eyes Only, Attorney-Client Privilege,

Confidential, and Under Seal.

To Insert an Image

1. On the Markup Toolbar, click the Image tool.

2. In the browse window, navigate to and select the image file you want to use

and click Open.

3. In Concordance Viewer, use your mouse to select the area where you want to

add the image.

4. Click outside the image or navigate to another document to save the markup.
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To Insert a Stamp

1. On the Markup Toolbar, click the Stamp tool.

2. Adjust the color, font, or font attributes for the stamp in the Markup Properties

Toolbar.

3. Use your mouse to draw a stamp box in the document.

4. By default, the stamp text is Confidential.  You can double click inside the text

box and modify the text if needed.

1. Click outside the stamp or navigate to another document to save the markup.

A redaction is used when confidential information needs to be hidden in a

produced document.  Redactions placed using the Concordance Viewer are

transparent and can be edited, moved, or deleted similar to other markups.  Once a

document is produced, redactions cannot be edited or removed in the produced file

and any text or images concealed by a redaction cannot be viewed, copied or

searched.

The Redaction tool allows you to place one or more redactions over various areas

of sensitive information within a document.  In Concordance Viewer, the redaction

appears transparent to allow you to make sure the redaction covers the

information you want to conceal.  When a production is executed, the redaction

becomes opaque concealing the information underneath.

Since PDF files are not flattened or burned, when producing PDF files the redacted

information is removed from the file before the redaction is placed.  The production

process physically removes the hidden text from the produced file, the original

document is not altered.

Redactions can be applied to specific text, or they can be applied as a box over an

area of a document or image.  It is recommended to us a different color for

redactions than other markups.  This ensures that the markup type can be easily

differentiated when viewing a document or image.
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If you need to produce text files, you will need to OCR the

produced images after the redactions have been burned into the

production output, or you can choose to scrub redacted text when

generating a Production.

When redacting a bullet or numbered list, it is recommended that

you apply redactions using the Area Redaction tool. This ensures

that the list content is completely redacted when the content is

produced and/or printed. 

All redactions are produced as black when Black & White is

selected in Image Settings for the production output.  Color

redactions will appear as set by the user when Color is selected for

the production output.

To Add an Area Redaction

1. On the Markup Toolbar, click the Redaction tool.

2. Adjust the redaction attributes you want in the Markup Properties Toolbar. 

You can modify the redaction color and the redaction Reason.  You can select

a previously entered Reason in the list or type in a new one.

3. Use your mouse to draw a redaction box in the document over the text and/or

image you want to redact.

4. Click outside the redaction or navigate to another document to save the

markup.

To Add a Text Redaction

1. Select the text in the document that you want to redact.

2. On the Markup Toolbar, click the Redaction tool.  The text will show a

redaction applied.
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3. If necessary, click the redacted text in the document and adjust the Markup

Properties.  You can modify the redaction color and/or the redaction Reason.

4. Click outside the redaction or navigate to another document to save the

markup.

Editing a Redaction

1. Use your mouse to select the redaction to edit in the document.

2. In the Markup Properties toolbar, modify any properties as needed.

3. Click outside the redaction or navigate to another document to save the

redaction changes.

You can print the currently displayed document using Concordance Viewer.  When

printing in Concordance Viewer, be aware of the following:

· When printing documents that have been reviewed and redacted using

Concordance Viewer, any redaction placed on the document will print

transparent revealing the text underneath.   If you want to print opaque

redactions, be sure to select the Opaque option in the Markups section of the

print settings.

· Printing documents that contain markups to Adobe PDF using the File>Print

option, does not permanently burn the markups in the document.  If you want

markups burned in, you must run the documents through the Production

process in Concordance, then print the produced document.

· Some document types such as .xls, the landscape option will split the page by

columns and print as portrait.

· Make sure your printer's color properties are set appropriately.

· The maximum number of copies that can be printed is 100, and the copies are

automatically collated.
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· Crossout, strikethrough, highlight, and underline markups can all be applied to

the same text, and if so, are combined in the printed file.  This means, for

example, if crossout and highlight are both applied, but only crossout is

selected for printing, both the crossout and highlight will be printed.
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To Print in Concordance Viewer

1. From the hamburger menu  in the upper left corner, select Print.  The

Concordance Printing dialog displays.

2. Select the Printer you want to use for printing the documents and/or images.

3. In the Document Selection section:

· Choose the Document Range and Page Range you want.  If you select a

page Range, you can also specify the range of pages to print for each

document.

· Select the Include document separator sheet checkbox if you want

separator sheets printed at the beginning of each document.  See

Configuring Separator Sheets  for configuration information.

· Select the Include document synopsis checkbox if you want synopsis

sheets printed at the end of each document.  See Configuring Synopsis

Sheets  for configuration information.

4. In the Output Settings section:

· Select Portrait or Landscape for the Orientation.

· Choose Color or Greyscale in the Color Settings drop down.

· Select the Resize for best fit checkbox if you want the Concordance Viewer

to adjust the size to fit the available print region.

· Specify the number of Copies to print.

5. In the Markups section:

· Check the Select All box if you want to include all markups.  Otherwise you

can select individual markups that you want to include in the printed

document(s).

223
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· In the Print redactions as drop down select either Opaque or

Transparent to determine if your redactions will block out the underlying

section of the document fully.

6. Select headers and footers to configure header and footer information for

printing.  See Configuring Headers and Footers  for configuration

information.

7. Optionally you can click Preview to see a preview of how the current

document will appear when printed.  

If you select Print in the Print Preview dialog you will only print

what is shown in the preview and not the full document.  To print

the entire document, use the Start Printing button on the

Concordance Printing dialog.

8. Optionally you can go to the top of the Concordance Printing dialog and

save all of the printing options you specified.  Select a name for this

configuration of Settings in the drop down, or type in a new Settings name. 

Once you have selected a name for the Settings you can Save or Save as

default.  The settings can be recalled by selecting the name in the drop down

when printing in the future.

9. Click Start printing when you are ready to print.

Configuring Separator Sheets

225



Concordance Classic224

© 2022 CloudNine™. All rights reserved.

When you select the Include document separator sheet check box, click

Configure separator sheet to specify the contents of your separator sheets.  The

contents are specified by typing into the Text comment box and/or adding Fields

from the drop down on the top right.  When you add a Field to the Separator Page

Configuration, it is replaced in the text with the actual field value for the associated

document from the Concordance database.

Use the Font button on the lower left to select the font attributes to use for your

separator sheets.

Configuring Synopsis Sheets
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When you select the Include document synopsis check box, click Configure

synopsis sheet to specify the contents of your synopsis sheets.  The contents are

specified by selecting fields from the Available Fields list on the left.  Select

individual fields or multiple fields and use the buttons in the center to add the fields

to the Selected Fields list.  You are allowed to specify up to a maximum of 20

Selected Fields.

Use the Font button on the lower left to select the font attributes to use for your

synopsis sheets.

Configuring Headers and Footers
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When you select Include headers and footers, several additional configuration

options are displayed:

1. Click the Font button and select your font options in the Select Font dialog

that displays.  This includes Font Family, Font Size, and Font Style.  Click OK

to save your font selections and close the Select Font dialog.

2. In the Headers and Footers section, specify an item to print for each header

and footer based on your needs.  Leave the selection set to None if you want

that header or footer to remain blank.

3. In the Margins section, specify an item to print for each section of the left and

right margins based on your needs.  Leave the section set to None for a blank

margin.

4. Select an item for your Watermark, if desired, or leave None for no

watermark.
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Review with Concordance Native Viewer

Utilizing the media key (image key) field in Concordance, Concordance Native

Viewer can synchronize with the current Concordance database and display the

associated documents.  Using Concordance Native Viewer you can view native

documents, removing the need to purchase and open the document in its native

application.  CNV opens the near-native view of the supported document types

allowing you to review and annotate them.

With Concordance Native Viewer open alongside the Concordance application, you

can view a record in the Browse and Table views while viewing the same record in

the Native Viewer.

Concordance Native Viewer stores references to all native documents and image

information in a single Concordance Image Base database (.cib) file. The .cib file is

located in the same folder as the associated Concordance database (.dcb).   

Due to changes within Brava, our third party vendor, if you are

currently working on a review with Concordance Native Viewer

version 1.08 or earlier, it is recommended that you complete the

review and produce the files before upgrading to Concordance

Native Viewer version 1.10 or later.  For more information, contact

Concordance Technical Support.

Supported Files

Concordance Native Viewer works with the following file types:

File Type Description

*.tif, *.tiff Tagged Image File
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*.jpg, *.jpeg Joint Photographic

Experts Group

*.gif Graphic Image File

*.bmp Bitmap

*.asc ASCII text

*.pcx PC Paintbrush Bitmap

*.csv Comma-Separated

Values

*.cal, *.cals Facsimile

*.pdf Adobe Portable

Document Format

*.doc, *.dot,

*.docx

Microsoft Word 

*.ppt, *.pps,

*.pptx,

*.pptm

Microsoft

PowerPoint®
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*.xls, *.xlsx Microsoft Excel® (See

note below)

*.msg Microsoft Outlook

2010 Message File

*.txt ASCII Text

*.rtf Rich Text Format

*.html, *.htm Web/HTML — Only

supported in E-

Document databases.

When working with a Microsoft Excel workbook that contains more

than one worksheet, the data for all the worksheets is stored in the

corresponding Concordance database; however, Concordance

Native Viewer only displays the first worksheet during review. 

The Concordance Native Viewer displays the document associated to the record

currently open in Concordance.  Using the tools in Concordance Native Viewer you

can review documents, navigate between records, apply markups (annotations),

and adjust the display of the documents.  

From an open database in Concordance, you can launch Concordance Native

Viewer by selecting the View Image (camera) icon on the Dynamic Toolbar.
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Menus

· File - Here you can OCR an image or print documents.

· View - Provides access to several viewing options (also available in the View

Toolbar).  The "sticky" settings are accessed in this menu.

· Markups - Provides access to markup tools for document review (also

available in the markup Toolbar).

· Help - Provides a link to the online Concordance Help.  You can also activate

Concordance Native Viewer, and view your installed Concordance Native

Viewer version number.

Markup Toolbar
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To

ol

Na

me

Description

Pan Moves the current page in any

direction

Sele

ctio

n

Selects a markup to edit, move,

copy, resize, reshape, or delete

Text

Box

Places a box that contains text on

the page

Not

e

Places a note icon on the page and

opens a pop-up for the content

Ima

ge

Places an external image (JPG, BMP,

or PNG) on the page

Sta

mp

Places a predefined stamp on the

page

Red

acti

on

Blocks out areas on the page that

are considered confidential or

sensitive from being viewed or

copied after production
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To

ol

Na

me

Description

Line Draws a straight line in any

direction on the page

Pol

ylin

e

Draws a jointed line on the page

Cros

sout

Draws an X on the page

Arro

w

Line

Draws a line with an end

arrowhead on the page

Rect

ang

le

Draws a rectangle around the

selected area on the page

Elli

pse

Draws an ellipse around a selected

area on the page

Stri

keo

ut

Draws a strikeout line over the

selected text



Concordance 233

© 2022 CloudNine™. All rights reserved.

To

ol

Na

me

Description

Hig

hlig

ht

Highlights the selected text

Und

erli

ne

Draws an underline under the

selected text

Strikeout, Highlight, and Underline tools are only available if the

document contains selectable text.

Viewer Pane

The Viewer Pane displays the current page of the current document.

Thumbnails Pane

The Thumbnails pane displays small images of the pages within the current

document.  

· a green rectangle highlights the currently displayed page

· a red exclamation point (!) displays next to any pages that contain markups
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Use the navigation tools at the top of the Thumbnails Pane to navigate through

pages of the current document, or navigate specifically through those pages with

markups.

Information Pane

The Information Pane contains detailed information about each document within a

record. Each tab can be configured to display the information most important to

you.  The information is directly linked to Concordance and stored in the

Concordance Image Base (CIB) file.

Info

rmat

ion

Tab

Description

Docu

ment

Displays Concordance field

data (numeric, date, text and

paragraph) for the

document, up to 60

characters.  You can specify

which fields display, and

their order by clicking the

View button.

Imag

e

Displays metadata for image

documents.  If you are using

Concordance Native Viewer

this information is only
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Info

rmat

ion

Tab

Description

available for Concordance

Image Load File databases

that have been converted.

Mark

up

Histor

y

Displays a complete history,

in descending chronological

order, of all markup

additions, modifications, and

deletions that have taken

place for the current

document.

The Information Pane provides quick access to additional information (metadata)

about the current document or image.  The information is directly linked to the

information in Concordance and is stored in the Concordance Image Base (CIB) file.

 

The upper section of the Information pane displays detailed information about the

document for the selected view.  The lower section displays a set of buttons for

one-click access to the corresponding view.  When you click a view button, its

contents are displayed in the upper section.  The horizontal splitter bar located

between the view and the buttons allows you to collapse the buttons into a button

tray.

Each of the selected views has a Print button that you can use to print that view's

information for the current document.
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Navigation & View Toolbar

Tool N

a

m

e

Description

Fir

st

D

oc

u

m

en

t

Navigates to the first

document in a single or

concatenated set of

Concordance databases

Pr

ev

io

us

D

oc

u

m

en

t

Navigates to the previous

document in a single or

concatenated set of

Concordance databases

N

ex

t

D

Navigates to the next

document in a single or

concatenated set of

Concordance databases
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Tool N

a

m

e

Description

oc

u

m

en

t

La

st

D

oc

u

m

en

t

Navigates to the last

document in a single or

concatenated set of

Concordance databases

Go

To

D

oc

u

m

en

t

Navigates to a specified

document or page within a

single or concatenated set

of Concordance databases

Pr

ev

Navigates to the previous

page in a multi-page
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Tool N

a

m

e

Description

io

us

Pa

ge

 

document shown in the

native viewer

N

ex

t

Pa

ge

Navigates to the next page

in a multi-page document

shown in the native viewer

Zo

o

m

on

Se

le

cti

on

Click this tool and drag the

tool across an area of the

document that you want to

enlarge

M

ag

nif

ier

Displays a magnifier

window for viewing

magnified sections of the

current document.  Close

the magnifier window using
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Tool N

a

m

e

Description

the X in the upper right

corner.  You can modify the

magnifier window in several

ways:

· Click or drag the corner

or edge of the magnifier

window to expand or

reduce its size.

· Click the adjustments

handle immediately to

the right of the

magnifier window to

modify the font size

within the magnifier

window.

· Use the Eyeglass or

Bird's Eye tool in the

upper left to adjust

which section of the

document is being

displayed in the

magnifier window.

Fit

to

He

Adjusts the zoom height so

that the entire height of the
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Tool N

a

m

e

Description

ig

ht

document appears in the

workspace

Fit

to

Wi

dt

h

Adjusts the zoom width so

that the entire width of the

document appears in the

workspace

Zo

o

m

sli

de

r

Drag the slider right to

increase magnification or

left to decrease

magnification of the

document being displayed

Ro

tat

e

Cl

oc

k

wi

se

Rotates the document in 90

degree clockwise
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Tool N

a

m

e

Description

Ro

tat

e

Co

un

ter

Cl

oc

k

wi

se

Rotates the current

document in 90 degree

counter clockwise

To

gg

le

Th

u

m

bn

ail

s

Opens the Thumbnails pane

Status Bar
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The Status bar at the bottom of  Concordance Native Viewer displays information

about the current database being viewed, including whether the database is

editable or not.  On the right side, the status bar shows the current page and total

page count for the current document.

Concordance Native Viewer is synchronized with Concordance.  Each separately

opened database has a tab at the top of the Viewer Pane that displays the current

database name.  You can have up to 16 databases open in Concordance Native

Viewer at the same time.

Documents may consists of multiple pages.  You can always determine what page

you are currently viewing by looking at the page information in the lower right

corner (on the Status Bar).

Use the Navigation and View Toolbar at the bottom to move between documents,

and move to different pages within a document.  You can also navigate pages by

selecting a page in the Thumbnails Pane, or using the navigation toolbar at the top

of the Thumbnails Pane.

Sticky Zoom and Sticky Rotate

Many documents are often scanned with a portrait page view setting, making

online reading a challenge unless the page is rotated. The Sticky Zoom and Sticky

Rotate settings make reviewing easier by changing the page layout to a landscape

view and keeping it there even while navigating between records.

The Sticky Zoom and Sticky rotate functions are located on the View menu:

· Sticky Zoom - keeps your preferred magnification settings as you move from

record to record. If you uncheck the selection, and then navigate to the next

record, the record defaults to the full page view.

· Sticky Rotate - retains the rotated settings as you page through a record.

These settings are especially helpful if you are reviewing a spreadsheet.  If you

uncheck the selection, and then navigate to the next record, the record defaults

its original view.
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A check mark next to each option on the Tools menu indicates that this setting is

selected. The selections are maintained for the current database when Concordance

Native Viewer is closed and reopened.

Concordance Native Viewer provides several markup tools for annotating

documents and images during review.  Applying markups includes redacting

information and adding notes. You can also apply color markings to highlight or

underline text and add a circle or box to emphasize a block or region of key

content.  All of these elements can easily be edited, moved, or resized.

There is no limit to the number of markups you can add to a document.  As a best

practice, use some restraint and stick to the internal review guidelines for your

organization, ensuring all annotation marks are sensibly applied and records are

kept clean for other reviewers.

Markup History in the Information Pane display all markups for the current

document including the markup type, title, and author.  Markup history is also

saved in the .CIB file.

The current state for the markups on a document are stored in an

XML formatted (.xrl) file in the same directory as the corresponding

media file.  DO NOT edit this file.  Doing so may corrupt all your
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markups and redactions, as well as, possibly cause Concordance

Native Viewer to crash.

When you select a Markup Tool, the top of the Viewer pane updates to display an

appropriate toolbar to use for adding or editing that markup.  You can change the

appearance, size, and location of markups after you add them.  All changes are

tracked in the Markup History view of the Media Information pane.

The Markup Properties Toolbar
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Add Text Markup

1. On the Markup toolbar, click Text Box tool.

2. Use your mouse to select an area in the document where you want the text

box to appear.

3. In the text box, type the text you want to add.

4. Using the Markup Properties toolbar, modify the color, or other text attributes

as needed.

5. Navigate to another document to save the markup.

Add a Note
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1. On the Markup toolbar, click the Note tool.

2. In the Markup Properties toolbar, select the color you want to use for the note.

3. Use your mouse to click a spot in the document where you want to place the

note.  The Changemark Note dialog displays.

4. Edit the information in the dialog box:  title, text for the note, note type, and

note state detail.

5. When finished, click OK.

6. Navigate to another document to save the markup.

After applying a note, with the Pan tool selected, you can move the

mouse over the note to display the first 40 characters of the

contents of the note.  To view the full contents of the note

(maximum of 520 characters), use the Note tool and double-click

the note to display the Changemark Note dialog and view the

entire note.

Add a Line or Shape Markup
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1. On the Markup toolbar, select the line or shape tool corresponding to what

you want to add.

2. In the Markup Properties toolbar, select the color, and line or shape attributes

you want.

3. Use your mouse to draw the line or shape on the document.

4. Navigate to another document to save the markup.

Selectable Text Markups

When a document contains selectable text, the Strikeout, Underline, and Highlight

tools become available.

1. On the Markup toolbar, select the Strikeout, Underline, or Highlight tool.

2. In the Markup Properties toolbar, select the color you want to use.

3. In the document, use your mouse to select the text to apply the markup to.

4. Navigate to another document to save the markup.

Editing a Markup

1. On the Markup toolbar, click the Selection tool.

2. Use your mouse to select the markup to edit in the document.

3. In the Markup Properties toolbar, modify any properties as needed.

4. Depending on the markup type, after selecting the markup to edit the display

updates to display resize and rotate handles.  You can select any of these to

modify the size or rotate the markup as needed.

5. Navigate to another document to save the markup changes.

Editing Another User's Markups

1. From the Markup toolbar, click the Selection tool.
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2. Press Shift and then select the markup you want to edit.  

3. Follow the instructions above for Editing a Markup.

Delete a Markup

1. On the Markup toolbar, click the Selection tool.

2. Using your mouse, select one more more markups you want to delete.  For

multiple markups, press CTRL while selecting.

3. Press Delete.  The selected markups are removed.

4. Navigate to another document to save the markup changes.

The Image tool allows you to insert images (JPG, BMP, or PNG) into the current

document.  Concordance Native Viewer ships with several standard image files

(draft, final, redacted, reviewed, etc.).  You can find these images in C:\Program Files

(x86)\CloudNine\Concordance native Viewer\StampImages.  You can also use

other images based on your needs, or modify the existing images if necessary.

Stamps contain predefined information that cannot be modified.  Concordance

Native Viewer is shipped with four predefined stamps:  Attorney's Eyes Only,

Attorney-Client Privilege, Confidential, and Under Seal.
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To Insert an Image

1. On the Markup toolbar, click the Image tool.  The Markup Properties toolbar

will display above the document.

2. On the Markup Properties toolbar, either select an image file from the

dropdown list or click the Browse button to navigate to and select the image

you want to add.

3. Click on the document in the area where you want the image to be added.

4. Navigate to another document to save the markup.

To Insert a Stamp
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1. On the Markup toolbar, click the Stamp tool.  The Markup Properties toolbar

will display above the document.

2. On the Markup Properties toolbar, select a stamp from the dropdown list.

3. Click on the document in the area where you want the image to be added.

4. Navigate to another document to save the markup.

A redaction is used when confidential information needs to be hidden in a

document for production.  Redactions associated with the produced document

cannot be edited or removed.  Once the document is produced, any text or images

concealed by a redaction cannot be viewed, copied, or searched.

The Redaction tool allows you to place one or more redactions (rectangular boxes)

over various areas of sensitive information within a document.  In Concordance

Native Viewer, the redaction appears transparent to allow you to make sure the

redaction covers the information you want to conceal.  When a production is

executed, the redaction becomes opaque concealing the information underneath.

Since PDF files are not flattened or burned, when producing PDF files the redacted

information is removed from the file before the redaction is placed.  The production

process physically removes the hidden text from the produced file, the original

document is not altered.

Redactions can be applied to specific text, or they can be applied as a box over an

area of a document or image.  It is recommended to us a different color for

redactions than other markups.  This ensures that the markup type can be easily

differentiated when viewing a document or image.

If you need to export the body text for a production, you will need to re-OCR the

images after the redactions have been burned in.  You can also choose to scrub the

redacted text when running a Production.

When printing Concordance Native Viewer documents, redacted

documents print with transparent redactions making the text

underneath the redaction visible.  If you want redactions to print
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opaque, you need to use the Production tool in Concordance to

produce the documents and then print the output documents.

Add a Redaction

1. On the Markup toolbar, click the Redaction tool.

2. Using the Redaction tool, click and drag your mouse to select text in the

document or draw a rectangular box around the area to radact.

3. Using the Markup Properties toolbar, modify the color if needed, and select a

redaction Reason.  You can select a previously entered Reason from the list

or type in a new one.  There is a maximum of 40 redaction reasons in the list,

displayed in alphabetical order.

4. Navigate to another document to save the redaction.

Editing a Redaction

1. On the Markup toolbar, click the Redaction tool.

2. Use your mouse to select the redaction to edit in the document.

3. In the Markup Properties toolbar, modify any properties as needed.

4. Navigate to another document to save the redaction changes.

Opitical Character Recognition (OCR) processing can be performed on a single

page or an entire document displayed in Concordance Native Viewer.  Initiating the

OCR Single Image command scans the page or document and then writes the data

to a specified field in the in the associated Concordance database for indexing and

searching. 



Concordance Classic260

© 2022 CloudNine™. All rights reserved.

This feature requires activation of the OCR on the Fly license for

Concordance Native Viewer.

While the OCR Single Image process is running, do not navigate

between records in Concordance or close Concordance.  This will

cause the process to fail to write the data to the selected record. 

The corresponding Concordance database record is locked until the

OCR process is complete.

When running the OCR process on a document that contains a

markup that is not burned in, the text that lies under the markup

will be scanned and imported to the specified database field.  If you

do not want the text under the markup scanned, you must first

produce the document using the Production command in

Concordance, load the produced document into the database, and

then scan the document.

Digital OCR processing does not offer perfect text recognition.  Accuracy may be

reduced by many conditions:

· Text appears skewed or uneven on the page

· Pages are creased or torn

· Letters are faded, blurry or otherwise distorted

· Non-standard type faces used in documents

· Font style, size, and/or color

· Image files with low resolution (such as .gif formatted images), background

noise, inverted colors, black margins, or wrong page orientation

· Multiple languages selected for processing



Concordance 261

© 2022 CloudNine™. All rights reserved.

The OCR scanning process is CPU intensive and can require significant time and

computing resources to carry out large jobs.  Typical processing time is between 1

and 2 pages per second.  This time is greatly impacted by the amount of text and

other information on the pages, and the quality of the document.

Database Considerations

Concordance Native Viewer is locked once the OCR process is initiated and

remains locked until it is completed.  The corresponding Concordance database

record is locked for all users.  The database record can be viewed but not edited. 

Indexing cannot be performed on the database during the OCR process.

Concordance database OCR fields:

· Must already exist in the associated Concordance database

· May already contain data - you can append additional date to the next

available OCR field or overlay existing content with new data

· Must have the same alpha prefix, and have a numerical suffix that starts with 1

and are the same length (i.e. OCR1, OCR2, etc.)

· Must be paragraph type fields to ensure the data is indexed and searchable 

· Must be large enough and/or you must have enough fields defined to support

OCR processing

· Must be accessible with full read/write access by the user

Language

OCR Single Image supports these language types:

· Latin (for English, French, Spanish, German, etc.)

· Cyrillic (for Russian, Bulgarian, etc.)

· Greek

· Chinese (Simplified and Traditional)
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· Japanese

· Korean

To OCR the Text of a Document or Image

1. In Concordance Native Viewer, navigate to the document you want to scan.

2. From the File menu, click OCR Single Image.  The OCR Options dialog

displays.

3. Select Append to write the OCR data in the specified field at the end of any

existing data, or Overlay to replace existing data in the specified field (existing

data in the field will be lost).

4. Select Current Page to OCR the page currently displayed in the viewer, or

Entire Document to OCR all pages of the current document.
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5. From the Language Options list, choose the language that corresponds to

the text represented in the document.

6. Click Start.  

7. If you chose Overlay, you will need to confirm that you want to overwrite the

database field before proceeding.  Select OK to proceed.

8. A progress dialog displays.  Upon completion, you can return to Concordance

to verify that the data appears in the field you specified.

Using the print command in Concordance Native Viewer, you can print the current

document displayed in the viewer.  When printing documents, be aware of the

following:

· When printing documents that have been redacted in Concordance Native

Viewer, any redaction placed on the document will print transparent revealing

the text underneath.  If you want to print opaque redactions, you must run the

documents through the Production process in Concordance, then print the

produced document.

· Printing documents that contain markups to Adobe PDF using the File>Print

option does not permanently burn the markups in the document.  If you want

markups burned in, you must run the documents through the Production

process in Concordance, then print the produced document.
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To Print the Current Document in Concordance

Native Viewer

1. In Concordance Native Viewer, locate the document you want to print, and

then from the File menu, click Print.

2. To modify the printer settings, click the Printer Setup button, select the

printer to use, specify the paper size, orientation, and other general printing

options, and then click OK.  Options may vary with different printers and

drivers. 

3. On the General tab, select the range of pages you want to print in Print

Range.  Current View will only print the area of the image that is displayed in

the viewer workspace.

4. On the General tab, specify the Options you want:

· Set Number of copies to the number of copies to print.

· Minimum line thickness can be set to a value from 0 to 99 to specify line

weight for markups.

· Specify the Print option Original Colors to print using the colors shown in

the viewer, As Grayscale to print in shades of gray, or Lines as Black to

print all lines black (markups print with color if applicable).

5. Specify any of the following print settings that are necessary:

· Select Automatically rotate for best fit to allow more of the image to fit

within the margins of the printed page.

· Select Print Changemarks notes to include the text in any notes in the

current document on a separate sheet.  This option is only available if

changemark notes exist.

· Select Print redaction reasons to include the text in any redactions in the

current document on a separate sheet.

· Select Optimize for PDF/Postscript Printing if you are printing a PDF

document.  This option resolves some older printer issues that resulted in



Concordance Classic266

© 2022 CloudNine™. All rights reserved.

reversed prints.  This option results in slower print time and a larger print

spool file.

6. On the Scale tab, you can decide to print the document as Fit to page, Fit

document within banners, or select a customized scaling value.

7. Click Watermark/Banners to configure your watermark and margin details. 

See Configuring Watermark and Banners  for more information.

8. Click the Defaults button to save the current print settings as your default

values.

9. When finished, click Print.

Configuring Watermark and Banners

1. Click the + next to the Header/Footer or the Watermark folder you want to

edit to expand the list.

266
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2. Within the expanded list, select the <blank> field.  Enter in the text that you

want displayed in that area.  To include a macro in the text type the percent

sign (%) and the available macros list displays allowing you to select one to

insert.  See Macros  for the list of available macros.

3. To edit the font for the all the text, click the Font button, and then in the Font

dialog box, specify the font name, style, and size.

4. To view a list of all the headers, footers, and watermark set for the production,

click List.

5. When finished, OK.

Concor

dance

Native

Viewer

Macro

Description

FIELD_<f

ield

name>

Inserts database field data up to 60

characters for a each specified field.  For

example, FIELD_OCR1 would generate

the first 60 characters of the OCR1 field. 

If security is enabled, only those fields

with a minimum of Read access are

displayed.

Date Inserts the current date

SysDate

PlusDays

()

Inserts the system date plus a specified

number of days.  Enter the number of

267
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days to add to the system date in

parenthesis. 

Time Inserts the current time the print is

executed based on a 12-hour clock

MilTime Inserts the current time the print is

executed based on a 24-hour clock

Title Inserts the current title of the document

Page Inserts the page number of the document

TotalPag

es

Inserts the total number of pages of the

document

BatesPg

No()

Inserts a page number on each printed

document.  Enter the starting page

number for each document in

parenthesis.  Multi-page documents are

numbered incrementally.  For example,

BatesPgNo(0001) would print 0001 on

the first page, and 0002 on the second

page, and so forth.

Login Inserts the login name of the person who

executed the print
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User Inserts the user name of the person who

executed the print

Hostnam

e

Inserts the hostname of the machine

where the print was executed from

IPAddres

s

Inserts the IP address of the machine

where the print was executed from

% Inserts a single % character

© Inserts a copyright symbol

® Inserts a registered trademark

Review with Concordance Image

Content review of records can be done with Concordance Image. Concordance

Image allows you to magnify the original document image for clarity and

inspection (especially for dates and signatures), and provides a variety of

annotation tools specifically designed for privileged content and trial preparation.

Once you have annotated content, especially redacted key information, the

document markings are automatically saved and the changes secured. A third-

party, such as opposing counsel, will not be able to uncover the redaction

information or remove any notable markings once they are burned onto a new set

of images during production.

Concordance Image opens image records in a secondary window, which can be

resized to view alongside the main Concordance application, allowing you to see

both the Browse and Table views while reading the full document content.
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Not all case records are viewable in Concordance Image. Transcript files are text

files stored in a separate database and viewable only in the Browse and Table

views. Notes entered in the Browse view are not viewable in the image view

because they are separate text files. Similarly, notes entered in Concordance Image

records are not viewable in the Browse view because they are scanned image files.

The same document files are linked in the database for full search functionality, but

record additions are not transferable for viewing purposes. 

Supported Files

Concordance Image works with the following file types:

File Type Description

*.tif, *.tiff Tagged Image File

*.jpg, *.jpeg Joint Photographic

Experts Group

*.gif Graphic Image File

*.bmp Bitmap

*.pcx PC Paintbrush Bitmap

*.cal, *.mil CALS Files
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*.dir, *.fyi Concordance Image

imagebase

Concordance Image opens image records associated with the record currently

open in Concordance.  

From an open database in Concordance, you can launch Concordance Image by

selecting the View Image (camera) icon on the Dynamic Toolbar.  You can also

right click on a record in Browse, Table or Edit views in Concordance and select

View image.
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Standard Toolbar
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T

o

ol

Na

m

e

Description

Op

en

Opens images not associated with

the current database

Pri

nt

Prints documents and pages from

the current database

Ma

rk

Marks an area in the image to copy

Ma

rk

Zo

om

Captures a selected region of a

document and enlarges it to fill the

viewer area

Ma

gni

fier

Opens a magnifier window for

viewing specific sections of an image

Zo

om

Opens the Magnify window for

viewing a selected area of an image

Pan Moves the image in any direction
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T

o

ol

Na

m

e

Description

Hel

p

Opens Concordance Help

Redline Toolbar

T

o

ol

Na

me

Description

Mo

ve

Selects markup entries to move,

copy, resize, reshape, or delete

Res

ize

Reduces the size of a redline

incrementally

Hig

hlig

ht

Highlights selected text on the image



Concordance 275

© 2022 CloudNine™. All rights reserved.

T

o

ol

Na

me

Description

Red

act

Places a redaction on the image

Hol

low

Box

Places a hollow box on the image

Hol

low

Elli

pse

Places a hollow ellipse on the image

Soli

d

Elli

pse

Places a solid ellipse on the image

Tex

t

Places text on the image

Lin

e

Places a Line on the image



Concordance Classic276

© 2022 CloudNine™. All rights reserved.

T

o

ol

Na

me

Description

Not

e

Places a note on the image

Sea

rch

Opens the redlines search pane

Navigation Toolbar

To

ol

Na

me

Description

First Navigates to the first page in the

document

Previ

ous

Navigates to the previous page in

the document

Next Navigates to the next page in the

document
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To

ol

Na

me

Description

Last Navigates to the last page in the

document

Previ

ous

Docu

ment

Navigates to the previous

document in the imagebase

Next

Docu

ment

Navigates to the next document in

the imagebase

Zoo

m

Out

Zooms out incrementally 

Zoo

m In

Zooms into smaller areas on a

larger image

Fit

Widt

h

Changes the zoom level such that

the entire width of the image

appears in the window

Fit

Heig

ht

Changes the zoom level such that

the entire height of the image

appears in the window
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To

ol

Na

me

Description

Rotat

e

Rotates the image by 90º

clockwise

You can make your Zoom and Rotate settings "sticky" by selecting Sticky zoom

and/or Sticky rotate on the Tools menu.  Several options on the Navigation

Toolbar are available on the View menu.  The View menu also provides a few

Mirror options to flip images horizontally, vertically, or both.

Selecting Tools>Preferences on the Concordance Image menu brings up the

Preferences dialog box.  This dialog provides eight tabs of various setting options

so you can configure Concordance Image based on your needs.

General
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General

Setting

Additional

Information

Close all previous

windows for each

new image

Selecting this preference

closes all windows before

displaying a new image.

Check volume ID

for each new

image

If selected, Concordance Image

will check the image location

against where the image was

registered.  If you have

multiple images with the same

name, selecting this option can

insure the correct image is

displayed.

Synchronize

paging with

Concordance

This option keeps

Concordance and

Concordance Image

synchronized when moving

between documents.

Keep Concordance

Image always on

top

Concordance Image will

always show on top of all

other windows.

Display full image

on startup

Displays the full image when

the image is loaded.
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General

Setting

Additional

Information

Sticky Zoom Maintains the zoom level and

position for every image.

Scale quality

default

Can be Scale for best quality

when you want to resize for

quality, or Scale fastest if

speed is preferred.

Anti-aliasing

default

Used for black and white

images, select No anti-

aliasing, Fast (4 shades of

gray), or Partial (16 shades

of gray).

Background Color Click Background Color to

select the color to display in

the background of the Viewer.

Mouse
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The Mouse preferences allow you to specify the default Concordance Image tool

associated with the Left, Middle, and Right mouse buttons.

Rectangular Magnifier
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The Rectangular Magnifier preferences can be used to specify the Width and

Height Dimensions for the magnifier window in pixels.  You can also define the

Zoom magnification percentage from the list.

Redline

Redline preferences allow you to turn off the prompt for selecting redline color

when applying a redline, and the prompt for saving the image with redlines when

the image is closed.  You can also define the redline Default text font and

Default color.

Redaction
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Redaction preferences are used to define the Redaction text list that you select

from when applying a redaction.  You can alter the list to appear in any order you

want.  This preference page also provides the ability to define the redaction Font to

use.

Dates
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Dates preferences allows you to select your preferred Date format and Time

format to use for printing and production.

DDE

The DDE preference page is provided for backwards compatibility with early

versions of Concordance.  This should only be altered with guidance from

CloudNine Customer Support.

FYI
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The FYI preferences define the scaling factor for transfer of images across the

Internet from the server to the client PC.  You can also default to Use local images

first.  When using print and production wizards with an FYI imagebase,

Concordance Image automatically downloads a full-scale copy of the image

regardless of the Use local images first setting.

Concordance version 10 databases and Concordance Image

version 5 imagebases are compatible with FYI Server and FYI

Reviewer versions 4.x or later.

When the View Image button is activated on the Dynamic toolbar in Concordance,

opening a document in Concordance automatically launches Concordance Image. If

you do not want images or attachments to automatically launch during your

review, you can set this up in the Concordance Image Preferences.

With Concordance Image open alongside the Concordance application, you can

view a record in the Browse and Table views while viewing the same record in

Concordance Image.
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In addition to the View Toolbar, the Page menu provides several ways to navigate

pages, documents, and images.  When you open Concordance Image from

Concordance, you are automatically brought to the current record in the

Concordance Image Viewer pane.  If you want to go to a specific image, you can

select Go to image on the Page menu and select the image key you want.

You can also open an imagebase that is not associated with your current

Concordance database by selecting Open Image on the File menu.  You will be

prompted to navigate to and open a Concordance Image .dir or .fyi imagebase file.

Concordance 10 databases and Concordance Image 5 imagebases

are compatible with FYI Server and FYI Reviewer versions 4.x or

later.

Information about the current image you are viewing can be displayed by clicking

Help>Image Information.
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During the discovery process, annotating record detail is the phase when deeper

content investigation and case record preparation begins. Upcoming depositions

and court appearances require that your paperwork is already in order, opposing

counsel wants copies, and all records need to be edited with proper annotations:

notes added, key content highlighted, related files attached, links to websites

validated, and privileged information redacted.

The Redline Toolbar, located on the upper left of Concordance Image, includes the

variety of tools used to markup or redline an image during review.  Applying

redlines includes redacting information and adding notes. You can also apply color

markings to highlight or underline text and add a circle or box to emphasize a block

or region of key content.  Once redlines are applied, you can search the document

for each type.  All of these markups can easily be edited, moved, or resized.

As soon as you begin redlining or annotating a document, the right-click menu

options are available to you. This is especially helpful when applying redactions.

Redaction marks and other redlines can be fused to the image file during print

production, securing the document.  When Concordance administrators process a

production, they can then select which markings are fused to the image, depending

on needs and recipient.

There is no limit to the number of annotations you can add to a document.  It is

best to stick to the internal review guidelines for your organization, ensuring all

markups are sensibly applied and records are kept clean for other reviewers.

Concordance Image stores markups in EPS layers (up to nine layers) that cannot be

unlocked, which is particularly useful for redacted content.  All annotated

documents are stored in a separate redline database.  Redlines are automatically

saved in this database once applied, but you cannot search a document for redlines

and others cannot view these changes until the database is reindexed.

On the Redaction tab of the Preferences dialog (Tools>Preferences) you can

customize the redaction text, font, and list placement, create a list of redaction

terms, and set the default redaction text.  If there is more than one redaction term

defined, the terms are available for selection when you right click a redaction in

Concordance Image. 
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Redaction text is not shared between Concordance Image and FYI

Reviewer. If you want the same redaction text to be available in

Concordance Image and FYI Reviewer, you will need to create the

redaction text in both applications.

When viewing a document within the Concordance Image Viewer pane, you can

select a tool from the Redline Toolbar to markup the document.  You can change

the appearance, size, and location of redlines after you add them.

We recommend incorporating standards for the review team for your redline

markups, such as note size and location.  This helps reviewers locate markups

quickly at a glance.  Even though a note may display small in the Viewer, it can still

hold up to the 12 million character paragraph capacity.

Notes added to an image record are not viewable or accessible

when the same document is viewed in the Browse view in

Concordance. These database files are linked but cannot transfer or

share edits.

Redlines applied to a .bmp file using Concordance Image version

5.09 or earlier and viewed in Concordance Image version 5.10 or

later or FYI Reviewer version 5.07 or later will not display in the

correct location.

Add a Text Redline

1. On the Redline toolbar, click Text tool.

2. Use your mouse to select an area in the document where you want the text

box to appear.  A Text dialog displays.
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3. In the Text dialog, type the text you want to add.

4. You can optionally click the Color button to edit the text color if needed.

5. Click OK.  The text redline displays in the Viewer pane.

Add a Note Redline

1. On the Redline toolbar, click the Note tool.

2. Use your mouse to select an area in the document where you want the note to

appear.  A Note dialog displays.

3. In the Note dialog, type the text you want to appear in the note.

4. Click OK.  The note displays in the Viewer pane.

Add a Line or Shape Redline

1. On the Markup toolbar, select the line or shape tool corresponding to what

you want to add.

2. Use your mouse to draw the line or shape on the document.

3. Right click on the redline in the document and select Change color to change

the line or shape color.

Editing or Deleting a Redline

1. Use your mouse to select the redline to edit or delete in the document.

2. Choose the menu option you want to either modify the redline properties or

delete the redline.

The Redaction tool allows you to place one or more redactions (rectangular boxes)

over various areas of sensitive information within a document.  In Concordance

Image, the redaction appears transparent when your are moving it, to allow you to

make sure the redaction covers the information you want to conceal.  
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It is recommended to us a different color for redactions than other markups.  This

ensures that the markup type can be easily differentiated when viewing a

document.

On the Redaction tab of the Preferences dialog, you can customize the redaction

text, font, and list placement, create a list of redaction terms, and set the default

redaction text.  If there is more than one redaction term defined in Preferences, the

terms are available for selection when you right-click a redaction in Concordance

Image.  For more information, see Preferences .

To Add a Redaction

1. On the Redline toolbar, click the Redaction tool.

2. Using the mouse, select an area in the document to redact.  Concordance

Image displays a redaction box.

3. Right click on the redaction box to alter the color or redaction text.

Once records have been reviewed and redlines applied, you may need to edit a

comment or assess the number of redactions in a group of records. You can locate

redlines in Concordance Image by type or reviewer by using the Search pane.  The

Search pane is displayed to the left of the Viewer pane by selecting

Redlines>Search.

278
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To Search for Redlines in Concordance Image

1. Select the Redlines>Search menu or click Search on the Redlines Toolbar. 

The Search pane displays.

2. On the Containing tab, select any specific redline types that you want

included in your search.  For redlines that include text, you can specify the text

to find in the text box.

3. On the Advanced tab, select any reviewers that you want included in your

search.

4. Click the Search button.  All records containing your search criteria are

displayed in the Search results. Records are listed as folders, named as the

document load order number.

5. To view the document where redlines were applied, click one of the

document's redlines in the Search results field.

6. When finished you can close the Search pane by clicking the X in the upper

right corner of the Search pane.

Using File>Save As, you can save the current image under a different file name or

format.



Concordance 293

© 2022 CloudNine™. All rights reserved.

1. Type the path and file name in the File text box or click Browse to navigate to

and specify the file location and name.

2. Select the Image type, Compression, Colors, and Redline options you want.

 See the table below for more details about which options are available based

on the Image type and Compression chosen.

3. Click Save to save the file.

Image Type Options

Ima

ge

Typ

e

Com

press

ion

Colors Redline

TIFF None

PackBit

s

1 bit (black

and white)

4 bit (16

colors)

8 bit (256

colors)

24 bit (16.7

million

colors)

No redlines

TIFF Group

3

1 bit (black

and white)

No redlines
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Ima

ge

Typ

e

Com

press

ion

Colors Redline

Group

3 2D

Group

3 TIFF

Group

4

Burn

redlines

onto image

PCX PCX 1 bit (black

and white)

4 bit (16

colors)

8 bit (256

colors)

No redlines

CALS Group

4

1 bit (black

and white)

No redlines

Burn

redlines

onto image

JPEG JPEG 24 bit (16.7

million

No redlines
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Ima

ge

Typ

e

Com

press

ion

Colors Redline

colors)

Using the print command in Concordance Image, you can print the current

document displayed in the viewer.

Printing images that contain markups to Adobe PDF using

File>Print, does not permanently burn the markups in the

document.  If you want markups burned in, you must run the

documents through the Production process, then print the

produced document.
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To Print in Concordance Image
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1. In Concordance Image, locate the document you want to print, and then

from the File menu, click Print.

2. On the Print tab in the Print dialog, select what you want to print in Print

range (image, portion, pages, and documents).  Select the Number of copies

to print.  On this tab you can also save your print settings or retrieve previous

print settings that you want to use.

3. On the Header & Footer tab, select the field that you want to appear in the

four available headers and footers.  Select Auto increment for any fields that

you want to auto increment for each document.  You can also select the

associated Font button to specify the font for each header and footer.

4. On the Options tab, specify which Redlines should appear and define

Separator sheet details if needed.

5. On the Setup tab, make sure the correct Printer is selected, and select your

Paper options, Orientation, and Print Quality.

6. When finished, click Print.

Productions

Once a document collection review is completed, documents typically need to be

produced to opposing parties. Database administrators prepare the electronic

production using Concordance and Concordance Native Viewer or Concordance

Image based on queries or tagged sets of documents that are identified for

production during the review phase.

Anyone tasked with preparing productions should receive Concordance

Administration training before attempting to produce documents from a live

database. The litigation industry guidelines regarding how discovery documents

are handled, processed, and shared between parties is a sensitive matter.

If you or anyone on your IT or Litigation Support Team are interested in learning

more about productions, please contact our Client Training Department by email at

training@cloudnine.com to register for the Concordance Administration

Fundamentals and the Certified Concordance Software Administrator courses.

See Preparing Productions in the Concordance Administration section for more

details.

mailto:training@cloudnine.com


Concordance 299

© 2022 CloudNine™. All rights reserved.

Printing in Concordance

Concordance provides several printing options for document records and

transcripts, and can be used to create and print a variety of customized reports

based on search results, field content, tagged document sets, and transcript

annotations. Printing options are available in the Browse and Table views. The view

you print from determines the format of the print output. The print output format

looks similar to the view you print from.

You can use Concordance to print:

· Records directly from the Browse view

· Record batches based on queries

· Transcript annotation reports (Annotation Report Writer)

· Tagged record lists

· Summary reports from the Table view (Report Writer or Send to Excel)

· Selected field data

· Print multiple documents and images

You can also print document pages and images in Concordance Viewer,

Concordance Native Viewer, and Concordance Image.  See Printing with

Concordance Viewer , Printing with Concordance Native Viewer , or Printing

with Concordance Image  for more information.

Please be aware of the following:

· When printing documents that have been reviewed and redacted using

Concordance Viewer, any redaction placed on the document will print

transparent revealing the text underneath.   If you want to print opaque

redactions, be sure to select the Opaque option in the Markups section of the

print settings.

· When printing documents that have been redacted in Concordance Native

Viewer, any redaction placed on the document will print transparent revealing

the text underneath.  If you want to print opaque redactions, you must run the

219 263
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documents through the Production process in Concordance, then print the

produced document.

While you have basic options for printing page numbers and dates, Concordance

also offers selections for printing highlighted annotations, underlined hits, field

labels, and more. These print options are useful for printing sets of records for full-

text review or to print annotations from transcripts.  You can also print a

spreadsheet report of queries displayed in Table view with field text in the sort

order selected. This option is useful for generating a summary listing.  With lengthy

documents like depositions, transcripts, and research reports, print a Keywords in

Context (KWIC) report to capture pertinent information in context.

When a batch of images are printed, the original images never change.

Annotations, highlights, and other markings are stored in the Concordance

database, and can be modified without modifying the original image. Selected

annotations and headers and footers can be applied to only the paper copies of

images for printing or fused directly onto new images when produced. When

images are printed, they have a slightly smaller output than the original image.

Images are automatically reduced by 2 or 4 percent, based on the type of image

file.

Media files are usually only printed in productions by your Concordance

administrator once annotations are completed and all redacted content marked.

This ensures that opposing counsel does not receive any original copies and other

staff do not view privileged content. However, there may be instances when you

need to print images or create certain reports.

Printing from the File Menu
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By selecting Print from the File menu, you can:

· Print the current record as a PDF in Browse View

· Print a list of searches in Review View

Printing Standard Reports

If you want to print multiple records or transcripts, you can generate a standard

report. Your current search query determines which records or transcripts are

available to print on a standard report.

Standard reports have a number of customizable features such as headers, footers,

date and time stamps, page numbering. When you print a standard report in

Concordance, by default the printed font format for records is determined by your

personal Concordance display settings. If you do not want to use the default

format, you can define your preferred print settings on the Print documents dialog

box before printing. You can also save your preferred print settings for future

printing, or reuse previously saved print settings.
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To ensure records print the way you want, it is recommended to preview your print

job before sending it to the printer. To preview your print job, click the Print

preview button on the Print tab in the Print documents dialog box.

To Print Standard Reports

1. On the toolbar, click the Print button.

2. Click the Fields tab.  The Fields tab is used to define the fields and their order

to include on the report for the selected database. The fields are listed

alphabetically in the Available fields field.

3. In the Database list, select the database containing the records you want to

print.  The Database field defaults to the current Concordance database.

4. In the Available fields list, choose the fields you want to include on your

report and add them to the Selected fields list using the Select and Remove

buttons in the center.  You can also reorder the Selected fields as needed with

the Move buttons.
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5. To print the keywords (search hits) for the current query, click the KWIC tab

and select the Print key words in context (KWIC) check box.

6. The database and fields you selected on the Fields tab are displayed below the

Print key words in context (KWIC) check box.  In the list, select the check

box next to the fields you want to print keys words in context.

7. To include record text above and below the key words, select the Print line(s)

above and below check box and type the number of lines to include above

and below in the line number fields.

8. To print the question and answer pair associated with the key words in

transcripts, select the Print Q&A pairs check box.  This check box only applies

to transcripts.

9. To add header and footer text, and define other printing controls, click the

Formatting tab.
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10. In the Header field, type the report header.  The header displays at the top of

each printed page and is left justified on the page.

11. In the Footer field, type the report footer.  The footer displays at the bottom of

each printed page and is left justified on the page.

12. In the Widows and Orphans fields, type the number of widows and orphans

to allow on each page.  Widows are the lines of text left at the bottom of a

page when a record is split in two. Orphans are the lines of text at the top of

the next page.  The number entered in the Widows field controls the minimum

number of lines Concordance allows to remain at the bottom of a page. If the

number of lines to print at the bottom of the page is less than the number in

Widows field, then the document is moved to the top of the next page.  The

number entered in the Orphans field controls the minimum number of lines

Concordance prints at the top of a page when splitting a document between

pages. If the lines left to print are less than the number in the Orphans field,

then lines will be borrowed from the previous page until the orphan minimum

is met. This may cause the preceding page to go below the widows threshold,

causing the entire document to print at the top of the new page.

13. Select any additional Options that are necessary:
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· Print date puts the current date on each page below the footer.

· Print time puts the current time on each page below the footer.

· Print field labels prints the field name before each field.

· Print page numbers puts the page number at the bottom of each page on

the right.

· Print document numbers will number each page of the report with current

and total page numbers.

· New page for each record prints each document on a separate page.

· Highlight annotations highlights both notes and annotations in the report.

· Compressed printing allows you to compress multiple pages on one

printed page.

· Print page borders is only available for Compressed printing and prints

borders around the page.

· Underline hits, Bold hits, Italicize hits, and Hit Color all affect how

search hits will display in full-text paragraph fields

14. In the Options section, select the print options you want to apply to your

report.  Search hits are only highlighted in the full-text paragraph fields, not in

fixed-length text, date or numeric fields.  If a record is edited after the search,

the record's search hit will not be highlighted in the report. To include the

edited record's search hit, index or reindex the database and re-run the search.

15. To finalize the rest of your print settings click the Print tab.
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16. Total is read-only, and displays the total number of documents in the current

query.  In First, type the number of the first document you want to include in

the report.  In Last, type the number of the last document you want to include

in the report.  You can also click:

· Save print file - allows you to save your print settings to a print format file

(.fmt).

· Open an existing print file - allows you to load settings from an existing print

format file (.fmt).

· Change the font - allows you to select fonts for the fields, data, transcripts,

and header/footer in the report.

· Change the margin, orientation and other print settings

· Print preview - shows a preview of your report.

17. Click the Print button to generate and print the report. 
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Printing by Tally

The tally feature in the Tally task pane itemizes field information for searching, and

is also a great tool for helping you organize your document collection in

preparation for printing reports. For example, if you want to print a subset of

records based on the document type, such as a group of financial reports. The

fastest way to locate these records is by running a tally count and then printing

them based on your needs.

To Tally Records for Reports

1. In the Table view, right-click a record in the field column you want to tally, and

click Tally [field name].

1. Clicking Tally [field name] displays the tally results in the Tally task pane.
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2. In the Tally task pane, double-click an item in the Tally list.

i. Double-clicking an item in the tally list displays only those records in

the Table view. For example, if you ran a tally on the DOCTYPE field, and

double-clicked Financial Report in the Tally task pane, only financial

reports are displayed in the Table view.

3. Print the applicable records.  See Printing Standard Reports  for details

about printing individual or multiple records.  See Exporting Concordance

Data  for details about saving data to Microsoft Excel.

301
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Concordance Databases

We recommend preparing and outlining your database field structure in advance. 

This may involve discussions with a lead attorney and key people involved in the

case.  Making changes to the database structure once data has been loaded has a

high potential for database corruption, so careful preparation helps minimize the

need for changes later.

Use the database checklist to assist you when you first begin creating and indexing

databases to ensure that you understand each step of the process and don't forget

to verify critical data.

Making changes to your database template is the number one way

to corrupt your database. It is important to prepare and outline

your field structure in advance to avoid changes after data has

been loaded.

Database Capacities

Datab

ase

Capaci

ty

Number

of

docume

nts

33

million

Concate

nated

database

s

128
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Datab

ase

Capaci

ty

Concate

nated

docume

nts

Over

four

billion

Docume

nt size

3 billion

character

s

Fields 250

Database

.ivt file

1/2

terabyte

Database

dictionar

y

1

terabyte

Database

file path

name

199

character

s in

length

Database Checklist
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Data Review

Do you know how many

documents or gigabytes

(GB) of data have been

received?

Are your files converted

to types that are

recognized by

Concordance?

Do you understand

Concordance field

structure and how it

affects importing data?

Review Load Files

Have you reviewed the

contents of the data

volume you are about to

load?

Have you reviewed your

data load file for

acceptable delimiters and

date formats?
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Data Review

Do you have fields set in

place for data that you

are importing?

Have you verified that

the bates number for the

first record to be loaded

does not overlap with the

last bates number used

in the existing collection?

If it does overlap, a

correction should be

requested from the

source prior to loading.

Did you receive an image

load file along with your

images? If not, you can

create one.

Did you adjust the

directory path of your

image load files, if need

be?

Have you verified that

your alias in the image

load file matches the
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Data Review

Image field in the

Concordance database?

Have you reviewed how

your OCR has been

formatted, named and

organized? Do you know

which CPL to use for

import if the OCR was

not included in the .dat

file?

Importing a .pst file

requires that a user

profile is set up for each

user in Microsoft

Outlook. Have you

completed this process?

Database

Structure

Did you create a

database template that

includes administrative

fields?
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Data Review

Did you select an image

key field for your

images?

Did you validate the

EDITTRAIL and

CREATEDATE fields?

Did you index all fields

needed for full-text

searching?

Did you create additional

miscellaneous fields?

CPLs

Did you verify supported

CPLs for your current

Concordance version by

reviewing the  ...

\ProgramData\CloudNin

e\Concordance 10\CPL

folder? 
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Data Review

Case Review

Have you reviewed case

records to understand

what types of files you

are importing?

Did you review case

records to plan your field

structure?

Do you understand what

types of reports you may

be generating for

maintenance and to

support reviewers?

Do you understand the

file and media

requirements for print

productions, especially

for opposing counsel?

Ongoing

Maintenance
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Data Review

Have you outlined

maintenance processes

and schedules that affect

your new databases?

Concordance Database Files

Each Concordance database uses several files during operation. Only four are

absolutely required to open and use a database. The four mandatory files are the

database control block (.dcb), the numeric date text file (.ndx), the text file (.tex), and

the security file (.sec). The security file only exists if security has been enabled. All of

the other files can be recreated without damaging the integrity of the data. At a

minimum, these four files should be backed up for archival purposes.

A B-tree file uses a tree data structure to provide fast search results.

The tree data structure minimizes the number of times the

database is accessed when searching for a record, resulting in

faster searches.

The .TRK file in Concordance uses SQLite. SQLite is an embedded

relational database engine, and does not increase the required

maintenance and administration of Concordance.

Concordance Database Files
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Fil

e

Ex

te

ns

io

n

 Fil

e

Ty

pe

Usage B

-

t

r

e

e

F

il

e

?

S

Q

L

it

e

F

il

e

?

.arf Ann

otat

ion

rep

orts

Contains the

annotation report

definition.  Used

by the annotation

report writer.

.ar

p

Rep

ort

writ

er

Contains report

definitions in

plain text.  These

files are created

and saved by the

report writer, and

can be edited with

any text editor

program.

.cat Con

cate

Stores a list of

concatenated
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Fil

e

Ex

te

ns

io

n

 Fil

e

Ty

pe

Usage B

-

t

r

e

e

F

il

e

?

S

Q

L

it

e

F

il

e

?

nati

on

databases.

.cib Ima

geb

ase

Stores association

between media

keys and native

and image files

including markup

history

(Concordance

Native Viewer

only).

y

es

.cpl CPL

scri

pt

Concordance

Programming

Language (CPL)

scripts.
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Fil

e

Ex

te

ns

io

n

 Fil

e

Ty

pe

Usage B

-

t

r

e

e

F

il

e

?

S

Q

L

it

e

F

il

e

?

.cp

t

co

mpi

led

CPL

scri

pt

Compiled version

of a CPL script

.cs

v

Sec

urit

y

Stores field and

menu access for

all users (when

exported by user).

.da

t

Deli

mit

ed

text

Contains

metadata and

sometimes OCR

for document

records.
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Fil

e

Ex

te

ns

io

n

 Fil

e

Ty

pe

Usage B

-

t

r

e

e

F

il

e

?

S

Q

L

it

e

F

il

e

?

.dc

b

Dat

a

con

trol

bloc

k

Database

definition,

including fields,

document count,

and other

settings.

.dc

t

Dict

ion

ary

All unique words

in the database, in

alphabetical

order.  This is not

a plain text file, it

cannot be read or

edited by a text

editor or word

processor.

y

es
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Fil

e

Ex

te

ns

io

n

 Fil

e

Ty

pe

Usage B

-

t

r

e

e

F

il

e

?

S

Q

L

it

e

F

il

e

?

.dir Ima

geb

ase

Stores image keys

(Concordance

Image Only).

.fm

t

Prin

t

setti

ngs

Saves print

settings for

reports generated

using the

standard print

feature.  This is a

user generated

file.

.fyi Con

cor

dan

ce

FYI

A link file that

opens a database

on a remote FYI

Server.
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Fil

e

Ex

te

ns

io

n

 Fil

e

Ty

pe

Usage B

-

t

r

e

e

F

il

e

?

S

Q

L

it

e

F

il

e

?

Ser

ver

dat

aba

se

.fzy Fuz

zy

sear

ch

dicti

ona

ry

Contains

homonyms for

words in the

search dictionary.

 This file is created

and updated by

indexing and

reindexing.

y

es

.ga

t

Bac

k

Up

A tag backup file

that stores

tagging
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Fil

e

Ex

te

ns

io

n

 Fil

e

Ty

pe

Usage B

-

t

r

e

e

F

il

e

?

S

Q

L

it

e

F

il

e

?

information.

Generated by

running the

TagSaver_v<versi

on>.cpl

.ini Con

figu

rati

on

setti

ngs

Stores various

configuration

settings.

.ivt Inve

rted

text

Used with the

dictionary during

searches.
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Fil

e

Ex

te

ns

io

n

 Fil

e

Ty

pe

Usage B

-

t

r

e

e

F

il

e

?

S

Q

L

it

e

F

il

e

?

.ke

y

Key

fiel

ds

Field storage for

fast relational

searching.

y

es

.lay

out

Tabl

e

layo

ut

Stores the defined

table layouts.

y

es

.so

rtla

yo

ut

Sort

ing

layo

ut

Stores the defined

sorting layouts for

the current

database.

.lst Wo

rd

lists

Contains

predefined values

that can be

y

es
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Fil

e

Ex

te

ns

io

n

 Fil

e

Ty

pe

Usage B

-

t

r

e

e

F

il

e

?

S

Q

L

it

e

F

il

e

?

selected from a

list when editing

fields.

.nd

x

Nu

mer

ic,

dat

e,

and

text

fiel

ds

Stores data for

the fixed length

field types:

Numeric, Date,

and Text.

.op

f

Prin

t

setti

ngs

A Concordance

Image print file

that stores print

settings for print
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Fil

e

Ex

te

ns

io

n

 Fil

e

Ty

pe

Usage B

-

t

r

e

e

F

il

e

?

S

Q

L

it

e

F

il

e

?

jobs generated by

Concordance

Image (Opticon). 

This is a user

generated file.

.qr

y

Que

ry

Stores search

query strings.

-

red

lin

es.

dc

b

Dat

aba

se

Stores markups

and notes

(Concordance

Image Only).
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Fil

e

Ex

te

ns

io

n

 Fil

e

Ty

pe

Usage B

-

t

r

e

e

F

il

e

?

S

Q

L

it

e

F

il

e

?

.se

c

Sec

urit

y

con

trol

Stores passwords

and security

settings.  Erasing

this file can lock

up a database if

security is

enabled

y

es

.sn

p

Sna

psh

ot

Stores search

history and auto-

restore settings.

.st

p

Sto

pw

ord

s

Contains the

noise words that

are ignored

during database

indexing.

y

es
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Fil

e

Ex

te

ns

io

n

 Fil

e

Ty

pe

Usage B

-

t

r

e

e

F

il

e

?

S

Q

L

it

e

F

il

e

?

.sy

n

Syn

ony

ms

Stores user

defined

synonyms.

y

es

.ta

g

Tag

ged

rec

ord

s

Tracks document

tagging.  No

longer used with

Concordance 9.5

and higher.

y

es

.tex Text Full text

paragraph field

storage.

.trk Tra

nsa

ctio

Stores tags and

tag histories,

security (field and

y

es
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Fil

e

Ex

te

ns

io

n

 Fil

e

Ty

pe

Usage B

-

t

r

e

e

F

il

e

?

S

Q

L

it

e

F

il

e

?

n

trac

kin

g

menu access for

all users) and

replication data.

.vo

l

Vol

um

es

Stores image

volume

information

(Concordance

Image Only).

.xrl Mar

kup

Stores the current

state of markups

and

placeholders(Con

cordance Native

Viewer Only).
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Temporary Files

Concordance creates and uses temporary files, which are automatically erased

when you leave the program. Temporary files are not erased if there is a power

outage or other problem which causes an irregular program termination.

Concordance places the files in the system's temporary directory as defined by the

Windows TEMP environment variable. The two most common functions that create

temporary files are indexing and reindexing.

When indexing a database, two temporary files are saved in the local computer's

temp directory. Both files begin with the prefix C- and end with the .tmp extension.

These files represent the temporary .dct and .ivt files. They are not initially saved on

the network server since network latency would severely decrease performance.

When indexing is complete, the resulting .dct and .ivt files are copied to the network

server.

When reindexing a database, the same temporary files are saved in the local

computer's temp directory. In addition, a temporary dictionary file with a .dcb file

extension is saved in the local computer's database directory. This file contains

information from the newly created records. Near the end of the reindexing

process, this dictionary file is merged with the main dictionary file on the network

server.

Managing Data Files

Files can be received from a client, data processing vendor, or third party. When

receiving data, you should always review all files on the disk, prior to loading the

data, to ensure they have the proper formats for Concordance.

Load files or delimited text files are one of the files used to construct your

Concordance database. These files typically have extensions ending in .dat, .csv, or

.txt. Each file contains record metadata, but some may also include body text. We

recommend having your OCR separated into individual text files and imported

separately using a CPL script.
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Administrators should always make a practice of opening and reviewing the

delimited text files when you receive them, as the files are not always prepared

perfectly and may need to be modified.

When reviewing your data load files, always check for the following:

· Field names – each line of metadata is one record, check each header column

to verify data

· Delimiters – unique characters that appear in the delimited text file and do

not exist in your actual data.  Concordance delimiters are:

o Comma - Field break indicator, default is ?  (ASCII 20), customizable, avoid

these characters in data

o Quote - Keeps text together, default is þ (ACSII 254) and is only required

around fields that have text and spaces, customizable, avoid these characters

in data

o New Line - Manual line break and text wraps within a field, default is ®

(ASCII 174), customizable, avoid these characters in data

o New Record - Starts a new record, final carriage return loads the last record,

cannot be changed, industry standard

· Date format – date fields are an 8-character maximum with slashes. If dates

include slashes, you can import any format. If slashes are not used, then you

must use the universal date format of YYYYMMDD or the mm-dd-yyyy date

format with dashes.

· Carriage return – a final carriage return ensures that the last record will load

into the database.

Delimiters are customizable for an organization's internal database

design, but many organizations ask vendors to use Concordance

default delimiters.  If your case records contain the registered

trademark symbol, you may want to consider changing the ® to

another symbol in the load file.
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Data Fields

Before you begin your database construction, it’s important to understand the

types of data you will receive, and how that information can be categorized into the

data format of Concordance fields. 

There are two basic field categories available in the Concordance system: defined

length fixed fields and variable length paragraphs. The full-text paragraph fields are

the most flexible and most commonly used type in a Concordance database.

Fixed fields are always a pre-defined length and contain numbers, dates, or short

amounts of text.  Documents in a Concordance database can be sorted by the

contents of both fixed fields and paragraph fields, but fixed length fields sort much

faster.  Data in fixed fields is typically searched using relational comparison search

operators such as =, >, and <.  Fixed fields can be fully indexed and searched using

full-text techniques as well.

Fixed length fields have unique applications when compared to full-text

paragraphs. While paragraph fields are flexible and variable in size, they do not sort

quickly or search easily by comparison.

· Fixed-length fields sort the fastest.

· Fixed fields display faster in Table view than Paragraphs. This is useful in long

document databases.

· Relational searches for dates and numbers work best when they are stored in

Date and Numeric fields.

· Numeric and date math using the Report Writer or using Concordance’s

programming language work best with Date and Numeric fields.

Concordance Data Field Types
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Da

ta

Ty

pe

Capa

city

T

y

p

e

Notes

Dat

e

8 bytes Fix

ed

Just for dates, keyed

by default

Nu

mer

ic

1-20

digits

Va

ria

ble

Currency, zero-filled,

comma, keyed by

default

Text

 

1-60

charact

ers

Va

ria

ble

Alphanumeric, keyed

by default

Par

agr

aph

12

million

charact

ers

Fix

ed

Alphanumeric, indexed

by default, allows rich-

text format

If you want a field to be full-text searchable, make it a paragraph

type.  Reviewers in Browse view will see that fields with an = sign

are for relational searches and fields with a : sign are full-text

searchable.
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Understanding Field Structure and Applying

Properties

Concordance does not have a predefined field structure and there are no required

fields.  This means that preliminary planning in how you construct fields and apply

properties to each field is essential.  The general Concordance field profile includes:

· No predefined structure, no required fields

· Maximum of 250 fields per database

· Field Name maximum of 12 characters, including: Letters, Numbers at middle

or end, Underscores in the middle only

· Field names are stored in capital letters

· Field name saves when the data type is selected

Media (image) key field names with Unicode characters are not

supported.

Concordance Field Properties

Image

(Concord

ance

Image

Only)

Indicates which field contains the image

key or alias, only selected once per

database and is usually the BEGNO field.

Media 

(Concord

Indicates the field that contains the media

key or alias, only selected once per
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Concordance Field Properties

ance

Native

Viewer

Only)

database and is usually the BEGNO field.

Key Speeds sorting and relational searching

(adds values to database .key file), keying

everything dilutes the value

Accessi

on

Copies UUID in system table into visible

field, good for sorting by load order, great

for tracking gaps

System Field cannot be seen by users,

Concordance creates these for

replication/synchronization information

Indexed Enables full-text searching (adds values to

.ivt and .dct files)

Guidelines for Creating Fields

Bates A unique serial number used to identify a
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Guidelines for Creating Fields

Number record. When setting up the numbering

system, think of the longest number you

might need given your case record load.

Designate a length that is large enough so

data does not truncate. Choose text as the

field’s properties in case you need an

alphanumeric system implemented.

Media

field 

(Image

field)

Select the Media (Image) Key setting to

indicate the media key or alias field.  You

can click the View image (camera) button

to launch and link the imagebase files with

the corresponding Concordance database

records. Only make this selection once per

database for a unique field, this is

generally the BEGNO field.

Keyed

fields

Select the Key setting to improve sorting

and relational searching speed.

Indexin

g

Indexing puts data into the dictionary and

index. You can index any data type.

Paragraph fields are indexed by default.

Full-text searching only works on indexed

fields. Avoid indexing unique values, serial,

Bates numbers, and dates to optimize the

full-text searching speed. Use relational

searching for non-indexed fields.
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Guidelines for Creating Fields

OCR2

field

This field is created as an overflow field for

OCR1, just in case the 12 million character

limit for OCR1 is exceeded. This field name

must have the same alpha prefix as the

primary field and the numeric suffix must

be a consistent width and start at 1. Fields

must be entered in order by suffix. Use the

ReadOCR_v[version #].cpl if you need this

overflow field.

Punctua

tion

Your customizable Punctuation list

designates what punctuation you can use

for full-text searches, as long as the

characters are embedded between

alphanumeric characters and are within

quotes. You only need to set punctuation

once for each database.

Diction

aries/In

dexes

Big dictionary and index files slow search

processing. Do not bloat these files with

unnecessary entries; build stopword lists

to exclude them.

Field

Validati

on

Some fields require additional attributes

for tracking purposes, like EDITTRAIL and

CREATIONDATE date fields. These

attributes are set in the Data Entry

Attributes and must be added before

importing load files in order to the capture

information.
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Guidelines for Creating Fields

Table

view

Field column width in Table view is

determined in the Types setting in the

Modify dialog box. The default column

width is the field length identified in the

Data Types table, and as set in field

properties. And by default, paragraph

fields aren’t included in Table view to keep

display speed optimal. You can customize

Table view to include paragraph fields at

any time.

Common Database Fields

Fiel

d

Ty

p

e

Length and Option

Settings

BEG

NO

Tex

t

30, Key, Image

END

NO 

Tex

t

30

DOC

DATE

 

Da

te

Key, MM/DD/YYYY
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Fiel

d

Ty

p

e

Length and Option

Settings

DOC

TYPE 

Par

agr

ap

h

Indexed

DOC

TITLE

 

Par

agr

ap

h

Indexed

AUT

HOR 

Par

agr

ap

h

Indexed

RECI

PIEN

T

Par

agr

ap

h

Indexed

PAGE

S 

Nu

me

ric

Length 20, Places 0, Plain Format,

Key
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Fiel

d

Ty

p

e

Length and Option

Settings

TEXT

01 

Par

agr

ap

h

Indexed

TEXT

02

Par

agr

ap

h

Indexed

Common Administrative Fields

Fiel

d

Ty

pe

Settings

ACCE

SSID

 N

um

eri

c

20, 0, Accession, Use to track delete

documents. Generates a record

load order number.

CREA

TEDA

TE

Dat

e

Set properties using the Validation

command on the Edit menu,

normally not keyed or indexed
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Fiel

d

Ty

pe

Settings

EDIT

TRAI

L

Par

agr

ap

h

Set properties using the Validation

command on the Edit menu,

includes YYYYMMDD, time, time

zone, [session # -- assession #] per

user

PRO

DBE

G1 

Tex

t

Captures beginning Bates numbers

for first production. Using number

suffixes avoids having to rename

fields later for additional

productions.

PRO

DEN

D1 

Tex

t

Captures ending Bates numbers for

first production. Using number

suffixes avoids having to rename

fields later for additional

productions.

PRO

DNO

TES1

PRO

DNO

TES2 

Par

agr

ap

h

Enter pertinent information here

about the person who ordered the

production, add this on every single

record in a production set.

PRO

DDA

TE1 

Dat

e

Enter the production date here with

global edit or

AppendTextToField_v<version>.cpl.
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Fiel

d

Ty

pe

Settings

PRO

DTA

GS1 

Par

agr

ap

h

Used to capture tags as they existed

at the time of production using the

Tag To Field command, Tools >

Manage Tags/Issues.

TAGS

 

Par

agr

ap

h

Used to hold the names of checked

tags generated by the Tag To Field

command, Tools > Manage

Tags/Issues.

TAGI

NFO

Par

agr

ap

h

Used to hold activity generated by

the Tag History&Store

It_v<version>.cpl.

CUST

ODIA

N

Par

agr

ap

h

Original owner of the data.

REVI

EWS

TATU

S

Par

agr

ap

h

Name of person who reviewed the

file.

ATTY

NOT

Par

agr

Used to hold attorney notes.
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Fiel

d

Ty

pe

Settings

ES ap

h

ADM

IN1 

ADM

IN2

ADM

IN3 

ADM

IN4 

Par

agr

ap

h

Extra fields to hold data generated

later for any reason, make several

of them.  When you make a new

field, you must run a full index so

these fields save valuable time. 

Make some paragraph and some

for dates.

Additional Administrative Fields and Naming Conventions

Fiel

d

Ty

p

e

Settings

Seria

l

Num

bers

Tex

t

Can be used to link to image files if

BEGNO is not used.  May have

many serial numbers during the life

of a database, usually matched with
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Fiel

d

Ty

p

e

Settings

the .tif file name as the first field in

the database.

BEGB

ATES

BEG

DOC

STAR

TPA

GE

Tex

t

Alternative field names for BEGNO.

END

BATE

S

END

DOC

END

PAG

E

Tex

t

Alternative field names for ENDNO.

DOC

NO

Tex

t

Document number, an alternative

to using serial numbers key to the

page, more common in e-

documents that are not .tif files.
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BEG

ATTA

CH

Tex

t

Used to denote attachment range.

END

ATTA

CH

Tex

t

Used to denote attachment range.

INCL

UDE

S

Tex

t

Holds Bates or control numbers of

all pages inside the document,

facilitates searching for middle

page .tif files.

PAR

AGR

APH

Par

agr

ap

h

Alternative name for DOCTYPE

field.

Docu

ment

meta

data

fields

Par

agr

ap

h

Also called bibliographic metadata

fields. Typically includes author,

recipient, custodian, dates (sent,

received filed, etc.), subject, title, etc.

Generally this information is visible

on the face of the document.
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Settings

Syste

m

meta

data

fields

Par

agr

ap

h

Typically includes information

captured automatically by the

computer like last access date,

modification date, and print date. 

This information may not appear on

the face of the document.

TEXT

1

TEXT

2

Par

agr

ap

h

Alternative naming convention for

body text fields like OCR1, OCR2,

OCR3.  Used by

ReadOCR_v<version>.cpl to hold

imported OCR text.   If these fields

are named with the same alpha

prefix (TEXT for example) and have

numeric suffixes that start with 1,

are the same numeric length, and

are in order ascending by suffix, the

CPL script overflows additional text

into subsequent fields, as needed.

BOD

Y,

TEXT

or

MES

SAG

E

Par

agr

ap

h

Naming conventions for e-

documents that are not OCR

scanned, fields names are usually

with numeric suffixes.



Concordance 347

© 2022 CloudNine™. All rights reserved.

Fiel

d

Ty

p

e

Settings

ATTA

CHM

ENT

or

FILEP

ATH

Par

agr

ap

h

Customarily used to hold a clickable

hyperlink to the native document in

electronic format. If this field

contains a file path or web address,

running the

CreateHyperlinks_v<version>.cpl

converts it to a hyperlink.  Another

use is for this field to hold the Bates

number of records in Concordance,

which are attachments to the

current record. When populated

with Bates numbers, the

FindAttachments_v<version>.cpl

locates the attachments.  Or, this

field may contain Bates numbers of

any records that are attached to this

document. 

DOC

CON

D

Par

agr

ap

h

Holds notes about the document

condition, like Marginalia.

PRIV

CALL

Par

agr

ap

h

Holds the reason a document or

redacted sections are marked as

privileged, like Attorney-Client,

Priest-Penitent, Medical, etc.
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d
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p
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Settings

MEN

TION

S

Par

agr

ap

h

Keywords included in the

document.

LOA

DDA

TE

Da

te

Alternative name for CREATEDATE

field.  Used to record the date the

record was created, date data type.

AUDI

TTRA

IL

Par

agr

ap

h

Alternative name for EDITTRAIL

field.  Records the date, time zone,

computer session ID, and user

name any time a record is changed

in Edit mode, and paragraph data

type. 

DISC

SOU

RCE

or

SOU

RCE

Tex

t

Used for entering the name of the

disk the data is loaded from or

physical media it is delivered on,

includes disk number, case number,

client number, name of person who

loaded it, etc.

Admi

nistr

ative

Par

agr

ap

Consider creating ADMIN1PARA,

ADMIN1TEXT, ADMIN1DATE, etc. to

hold specific types of data.
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Settings

fields

with

differ

ent

data

types

h

or

Da

te

Tem

plate

for

admi

nistr

ative

fields

(no

t

ap

pli

ca

ble

)

Consider creating this template.

Each time you make a new

database, you can insert fields

above them to accommodate data. 

To create a template: on the

Documents menu,  point to Export,

and then click Structure.  Locate and

save the existing database structure

in the Templates folder that is

located in the same folder as the

Concordance .EXE file.

REVI

EWE

DBY

Par

agr

ap

h

Alternative name for

REVIEWSTATUS. Name of the

attorney who reviewed the file.

TAG

SATP

Par

agr

Alternative name for PRODTAGS1.

Tags as they existed for production.
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p

e

Settings

ROD ap

h

Handling Empty Data Fields

Empty fields are those that contain no values.  You can configure a database so

empty fields are not visible in the field listing. Hiding unused fields can help to

improve the readability of database records for end users.  Showing empty fields is

generally a preference for Concordance administrators, who typically want to have

all database fields visible whether they contain data or not.

By default empty fields are not visible. This means that when you create a new

database but before you import data, no fields are visible since none of the fields

contain any data. After you import data, any field that does not contain data will not

be visible. 

To Show or Hide Empty database fields:

1. Open the Concordance database you want to view.

2. From the Tools menu, click Empties.  A check mark next to the Empties

command indicates that empty fields are visible, a missing check mark

indicates that empty fields are not visible.
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If you have the option to view empties enabled, you may still see

fields with no data on individual records. This situation occurs if

data exists in that field for any other record in the case.

Database Templates

Database templates are stored in C:\ProgramData\CloudNine\Concordance

10\Templates.  All templates in the Templates folder and the Templates folder's

subfolders are displayed in the Create database from template dialog box.  With

the exception of the General tab, the Templates folder subfolders are displayed as

tabs in the dialog box.  The General tab contains all database templates in the main

Templates folder.

You can save your database templates in one of the existing Templates folders or

create your own Templates subfolder.  Concordance ships with pre-defined

templates and template subfolders. You can modify or delete the pre-defined

templates and subfolders if they do not meet your organization's needs.

When you create a database, a temporary subfolder is added to the

database folder structure.  This folder is only temporary and will be

removed when the database is closed.
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Pre-defined Database Templates

Fold

er

Nam

e

Template Name

Templa

tes

Blank

Generic 20 Field

Research Bibliography

E-Docs E-Documents 

E-mail And Attachments

FYI Fyi Log

LEGAL Litigation Document

Production

Transcripts

Create a Database From a Template
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1. In Concordance, on the File menu, click Template.  The Create database

from template dialog displays.

2. Select the template you want from one of the tabs and click OK.

3. In the Create Database dialog, navigate to the database location, type the

name of the new database to create, then click Open.

4. If you selected the Blank template, there are no predefined fields, and you will

have to define all of the fields in the database.  The New dialog displays for

you to define the fields in your new database.

5. On the right, use the fields and drop downs to define the attributes that are

necessary for each new field:  Name, Type, Length, Places, and Format.  See

Data Fields  for more information about the various Concordance data types

that are available.

· The Length affects the column width and how the field appears in the

Table View.  Small Lengths cause the field name to appear truncated.

· Places and Format are only used for numeric field types.

· Negative numbers use an extra place for the negative sign.

332
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The FYI Server and FYI Reviewer do not support user names,

passwords, or database names containing characters in Unicode,

such as Chinese or Japanese characters. Currently, FYI Server and

FYI Reviewer only support user names, passwords, or database

names containing single-byte characters, such as English

characters.  If your organization uses FYI Server and FYI Reviewer,

be sure to only use single-byte characters when creating user

names, passwords, and database names in Concordance.

6. Review the Punctuation and add any other punctuation characters that are

integral to your searches. 

7. Select the check boxes for the field properties that apply:

· Image - A image/media field is used to link Concordance with a viewer,

such as Concordance Viewer or Concordance Native Viewer. The Image

check box only needs to be selected for one of the database's fields.  It is

best practice to select the Image check box for the BEGNO field or it's

equivalent. You can configure the image viewer you want to use via

Preferences.  Regardless of the image viewer you use, when you view a

document associated with an record in Concordance, the corresponding

media/image is displayed in the selected viewer.

· Key - makes the field a key field.  Any field can be a key field, but most

often fixed-length fields and date, numeric, and text fields that you need to

search are designated as key fields.  Key fields perform a function similar

to indexing without needing to be indexed.  For Key fields, Concordance

creates a database .key file, which is used when searching key fields.  Full-

text paragraph fields are only made into key fields to quickly locate empty

paragraph fields.  Use restraint when designating key fields because they

take up more room and add administrative overhead.

· Accession - unique serial numbers internally assigned to each record in

Concordance databases. Accession numbers are stored with each record

and are managed entirely by the database software. They stay with the

document as long as the document stays in the database, even if other

records are deleted around it.  Accession numbers cannot be edited or

modified in any way, but they can be viewed. Only ONE database field

should be marked as Accession.
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· System - created by Concordance. Concordance automatically selects the

System check box for system fields, which are hidden fields with no read

or write end-user privileges. System fields are used for internal system

administration features such as replication. Under normal circumstances,

system fields should never be indexed, added, deleted or modified by

users.

· Indexed - a field must be indexed to use Concordance’s full-text search

capabilities. Indexing places every word in the field into a dictionary for

fast retrieval. Concordance automatically selects the Indexed check box

when you create a paragraph field. You need to manually select the

Indexed check box if you want to index other field types.  Be sure to index

the database after modifying the Indexed check box setting to update the

dictionary files.

8. To add a field to the database, click the New button.  

9. The order the fields are listed on the left is the order the fields will appear in

Concordance.  Use the Insert or Delete buttons, as needed, to rearrange or

remove your database fields.

· To move a field, click the field in the field list, click the Delete button, then

click the field just below where you want to move the field, and click the

Insert button.

· To insert a new field into the existing field list, click the field just below

where you want to add the field, and click the Insert button. 

· To delete a field, click the field in the field list and click the Delete button. 

Make sure that the database fields you are creating match the

fields in the header row of the corresponding delimited text file you

will be using to import the field data.

10. If you would like to save the list fields in your database to a .txt file, click the

Save To File button.

11. Click the OK to save your database.
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Create a Database Template

Creating a database template is great for building future Concordance databases. 

Database templates are created by exporting an existing database's structure. 

When you export a database template, the template includes fields, data types,

properties, punctuation, stopwords, field data validation settings, and .ini file

settings like alias groups and tags. The database structure is stored in a

database.dcb file. Security settings are not included in the template. 

1. In Concordance, open the database you want to use to create a database

template.

2. On the Documents menu, select Export, and click Structure.  The Copy

Structure dialog displays.

3. Navigate to the Templates folder or one of its subfolders, type the name of the

database file in the File name field, and click Save.  If you want to create a

new subfolder, navigate to the Templates folder, create the subfolder, type the

name of the database file in the File name field, and click Save. 

Data Validation

Once you have created your database and its fields, you can define the data

validation attributes for your database fields in the Data Entry Attributes dialog.

Data validation attributes are settings that define how data is entered in fields from

Edit view. 
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Define Data Validation Attributes for Fields

1. On the Edit menu, click Validation.  The Data Entry Attributes dialog

displays.

2. In the Field Name list, select the field to edit data validation attributes for.

3. In the Data validation section, select the options you want to apply to the

field.

· Upper case - converts field text automatically to all upper case letters.

· Lower case - converts field text automatically to all lower case letters.

· Advance on enter - advances the cursor to the next field when a user

presses the Enter key in the Edit view. This functionality is the default setting

for fixed-length fields. If you select the Advance on enter check box for a full-

text field, but need to insert a carriage return within the field, press

CTRL+ENTER.
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· Read only - allows users to view and copy data from the field, but they

cannot edit or modify the field.

· Disable rich text - disables the Rich Text Toolbar and only allows plain text

to be entered in the field. Existing rich text will remain in the original format.

 Used for text fields.

· Alphabetic only - allows only alphabetic characters in the field.

· Numeric only - allows only numeric characters in the field.

· Validate dates - used for date fields to validate whether a real date is

entered in the field. This check box allows users to enter partial dates in the

field, with zeros for unknown days, months, or years. If an invalid date is

identified, users can correct the date or ignore the error.

· Edit date - populates the field with the current date automatically when a

record is edited. Select this option for the EDITTRAIL field or its equivalent.

· Creation date - populates the field with the current date automatically

when a record is created in Concordance. Select this option for the

CREATEDATE field or its equivalent.

Upper case, Lower case, Alphabetic only, and Numeric only are

only supported with English text.

4. To assign an authority list to the field, click the File button.  In the Open dialog

box, navigate to and select the appropriate authority list file.

The Data validation and Authority lists sections in the Data Entry

Attributes dialog box are independent sections. For example,

assigning an authority list with words to a field selected as

Numeric only does not cause an error. The data from the authority

list overwrites the Numeric only setting.

5. Select the check boxes that apply to the authority list. 

· Required for data entry  When the user's cursor is placed in the empty

field, the authority list automatically opens. If the field is already populated,
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the authority list opens when a user clicks the right mouse button or

attempts to type in the field. When the Required for data entry check box is

selected, users can only choose a field value from the list or cut, copy or

paste the text in the field.

· Single entry field  The field allows only one field value from the list to

populate the field. If a user clicks another field value from the list, the

original value is replaced by the newly selected value. You can select both

the Single entry check box and the Required for data entry check box to

ensure users can only populate the field with one field value from the

authority list.

· List updateable by user  Users can add and delete field values from the

authority list assigned to the field. If you do not want users to modify the

authority list, make sure that the List updateable by user check box is not

selected. When the List updateable by user check box is selected, the Insert

and Delete buttons are displayed at the bottom of the authority list dialog

box.

· Upper case conversion  Concordance automatically converts all text to

upper case before text is copied to the field or the text is added to the

authority list. Do not select the Upper case conversion check box if you are

using an existing authority list containing lower case field values. If the check

box is selected in this scenario, when a user selects a lower case field value

from the list, the value will not be added to the field.

7. The Delimiter field defaults to the comma character. To change the field

delimiter, type a different character in the Delimiter field.  The character in the

Delimiter field is used to separate field values that were added to the field

from an authority list. Delimiters are also used by exploded sort reports and

the tally function to determine where one entry ends and another begins.

8. Click OK to save your changes.

Punctuation

When indexing a database, Concordance uses several rules to determine what is a

word and what is not. One of the rules is that a word ends when it encounters any

character that is not a number or a letter. For instance, the space character would

indicate that one word is ending and another is beginning. Some characters, like

the decimal point and the comma in numbers or the slash in dates, do not indicate
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the end of a word. They are called embedded punctuation and are a part of the

word.

The set of embedded punctuation recognized by Concordance during the indexing

process is determined by what you enter in the Punctuation field. By default,

Concordance recognizes the period (.), comma (,), forward slash (/), and the

apostrophe ('). It does not include the hyphen. These characters are only considered

part of a word if they are both preceded and followed by a letter or a number.

Changes to the punctuation list are kept with the database. Use any non-

alphanumeric character except the space. For example, add @ if you want to search

for e-mail addresses. Up to 10 punctuation characters can be entered. Changing the

embedded punctuation in the Punctuation field does not update the dictionary.

Index the database after modifying the Punctuation field to update the dictionary

files.

Concatenating Databases

Concatenation is joining together two or more Concordance databases, allowing

you to view multiple databases as if they were one database in Concordance.  There

could be several reasons to break down larger databases into smaller concatenated

databases:

· You can separate databases based on document type, or custodian and still

search the entire case's record collection together

· Attorneys may request that records are separated by category, yet still need to

combine the databases during case review

· Security is sometimes needed for a smaller set of data, so you can split the

database based on security needs

Because one case can contain thousands of records and transcripts, your firm’s

Concordance administrator most likely will create several databases and join them

together to reduce time indexing a vast amount of information, which can take

several hours. Separate databases are also created based on type: emails,

transcripts, and non-transcript records, so joining them for search purposes is ideal

during review projects. Sometimes attorneys may want subsets of records broken
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by category, such as all pleading documents and correspondence documents

separated by database, and again having the benefit of concatenating them for

specific review projects.

As a member of the review team, you must ensure that every pertinent record has

been reviewed, sorted and tagged appropriately regardless of the database

location. The way to do this efficiently is by concatenating databases and saving

appropriate search queries during the discovery process. You will still be able to

see every tag and issue, entered by all users, and listed alphabetically.

Concatenating databases is a powerful feature that includes:

· Searching up to 128 databases simultaneously and treating them as a single

large file, depending on network set up.

· Opening transcript and non-transcript databases together.

· Using drop-down database lists on field’s with selection functions.

· Save indexing time when new records needs to be imported into Concordance,

by having a secondary database created and joined with the primary database.

· Save maintenance time when indexing databases. With concatenation, you can

perform full index updates offline and index multiple databases at the same

time.

· Automatically display tags from all databases.

· Create field groups in INI files so reviewers can search multiple fields under

one alias (copy into each .ini file for joined databases).

Things to Know About Concatenated Databases:

· Concatenation is not a structural change, records in each database stay the

same.

· Concatenation is not permanent.

· Concatenated databases do not have to have any fields in common.

· Saved .cat files are editable text-based files.
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· If a .cat file is saved in the same folder as the primary database's .dcb file, then

the concatenated database launches automatically when the primary database

is opened. Packing and database modifications are done in the primary

database, indexing and reindexing are done on all the databases in the

concatenated set in turn.

· Searches search each dictionary file one by one.

Unless you save a .cat file, concatenated databases are merged for

only one Concordance session. The next time you open

Concordance, you need to rejoin the databases to continue

searching in this manner.

Joining Multiple Databases

When you concatenate a set of databases, the databases remain joined only for the

duration of your current Concordance session unless you save the concatenated

database set as a Concatenated (.cat) file. 

Saving a .cat file allows you to easily reopen the same list of databases so that you

can search across all the other joined databases in another session or restore saved

queries that were previously run on the concatenated set.

There are some instances where setting up a concatenated set can affect other

users. You should consult with your database administrator before saving a

concatenated set of databases.  See Saving a Concatenated File Set  for more

information.

If you want to preserve your search history for the concatenated set, you need to

save your queries during the current session while the databases are joined. You

can restore the queries at a later time. When restoring saved queries for a

concatenated database, you need to rejoin the databases before re-running the

searches.  

When reviewing a concatenated dataset, all tags in all databases

display in the Tags panel.  If you apply a tag from one database to a

366
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record in another database, Concordance automatically writes that

tag into that record’s corresponding database.

Concatenating Databases

1. To join another database with your current database, on the File menu, select

Concatenate and then Add database.  The Concatenated Databases

dialog displays.

2. Click Add.  Browse to and select the database to add.  Click Open.

3. The database you selected is listed in the Concatenated Databases dialog. 

Click Done to join the database files.

The Current Database pane in the Databases panel displays all the concatenated

databases and the total number of documents in the concatenated set.  You can

also view information about concatenated databases in the Properties dialog (File >

Properties).
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Joined databases in a Concatenated database set only remain concatenated for the

current session unless you save the concatenated database set.  Once you close out

of the database, the concatenation is removed from each of the databases in the

set.

To remove the database concatenation, on the File menu, select Concatenate, and

then Clear database. 

The Table view layout corresponds to the active database you are

reviewing. If you view a record from a concatenated database, your

Table view layout changes to display the fields and sort order for

that database. Remember to reference the Concordance Title bar to

see what database you are viewing for a particular record.

If you are reviewing multiple joined databases at a time, it may be

helpful to change the font color or size in each database to help

you differentiate between the databases at a glance.
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Indexing and Reindexing Concatenated Databases

Edits and changes on various databases are occurring simultaneously by all users

who are adding tags and comments, and editing records. Make sure that team

members are updating the dictionary for searches by regularly reindexing all the

databases in concatenated database sets.

When you Index a concatenated set of databases, Concordance indexes each

database in the set. If you have access to multiple workstations, you can Index

various databases simultaneously, saving time. When you Reindex a concatenated

set of databases, each database in the concatenated set is reindexed, updating the

whole concatenated database collection.

If a check mark is displayed next to Reindex on the File menu, the databases need

updating. The check mark disappears from this setting after the process is

completed. 

Saving Searches in Concatenated Databases

When searching concatenated databases, Concordance searches across all

concatenated databases but because it searches each dictionary file one by one,

searches may take a bit longer.

Saving queries executed on concatenated databases is the same process as saving

them when reviewing one database at a time.  All searches from all databases in

the concatenated set are saved.  Query files are stored in a .qry file, and can be

restored on a concatenated set as you would a single database.  You just need the

databases to be joined when you save the query and when you re-run the query. 

Re-running the queries on a concatenated database set gathers any updates made

since the last time any database was reindexed.

Printing From Concatenated Databases

When printing from a concatenated database set, you have the option to show or

hide certain fields.

If you are printing a standard report in Concordance, you need to designate the

database you are printing from on the Fields tab in the Print documents dialog.
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To open the Print documents dialog, click Print on the Standard toolbar.  You can

also select the fields you want to print and can arrange the field order for printing

on the Fields tab.

For more information, see Printing Standard Reports .

Saving a Concatenated File Set

Always consult with your Concordance administrator before saving personal

concatenated files to your hard drive or network to ensure you are following

internal guidelines for this process. Saving .cat files can affect other users, so you

need to exercise care and caution.

You have two options for saving your personal concatenated files:

· Name the concatenated file as you wish and save it to your hard drive or

network in a directory that is not the directory containing the primary

database file.

· Name the file differently than the primary database and save it in the primary

database's directory or another network or hard drive folder.

If you name your personal concatenated file set's .cat file the same

name as the primary database and store it in the same folder

location as the primary database, then all the databases listed in

the file launch automatically when the primary database is opened.

This could create confusion and search problems for other team

members.

Save a Personal Concatenated File

1. Join the databases you want to include in the concatenated file.

2. On the File menu, select Concatenate, and then Save list.

301
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3. Browse to where you want to save the file, type the name of the .cat file in the

File name field, and click Save.

4. In the Concatenated Databases dialog, click Done.

If you want to know which databases are joined together in a

concatenated file, you can open the .cat file in Concordance, or you

can open it in any text editor program to view the list of databases.

Opening a Concatenated File Set

When you open concatenated (.cat) files in Concordance, Concordance

automatically opens each of the databases joined together in the file, and lets you

search and review the databases as one database.

A concatenated file is an editable text file that you can open in any text editor

program to review and edit the joined databases.

Open a Concatenated File in Concordance

1. In Concordance, on the File menu, select Concatenate, and then Open list.

2. Locate and open the .cat file.  A new tab displays on the Workspace pane. The

new tab name defaults to the name of the primary database in the

concatenated file.

Open a Concatenated File in a Text Editor

1. Locate and right-click to select the .cat file on your hard drive or network.

2. Select Open With and select the text editor program.

3. The file contains a list of the joined databases with their corresponding

directory paths.  You can manually edit the .cat file, including cutting and

pasting database directory paths directly into the text editor program and

saving the file. 
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Deleting a Concatenated File Set

If you no longer want databases to be joined in a concatenated file or automatically

launch each time the primary database is launched, simply delete or rename the

.cat file in the directory you originally saved the .cat file.

Exporting Concordance Data

In Concordance, you can export record data from the Table view to Microsoft Excel,

CaseMap, and Equivio. The export feature is a great tool for making custom reports,

as well as contact and mailing lists. In order to export to Microsoft Excel, CaseMap

or Equivio, the software you are exporting to must be installed on your computer.

If you want to export data to Microsoft Word, you can simply copy

and paste data from Concordance to Microsoft Word. 

Exporting to Microsoft Excel

When you export data from the Table view to Microsoft Excel, Concordance exports

data from the records you select in the Table view. The fields and field order

currently displayed in the Table view determine which field data is exported for the

selected records and the order of the fields exported to Microsoft Excel. Before

exporting, you can run a search to display the records you want to export in the

Table view, and modify the table layout to define the fields and field order you want

to include in the export. 

Microsoft Excel has capacity limitations, especially older versions of

Excel.  Please verify the capacity available for your Excel version

before exporting.
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1. Run a search to locate the records you want to include in the export to

Microsoft Excel. 

2. In the Table view, adjust your table layout to include the fields and field order

you want to export to Microsoft Excel.

3. In the Table view, select the records you want to export.  You can export

multiple adjacent records and non-adjacent records.

4. Right-click in the Table View, select Send To, and then click Excel.  Microsoft

Excel automatically launches and displays your exported Concordance data in

the field order you selected.

Exporting Numerical Data

When you export numerical data from Concordance to Microsoft Excel, if the field

value begins with leading zeros, the leading zeros are trimmed from the field value.

For example, if you are exporting the BEGNO field value 00020177, the value is

exported to Excel as 20177. To keep record numbering consistent with

Concordance data, you need to add the leading zeros back onto the applicable field

data in Microsoft Excel.  See, Microsoft Excel documentation.

Numerical field values starting with alphabetical prefixes are not

affected when exporting to Microsoft Excel.

Only the field data that is displayed in the Table view is exported. Field data is

exported in the order that is displayed in the Table view, based on the selected table

layout. You can use custom table layouts to determine the field data and order of

field data exported to another application.

Exporting to CaseMap

When you export table data to CaseMap from the Table view, all of the records

listed in the Table view are exported to CaseMap. 

1. In Concordance, run a search to locate the records you want to include in the

export to CaseMap. 
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2. In the Table view, right-click the records, select Send To, select CaseMap, and

then click Send all documents in query.

3. A message displays indicating that CaseMap does not support Unicode and we

will only send single-byte (Ascii) text to them. Press OK if you want to

continue.

4. Click OK to continue.  Clicking OK opens the Completed dialog.

5. Click the Continue button.  The Bulk Send to CaseMap wizard in CaseMap

opens.  For more information about exporting Concordance data to CaseMap

and using CaseMap's Bulk Send to CaseMap wizard, see the CaseMap

documentation.

Protecting Data

Protecting discovery document collections is a sensitive and demanding job.  Your

Concordance administrator or Litigation Support Manager must perform a variety

of maintenance processes and manage various files to preserve the integrity of

your document collection.  Stringent litigation guidelines must be adhered to and

maintenance schedules followed to protect the information and ensure your

databases are up-to-date and running efficiently for the review team.

Processes involved in protecting your Concordance databases include:

· Taking Snapshots

· Backing Up Databases

· Zapping Databases

· Packing Databases

· Deleting Tags

· Performing Global Replacements

Consult with your Concordance administrator or Litigation Support Manager to

gain a deeper understanding of your organization’s maintenance process schedule.

 If you are responsible for maintaining the database at an administrative level, it is



Concordance 371

© 2022 CloudNine™. All rights reserved.

recommended that you attend our Concordance Administration Fundamentals and

Concordance Certified System Administrator classes.

Avoid using administrative features in Concordance that you are

unfamiliar with, because you could inadvertently cause data loss or

corruption. These features may also require a backup of the

database before proceeding.

Whenever possible, consult with your database administrator

before attempting to use any administrative features so they can

either backup the database before you proceed or take care of

administrative tasks for you.

Saving and Restoring Snapshots

Snapshots are a point-in-time picture of your work history. Using snapshots is one

way reviewers can help track and preserve both search history and search results.

Saved snapshots can easily be restored to see what the contents of a database were

on a particular day, and what search results were found at that moment in time.

During a lengthy review, tracking your work for the day is also important, not only

to manage tasks and schedules, but to provide a placeholder for searches so you

can jump right back into your project without duplicating previous efforts.

Unlike a query file, a snapshot saves the search results for documents retrieved, not

which words were searched. This means that a snapshot will not locate new or

updated documents in a database; a snapshot only displays those documents

captured at the time the picture was taken.  Because snapshots provide a picture-

in-time reference, all your search queries and customized sort settings are

preserved and can be displayed again or restored at a later time. If your database is

actively being edited, changes will not be reflected in a snapshot saved last week.

For instance, a document deleted from the database since the snapshot was taken

will display as blank when you open the snapshot in Concordance. To capture

updates after edits have been made, rerun your snapshot queries.

Snapshots are saved as .snp files and can only be restored to the original

databases. When you restore a snapshot file, Concordance automatically opens the

databases associated with the file, with all queries and sorts preserved.
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There are two ways to save snapshots in Concordance. You can manually save

snapshots or you can use the Auto restore command to have Concordance

automatically save snapshots for you. 

If you regularly save snapshots at the end of every work session,

we recommend that you periodically review and delete outdated or

unnecessary files due to their large file size on your hard drive or

network.

Manually Save a Snapshot

1. On the File menu, select Snapshot and then Save snapshot.

2. Navigate to the location for your snapshot file and provide a File name for

the snapshot.  Click Save.

3. All search queries and customized sort settings for the current Concordance

session are saved in a .snp file.

Auto-Restoring Snapshots

With the Auto-restore feature, Concordance can automatically create and save a

snapshot each time you close the Concordance application. The next time you open

a Concordance session, the application automatically displays the exact record and

view settings you had when you closed the application, including displaying your

last search in the Review view. 

The Auto-restore feature functions differently than manually saving separate

snapshots of work your sessions. When the Auto-restore feature is enabled,

Concordance automatically saves a autosave.snp file at the end of each session,

overwriting the previous work session’s snapshot file. The autosave.snp is

automatically saved to the user's \Documents\Concordance 10 folder on your

machine.
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By default, the Auto-restore feature is enabled. The Auto-restore feature is enabled

and disabled by clicking the Auto restore option in the Snapshot menu. When a

check mark is displayed next to the Auto restore menu selection, the Auto-restore

feature is enabled.

Restore a Snapshot

1. On the File menu, select Snapshot, and then Restore snapshot.

2. Navigate to and select the snapshot file you want to open, and click Open.

3. Concordance restores the databases and documents that were accessed

during the search session captured by the snapshot and launches them. The

search results are displayed in the Review view, and the restored snapshot file

is listed in the Recent panel in the Databases task pane.

Backing Up Databases

Database administrators take stringent precautions against data loss. Data loss can

occur for many reasons, including hardware failures, file corruption, human error,

and natural disasters that damage equipment containing data. It is important to

take precautions to deter data loss by backing up data on a regular basis and

having disaster recovery plans in place.

Most organizations have backup programs that run automatically at scheduled

times to backup data on their network servers. We recommend becoming familiar
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with your company’s backup policies and disaster recovery plans in case you need

to recover data that has been lost or damaged.

Every organization handles backups differently, so it is important to know how

often backups occur on your network or off-site hosted network. Sometimes

backups are stored off-site or may be difficult to recover on short notice, so it is

helpful to know what to expect.

Concordance databases on a network should be backed up on a regular basis to

protect work product. Concordance databases that are stored on local hard drives

or hosted on off-network computers should have an alternative means of backing

up the data, such as an external hard drive or other backup device that can be easily

attached to the computer. Many of these devices come with software programs

that are designed to run backups automatically at a scheduled time, or files can be

backed up by copying them manually to a storage device attached to the computer.

Consult with your Concordance administrator or Litigation Support Manager if you

need more information regarding your organization's backups and disaster

recovery plans.

Other Maintenance Tasks

In addition to backing up and preserving databases, your Concordance

administrator performs other processes that keep your document collection

streamlined and running efficiently.  Reviewers should understand how these

processes affect their document collections, but should not attempt to use any of

these tools without consulting their Concordance administrator or having received

proper database administration training for Concordance.

It is highly recommended that security is applied to every Concordance database to

preserve document collections and protect staff from inadvertently deleting or

altering critical information.

The following administrative functions do not have an undo feature to retrieve

data once the process is performed:

· Zap - deletes every record in the database
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· Pack - deletes documents marked for deletion

· Delete Tags - deletes all tags in the database

· Global Replace - find and replace process for words or phrases in the

dictionary

Zap

This is an administration-only function. The Zap feature is used to remove all

documents from a database, freeing space in Concordance.  Once all documents

are purged, only the stopwords file and field definitions are retained in the

database. When zapping a database, there is no undo feature so administrators

must back up databases before running this process.

Pack

This is an administration-only function. The Pack feature is used for both the

document database and dictionary file. Packing a database removes all documents

that are marked for deletion. Packing a dictionary optimizes its file structure to

increase search speed and index processing time. If not done properly, this feature

can delete all of the records in a database.  Once performed, there is no undo

feature so administrators must back up databases before running this process.

Delete Tags

The Delete Tags feature is used either to remove tags from all documents, or

remove all tags from a database. There is no undo feature once this process is

performed.

Global Replace

Global editing is basically running a Find and Replace process for words or phrases

in a database. The Global Replace function can perform replacements on specific

fields, full or empty fields, with or without case sensitivity, and with or without

confirmation before replacement. Caution must be used when replacing data,
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otherwise information in your document collection may be unintentionally and

permanently altered. There is no undo feature once this process is performed.
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References

Additional Resources

Information for Concordance FYI can be found in the Concordance FYI Answer

Center.

Details for the Concordance Programming Language (CPL) are documented in the

Concordance CPL Answer Center.

Sample Databases

To successfully download and extract the Unicode sample databases, you will need

WinRAR by RARLAB. WinZip® by WinZip Computing  does not handle the foreign

language characters in the Unicode sample databases correctly, causing the native

file links not to work in the databases.

· Calfco Sample Database

· Cowco Sample Database (without images)

· Cowco Sample Database (with images)

· Cowco Concordance Native Viewer Sample Database (with native files)

PDF Guides

Content in the Concordance Answer Center is available for download in the Adobe

Acrobat PDF format.

· Concordance Installation Guide

· Concordance User Guide

· Concordance Administrator's Guide
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If you are planning to work offline, you can also download a compiled version of

the Concordance Answer Center (Concordance.CHM file) and save it to a folder on

your local computer.

· Concordance Answer Center Compiled Help

Preparing for Concordance

Preliminary planning for implementing any software application is important for

achieving the best setup results, the first time. We recommend that you take some

time to review this section to plan how your organization will be using

Concordance so your administrative tasks are minimized for initial setup and your

long-term maintenance of the application is streamlined into routine updates and

adjustments, rather than reworking any database design and system security later.

Discovery Document Conversion

If you are unfamiliar with the e-discovery process, we recommend that you take

some time to research this growing and rapidly changing industry and learn how it

impacts your system network and strategy by understanding how critical it is that

data load files are handled carefully during the import process. Because you are

dealing with confidential materials, file corruption of your database records is a

sensitive matter and legal implications regarding spoliation are strict and can carry

hefty fines. Once data is altered, your ability to attain another copy of case records

in some instances is minimal – especially if it’s opposing counsel’s case records –

and can affect the lawsuit for the organizations involved.

System Requirements
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Concordance’s system requirements for hardware and software are minimal and

network setup is flexible. The primary focus in ensuring that Concordance runs

properly for you and your organization is all about processing speed = RAM on

your network and individual workstations.

Please review the current system requirements for setup and suggested processor

and RAM. Keep informed of Concordance release updates and how they impact

your system.  See System Requirements for more information.

Database Design

Engineered for capacity and speed, Concordance provides stability with its

enormous database capacity and robust security features. Designed with a flat-file

architecture and a proprietary back-end, Concordance can distribute and store data

and processing over local-area networks. With Concordance’s separate load and

index processes, you can import a variety of load files and their native file

attachments, accessing them both in Concordance and Concordance Native Viewer.

Proper review of your organization’s records for a given case helps determine how

you build and design your database structure. Concordance has some

requirements for importing certain types of records, especially emails and

transcripts. Additionally, reviewing your case load files provides you with a high

level road map for how you want to move forward in planning your database

design.

Database design considerations are based on:

· Possible database size – breaking record groupings into Database 1, Database

2, Database 3

· Document Type – email, native files, and transcripts

· Confidential/Privileged Status

· Content – Predetermined Subject Groupings
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· Rolling Production Environments – adding content to primary databases by

creating secondary databases and concatenating them

· Other

See Concordance Databases  and Importing Files for more information.

Security Setup

Security levels are predominantly affected by the size of your organization and the

user roles that constitute your review team. If your organization is large and has

several geographical locations, system security for multiple ongoing cases is going

to take time and forethought in planning. If you belong to a small organization,

your system security may be minimal for internal staff because users are more

likely to perform many roles using Concordance software.

Please consider implementing security in your organization to ensure that records

are preserved in accordance with e-discovery regulations and database documents

are secured from inadvertent alteration or deletion by applying recommended user

permissions for field and menu items.

See Security for more information.

Implementation Checklist

We understand that each organization has its own organization guidelines and

processes for supporting their review teams during case review. We also

understand that transferring to and implementing new technology may affect

current procedures and that you may need to adapt new ones given the demands

of a rapidly changing e-discovery industry. Please reference the Preliminary

Planning Checklist to guide you in preparation for implementing and maintaining

Concordance at your workplace.

309
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Preliminary Planning Checklist:

E-Discovery, Collection, and Processing

Do you have an understanding of e-discovery rules

and how they affect your specific case and the review

process?

Do you have a collection and processing plan in place

while also following forensic guidelines, as required?

Do you have vendor relationships set in place for

various stages of your case?

Do you have a quality control plan in place?

Do you know what types of files you are receiving

and whether they are recognized by Concordance?

Database Design

Do you know what your case dataset looks like?

What is the size of your case, including the # of

pages/documents and GB to be processed?

Will this case require a native review?

Do you understand what the case review workflow

will be?
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E-Discovery, Collection, and Processing

What kinds of fields are needed for tracking

administration and reviewer metrics?

What kinds of tags are needed for supporting

administration maintenance?

What fields are needed for coding additional

metadata?

Where will annotations be tracked by reviewers:

Concordance Image sticky note, text associated note

or field? If it’s a field, what fields need preparation for

annotations?

Do you have field and tag naming conventions set in

place?

Do you have a list of categories for preparing your

database tag structure?

Have you consulted key players involved with

Concordance review and administration regarding

database design?

Have you prepared a directory location with

subdirectory folders in a structure that prepares you

for optimal organization of the various files for the

case?

Did you create extra miscellaneous fields in your

database?
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E-Discovery, Collection, and Processing

System Requirements

Have you reviewed the Concordance system

requirements?

Have you given full network rights to all users in the

directory where each case resides?

Did you adjust the indexing and dictionary cache

settings for each workstation?

Do you have remote staff that will be using

Concordance offline remotely and need a mobile

license installed?

Security

Did you plan security settings for all users accessing

this case?

Did you apply security to each Concordance database

individually?

Did you store the security console user ID and

password in a safe location and share it with at least

one other supervisor or administrator?

Maintenance

How will subsequent loads of data be handled? Will

they be uploaded to the main database or will you
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E-Discovery, Collection, and Processing

use concatenation to join multiple databases?

Do you have indexing/reindexing schedules planned

based on the workflow and timeline of the review?

Is there a back-up schedule in place?

Do you have a quality control checklist for major

administration tasks like importing, exporting, and

global edits?

Do you have a disaster recovery plan in place?

Production

Do you have a production plan in place for delivering

files to opposing counsel?

Do you know what types of reports will be generated

or requested by the review team and how to print

them?

Roles and Responsibilities

Does your review team understand the database

design and know how they will specifically use

Concordance for review?

Does your review team understand timelines and

processes required for administrating and

maintaining Concordance?
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E-Discovery, Collection, and Processing

Are roles and responsibilities clearly defined among

administrators, litigation support staff, paralegals,

and attorneys?

Are there policies in place for who can and cannot

create/modify databases and other sensitive tasks?

Ongoing Maintenance

As an administrator you are busy managing multiple cases and the various

software programs and databases in various network locations. We recommend

you to take some additional time to plan a maintenance schedule for Concordance

depending on the complexity of product licensing versions and how database

structure is designed and geographically dispersed.

Typical database management for Concordance includes:

· Directory and subdirectory folder design to store multiple databases for

multiple case reviews within your organization

· Back-up schedules for each case/multiple databases/concatenated databases

· Full index updates on databases performed during off hours (weekends or

holidays) or offline if multiple databases can be updated while staff continues

work in other databases

· Reindex updates when records are added or modified

· Subsequent data and image loads

· Deleting and packing databases and dictionary files after data entry/editing

and indexing

· De-duplication
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· Replicating and synchronizing databases

· Modifying or adding database fields, which then requires a full index

· Tracking metrics

· Running productions

Keyboard Shortcuts

Concordance

Browse and Table View

Shortc

ut Key

Description

F1 Open Concordance Help.

F2 Open Search task pane.

F3 Open or close the Review View.

F4 Open the Query by Example dialog box to run a form search.

F5 Open or close the Table View in the Browse View.

F6 Open or close the Browse View in the Table View.
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Shortc

ut Key

Description

F8 Open the Sort task pane.

- Navigate to the previous document.

+ Navigate to the next document.

C Open the Copy dialog box to copy document data. (Browse

View only)

D Open the Goto dialog box to navigate to a specific document.

F Navigate to the first document.

G Open the Goto dialog box to navigate to a specific document.

L Navigate to the last document.

N Navigate to the next search hit.

O Open the Font dialog box to view or modify the font.

P Navigate to the previous search hit.
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Shortc

ut Key

Description

V Open the current document's corresponding image file in the

image viewer.

CTRL+

N

Open the New Database Creation Wizard for creating new

databases using load files, E-documents and E-mails.

CTRL+

T

Open the database templates for creating a new database

using a template.

CTRL+

D

Open the Dictionary dialog box when your cursor is in the

Advanced Search panel.

CTRL+

F

Open the Fields dialog box when your cursor is in the

Advanced Search panel.

CTRL+

S

Open the Fuzzy Search dialog box when your cursor is in the

Advanced Search panel.

Tags Task Pane
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Shortc

ut Key

Description

SPACE

BAR

Toggle selected tag.

C Open the Copy dialog box to copy document data. (Browse

View only)

D Open the Goto dialog box to navigate to a specific document.

F Navigate to the first document.

G Open the Goto dialog box to navigate to a specific document.

L Navigate to the last document.

N Navigate to the next search hit.

O Open the Font dialog box to view or modify the font.

P Navigate to the previous search hit.

other

letter

keys

Navigate to the tag starting with the same letter.
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Review View

Shortc

ut Key

Description

F2 Open Search task pane.

F3 Open the Review View if it is not already opened.

F4 Open the Query by Example dialog box to run a form search.

ENTER Execute the selected search query.

CTRL+

D

Open the Dictionary dialog box when your cursor is in the

Advanced Search panel.

CTRL+

F

Open the Fields dialog box when your cursor is in the

Advanced Search panel.

CTRL+

S

Open the Fuzzy Search dialog box when your cursor is in the

Advanced Search panel.

ESC Cancel the current search that is in progress.
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Edit View

Shortcut

Key

Description

CTRL+PA

GE UP

Navigate to the previous document.

CTRL+PA

GE DOWN

Navigate to the next document.

TAB Navigate to the next field in the document.

SHIFT+TA

B

Navigate to the previous field in the document.

CTRL+TAB Navigate to the last database or Workspace tab you

opened.

CTRL+C Copy the selected text.

CTRL+D Open the Duplicate dialog box to copy field data to

another record.

CTRL+F Open the Find dialog box to find text in the current field.

CTRL+F Open the Fields dialog box when your cursor is in the

Advanced Search panel.
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Shortcut

Key

Description

CTRL+SHI

FT+F

Find the next instance of the text entered in the Find

dialog box.

CTRL+H Open the Replace dialog box to find and replace text in

the current field.

CTRL+L Open the authority list associated with the current field. 

For fields not associated with an authority list, navigate to

and open a saved authority list. 

CTRL+S Open the Fuzzy Search dialog box when your cursor is in

the Advanced Search panel.

CTRL+V Paste the copied or cut text.

CTRL+X Cut the selected text

CTRL+Z Undo the last action

Concordance Viewer
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Shortc

ut Key

Description

PAGE

UP

Navigate to the previous page

PAGE

DOWN

Navigate to the next page

ARRO

W UP

Navigate to the previous page

ARRO

W

DOWN

Navigate to the next page

ARRO

W

LEFT

Navigate to the previous document

ARRO

W

RIGHT

Navigate to the next document

TAB Go to the next markup (if there are more markups on the

page)
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Concordance Native Viewer

Shortc

ut Key

Description

CTRL

+ C

Copy the current selection

CTRL

+ X

Cut the current selection

CTRL

+ V

Paste the copied selection

CTRL

+

SHIFT

+ A

Pan tool

CTRL

+

SHIFT

+ X

Zoom tool

CTRL

+

SHIFT

+ Z

Magnifier tool



Concordance Classic396

© 2022 CloudNine™. All rights reserved.

Shortc

ut Key

Description

CTRL

+ E

Fit to Height

CTRL

+ W

Fit to Width

CTRL

+

SPACE

BAR

Rotate clockwise 90 degrees

CTRL

+

SHIFT

+

SPACE

BAR

Rotate counter-clockwise 90 degrees

PAGE

UP

Navigate to the previous page

PAGE

DOWN

Navigate to the next page

CTRL

+ P

Open Print dialog box
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Concordance Image

Shortc

ut Key

Description

CTRL+

O

Opens the Open dialog box to open an image in the viewer.

CTRL+

B

Turn on or off the Toggle Bar Code Mode function.

CTRL+

R

Toggle the display of the redlines on the image.

CTRL+

P

Open the Print dialog box to print the images.

CTRL+

C

Copy the current selection on the image.

CTRL+

X

Cut the current selection on the image.

CTRL+

V

Paste the cut or copied selection.
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Shortc

ut Key

Description

I Invert image color. (only works with black and white images)

CTRL+ Zoom in a little.

CTRL- Zoom out a little.

+ Zoom in 50%.

- Zoom out 50%.

ALT+Z Zoom on selection.

W Fit image to width.

H Fit image to height.

CTRL+

F

Display the full screen.

< Rotate left from the original orientation.

> Rotate right from the original orientation.
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Shortc

ut Key

Description

/ Flip from the original orientation.

LEFT

ARRO

W

Rotate left from the current orientation.

RIGHT

ARRO

W

Rotate right from the current orientation.

DOW

N

ARRO

W

Flip from the current orientation.

CTRL+

HOME

Navigate to the first page.

PAGE

DOW

N

Navigate to the next page.

PAGE

UP

Navigate to the previous page.
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Shortc

ut Key

Description

CTRL+

END

Navigate to the last page.

G Open the Go to page dialog box to navigate to a specific page.

CRTL+

G

Open the Go to image key dialog box to navigate to a specific

image.

CTRL+

PAGE

DOW

N

Navigate to the next document.

CTRL+

PAGE

UP

Navigate to the previous document.

Developing with Concordance

DDE stands for Dynamic Data Exchange. It allows two applications to communicate

through programmed commands in the Windows environment. It is not a simple

interface and it should only be used by experienced programmers.

Any parameters used in communicating with Concordance are referenced by name.

 Commands tell Concordance to do something, or they send or receive data.  
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The examples given here are provided for the C programming language. There are

four types of DDE commands that Concordance will recognize. The first command

establishes the link between your program and Concordance. This is referred to as

opening a DDE conversation. 

Establishing a DDE Conversation

All DDE conversations are established by connecting to the DDE server,

Concordance. Establishing the conversation requires your program to provide two

parameters: the service and the topic. The service is the name of the DDE server, in

this case Concordance. The topic is defined by the service and it varies from server

to server. Concordance supports database names as topics. The database topic

should use the full file path in either standard or UNC format. Concordance opens

the database specified as the topic for use in the DDE conversation. Use an asterisk,

*, as the topic to open the conversation using any database currently open and in

use by an end-user. You can close that database later and open another using the

DDE Execute commands.

Example

The following example is written in C. It opens a DDE conversation with a

Concordance server. The OpenConcordanceDDE() function receives two

parameters: the instance identifier and the database name. The instance identifier,

idInst, is a value returned by DdeInitialize() when your program performed the

required DDE initialization. The pszDatabase parameter is a pointer to a zero

terminated string containing the name of a database to open, or NULL to open the

DDE conversation based on the currently open database, i.e., using * as the topic.

HCONV OpenConcordanceDDE( DWORD idInst, char *pszDatabase)

{

HSZ hszService,  // Name of service to connect.

             hszTopic;  // Topic of conversation.

        HCONV  hConv;  // Handle to DDE conversation.

             // Set the handle to a NULL value.
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             hConv = NULL;

             // Use the database name if provided, otherwise

             // use * if no database is specified, this will

             // open the DDE conversation using the current

            // database being viewed by the end-user.

            if (pszDatabase == NULL)

            pszDatabase = "*";

            // Create the service’s string handle.

            hszService = DdeCreateStringHandle(idInst, "Concordance", CP_WINANSI);

             // Create the topic’s string handle.

             hszTopic = DdeCreateStringHandle(idInst, pszDatabase, CP_WINANSI);

             // Connect to the service, Concordance.

             hConv = DdeConnect( idInst, hszService, hszTopic, (PCONVCONTEXT)NULL);

             // Free the DDE string handles.

             DdeFreeStringHandle(idInst, hszService);

             DdeFreeStringHandle(idInst, hszTopic);

             // Return the handle to this DDE conversation.
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             // The handle is required for all further

             // communication with the Concordance DDE server.

             return(hConv);

}

Once a DDE conversation has been established, all further communication between

your program and Concordance takes place through the Microsoft Windows’

DdeClientTransaction() function. The DdeClientTransaction() function has eight

parameters:

       DdeClientTransaction( void *lpvData, DWORD cbData, HCONV hConv, HSZ hszItem, UINT

uFmt, UINT uType, UINT uTimeout, DWORD *lpuResult);

DDE Execute Commands

Execute commands request Concordance to perform actions. These include moving

between records, performing a search, appending and deleting records, and

opening and closing databases. These commands return success codes, but they do

not return data.  Several commands contain two parts: the command and the

command parameter. For instance, opening a database also requires the name of

the database you want to open. The command is sent as the single string open

drive:path\filename.dcb.

DdeClientTransaction() Parameters

Execute commands use two DdeClientTransaction() parameters, lpvData and

cbData. lpvData is a pointer to the command string. This may simply be the

command string in quotes. cbData is the number of bytes in the command string,

lpvData, including the terminating zero. For instance, strlen(lpvData) + 1.

Returns

The XTYP_EXECUTE commands return DDE_FACK, DDE_FBUSY, or

DDE_FNOTPROCESSED. DDE_FACK and DDE_FBUSY are returned to indicate
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success or TRUE and failure or FALSE. For instance, the lock command returns

DDE_FACK if the record was successfully locked and DDE_FBUSY if it could not be

locked, i.e., someone else already has it locked.

DDE_FNOTPROCESSED is only returned if the command is not recognized, usually

due to a misspelling, or if the database is not open. The return codes are defined in

the Windows ddeml.h include file, provided with your compiler.

EXECUTE Commands

Comm

and

Parameter Function

append Appends the current record

to the end of the database.

This is generally used with

blank, to create a new

record. For E-documents

databases created using

Concordance version 10.21

and later, this function is

disabled.  To append a

document to an E-

documents database, drag

the document onto the

database.

blank Creates a blank record. If

the current record has been

edited, it is automatically

saved before being

blanked. Use blank records

with the append command

to add records to the

database.
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EXECUTE Commands

Comm

and

Parameter Function

browse Brings up the Browse

screen.

close Closes Concordance. This

also terminates the DDE

conversation.

closeda

tabase

Closes the current

database.

closeall

databas

es

Closes all open databases.

first Retrieves the first record in

the query.

goto FIELD =

VALUE

This performs a search for

the record whose field

exactly matches the value.

The search is not limited to

the current query set, it

looks throughout the

database. Wildcards and

Boolean logic are not

allowed in the query. The

field must be a key field.

The matching record is
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EXECUTE Commands

Comm

and

Parameter Function

retrieved, but a new query

is not incremented.

Record

number

Moves to any record in the

current set of retrieved

records.

gotoref

erence

/d=database /

k=key /o=offs

et /l=length

This opens a specific

database specified by

database, goes to a key (the

replication key) specified by

key, and highlights a range

of characters specified by

the offset and length.

database is the full path to

the database.dcb file. key is

the replication key. offset is

the offset in characters to

start highlighting from.

length is the number of

characters to highlight.

isdelete

d

Checks if the record is

marked for deletion.

isedited Checks if the record has

been edited since last

indexed or reindexed.
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EXECUTE Commands

Comm

and

Parameter Function

last Moves to the last record in

the current set.

lock Locks the current record so

that you can edit it.

next Moves to the next record.

open Database

path.

Opens a database.

pgdn Moves to the next record

for Browse or Table views.

It is not necessary to send a

repaint command after a

pgdn.

pgup Moves to the previous

record for Browse or Table

views. It is not necessary to

send a repaint command

after a pgup.

prev Moves to the previous

record.

repaint Updates the Browse or

Table display. Use this if
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EXECUTE Commands

Comm

and

Parameter Function

your program changes the

contents of the displayed

record, or moves to

another record.

search Search string. Executes a search.

unlock Unlocks the record.

setfocu

s

Concordance sets focus to

itself. This is equivalent to

the Windows SetFocus()

function.

table Places Concordance into

Table view.

zap The database is zapped.

Every record in the

database is erased and

permanently deleted.

DDE Request Commands



References 409

© 2022 CloudNine™. All rights reserved.

DDE request commands return data values. This group of Concordance DDE

commands returns information about the database, such as a list of fields or the

database’s name, as well as the field contents.

DdeClientTransaction() Parameters

hszItem is a string handle created with DdeCreateStringHandle() and it contains the

command string in CP_WINANSI format. Use the CF_TEXT format for field names

when retrieving data from the database fields. Field names must be in all upper

case. Set uFmt to either CP_WINANSI or CF_TEXT as appropriate.

Returns

XTYP_REQUEST commands return an HDDEDATA value containing the requested

information. Use DdeGetData() to both obtain the length of the data and to copy it

to local memory. Note that the data may not be terminated with a zero. Allocate

one extra byte to your buffer before you copy the returned data. Null terminate the

string yourself.

Numeric fields are returned as text strings. Date fields are returned in YYYYMMDD

format.

REQUEST Commands

Comm

and

Data Returned

Databa

se

status

This command returns information about the

database in eight lines of text, delimited with

carriage returns and line feeds. Each line

contains a number indicating:

· Records in the database

· Fields in the database

· Needs reindexing
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REQUEST Commands

Comm

and

Data Returned

· Current physical record number

· Current record number in the query

· Active query number

· Records in the query

· Total queries

Databa

se

name

The full path and file name of the database.

List of

Fields

A list of fields in the database. Each field is on a

line terminated with a carriage return and a line

feed. The field name is followed by six items

indicating:

· The field type: P, N, D, or T.

· The field’s length.

· The decimal places, applies to numeric

fields.

· A Y(es) or N(o) to indicate if it is a key field.

· A Y(es) or N(o) to indicate if it is an image

field.
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REQUEST Commands

Comm

and

Data Returned

Image

field

The contents of the image field, if an image

field has been defined, otherwise NULL is

returned.

Total

count

A string containing the count of all records in

the database, including any concatenated

databases.

Query

count

A string containing the number of records in

the current query.

FIELD The contents of the named field.

DDE Poke Commands

DDE Poke commands send data to a Concordance field. The new data replaces any

data already in the field. Data on the end-user’s screen is not updated unless you

send a repaint message.

DdeClientTransaction() Parameters

hszItem is a string handle created with DdeCreateStringHandle() and it contains the

name of the field that will receive the data. You must set uFmt to CF_TEXT and use

the CF_TEXT format to create hszItem. lpvData points to the data for the field, and

cbData is the length of the data in bytes, i.e., strlen(lpvData). The data does not need

to be a zero terminated string.
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All data is sent as text strings, including values for numeric fields. Data destined for

a date field must be in YYYYMMDD format, without slashes or any punctuation. For

instance, 19991231 is valid but 31/12/1999 is invalid.

Returns

DDE_FACK if the data was accepted. DDE_FNOTPROCESSED is returned if the

command failed because:

· the field was not found

· the data format was not CF_TEXT

· the database isn't open

· you do not have sufficient security rights to change the field’s contents

DDE_FBUSY is returned if the record is not locked and Concordance could not lock

it to complete the command.

About the Unicode Standard

The Unicode Standard provides a consistent way to digitally represent the

characters used in the written languages of the world. As an accepted universal

standard in the computer industry, the Unicode Standard assigns each character a

unique numeric value and name. This encoding standard provides a uniform basis

for processing, storing, searching, and exchanging text data in any language.

In Concordance version 10.x, the Unicode Standard is supported in Arabic, Chinese,

English, Hebrew, Japanese, Korean, Russian, and other languages.

Some Adobe PDF files with Arabic text do not display the Arabic

text in the proper right-to-left order in Concordance. These PDF

files display the text in reverse order (left-to-right) because the files

report the language incorrectly or are not in the standard format.
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When sending data to a 3rd party software program using the

Send To command, only ANSI text is sent..

Installing Language Packs

To display characters in Unicode within Concordance, the appropriate language

packs need to be installed on the computer.

Issues and Tips

Currently, the Unicode Standard is supported when importing, searching, printing,

and exporting documents in the supported languages. The following issues and tips

are important to know working with non-English documents.

Right-to-Left Documents

When importing documents with Right-To-Left (RTL) languages, such as Arabic, the

imported text may be incorrectly justified to the left side. To correct this and change

the justification to the right side, select the text and press the right [Ctrl] +right

[Shift] keys.

Microsoft Excel Files

When importing Microsoft Excel files in Right-To-Left (RTL) languages, the

spreadsheet cells may be displayed Left-To Right instead of Right-To-Left.

File Names

Files names containing Unicode characters are supported in Concordance.

Delimiters
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The delimiters available from the drop-down lists in the Import Wizard, Import

Delimited Text dialog, in the Export Wizard and Export Delimited ASCII dialog, and

the Overlay Database dialog may appear as square symbols or may not be

displayed. How the lists are displayed depends on the computer's language

environment.

Delimiters use the Tahoma font, which displays the characters regardless of the

language environment.  All of the delimiter characters can be selected as a

delimiter, even if the symbols they represent do not appear in the drop-down lists.

Removing Kashida Characters

Kashida characters are used in Arabic text to lengthen a word by elongating

characters at certain points. The added Kashida characters change the word.

For example, the word for Term in Arabic is . When Kashida characters are

added, the word changes to .

Searching for the word Term with Kashida characters results in inaccurate search

results since it will not include the word  Term without Kashida characters.

To prevent inaccurate searches, the Concordance administrator can remove the

Kashida characters from the searchable text in the current database.  This can be

done in Concordance by going to the File menu, selecting Administration, and

then Remove Kashida characters.

Words That Sound Like the Selected Word

When doing an Advanced Search from the Search task pane, selecting Display a list

of words that sound like the selected word (also known as Fuzzy Search) only

works with English language words. Using this option with words in other

languages will display a list of words that do not sound like the selected word.

Navigating Search Results for Ideographic Languages
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A character in an ideographic language, like Chinese, can represent a word. When

navigating search results, each character is considered a separate hit. Clicking the

Next hit and Previous hit buttons jumps to the next character in the search results.

For example, if your search term is the Chinese word for Mandarin Language

School (    ) you will need to click Next hit four times for each word.

Data Validation Options

Database fields can be assigned data validation options from the Data Entry

Attributes dialog box. However, certain validation options are only supported with

English text. These include:

· Upper case

· Lower case

· Alphabetic only

· Numeric only

Match Whole Word Only

When searching for text using the Find or Replace commands, the Match whole

word only check box does not work with ideographic languages such as Chinese.

Clear the Match whole word only check box before searching for text in these

languages.

Additional Options for Hit Highlighting

When printing documents with ideographic text, like Chinese, a character

underlined for hit highlighting can easily be confused with other characters.

To allow hit highlighting in these languages, additional options have been added to

the Formatting tab in the Print documents dialog box. Now you can use underline,

bold, italics, color formatting or a combination of these options to highlight the

search hits in your reports.
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Exporting to ANSI or ASCII Format

You can export data from Concordance version 10.x to ANSI or ASCII format. The

file can then be imported into an application that does not support the Unicode

Standard; for example, into Concordance 2007 or earlier versions.

This option is available for delimited text files in the Export Wizard dialog box and

the Export Delimited ASCII dialog box. It is also available when exporting database

transcripts.

When exporting to ANSI or ASCII format, characters that cannot be

represented as a single-byte character will be lost in the export. So

exporting documents with double-byte characters, such as Chinese,

to ANSI or ASCII format will result in data loss.

Copyright Information

© 2022 CloudNine™. All rights reserved.

No part of this work may be reproduced or transmitted in any form or by any

means, electronic or mechanical, including photocopying, recording, or by any

information storage or retrieval system, without permission.

While the information contained herein is believed to be accurate, this work is

provided "as is," without warranty of any kind. The information contained in this

work does not constitute, and is not intended as, legal advice.

Concordance is a registered trademark, PreDiscovery is a registered trademark and

FYI is a trademark of Cloud9 Discovery LLC dba CloudNine.  Other products or

services may be trademarks or registered trademarks of their respective

companies.
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* Concordance Native Viewer incorporates software created by OpenText and its

use is limited to the terms of the licensing agreement.  

Concordance®

Concordance® Native Viewer

Concordance® Image

Concordance® FYI™

Contact Information

CloudNine™ offers the broadest choice of discovery solutions, giving law firms,

corporations and government agencies the efficiency, control, and confidence they

need to litigate successfully in the face of overwhelming data volumes and rapidly

changing technology.

Technical Support

Our number one priority is our clients. Our representatives pride themselves on

resolving client issues quickly and effectively. To receive technical assistance, or to

provide feedback or suggestions, please e-mail or call us. The Technical Support

team is available from 9:00 am to 7:00 pm Eastern Time, Monday through Friday.

E-mail: concordancesupport@cloudnine.com

Phone: 713-462-6464 ext.14

Websites

CloudNine™ Solutions:

CloudNine

mailto:concordancesupport@cloudnine.com
https://cloudnine.com/
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CloudNine™ Answer Center:

CloudNine™ Answer Center

Sales

Our sales team is committed to helping you to find the right products to suit your

requirements.  Contact us to learn more about the many flexible licensing options

for Concordance® and Concordance Desktop, and to see how our related software

and service offerings for litigation support — such as CloudNine™ LAW and

CloudNine™ Explore — can help to integrate and accelerate your efforts to arrive at

winning solutions. 

E-mail: CloudNine Ediscovery Sales Team 

Client Training Program

To help you meet the increasing complexity of electronic discovery, our Client

Training Program offers classroom experiences that focus on applying the powerful

features of Concordance to solve real-world problems. To learn more about our

training offerings, please e-mail our training team.

E-mail: training@cloudnine.com

mailto:sales@cloudnine.com
mailto:training@cloudnine.com
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